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About GeneMapper Software 1-1

About GeneMapper 
Software 1
Chapter Overview

Introduction This chapter describes the ABI PRISM® GeneMapper™ Software 
Version 3.0, the relationship of GeneMapper software to the current 
ABI PRISM® genotyping software, and the requirements for installing 
and starting GeneMapper software.

In This Chapter This chapter contains the following topics:

Topic See Page

Overview of GeneMapper Software 1-2

Hardware and Software Requirements 1-9

Registering GeneMapper Software 1-11

Obtaining Technical Support 1-12

1
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Overview of GeneMapper Software

About
GeneMapper

Software

The GeneMapper software v3.0 is a new release of GeneMapper 
software. This release of GeneMapper software has additional features 
and enhancements similar to the functionality of ABI PRISM® 
GeneScan® and Genotyper® analysis software. GeneMapper software 
provides automated genotyping for linkage analysis, SNP validation, 
population genetics, and human identification users.

Supported
Instruments

The GeneMapper software v3.0 supports data generated from the 
following instruments:

♦ ABI PRISM® 310 Genetic Analyzer

♦ ABI PRISM® 377 DNA Sequencer

♦ ABI PRISM® 3100-Avant Genetic Analyzer

♦ ABI PRISM® 3100 Genetic Analyzer

♦ ABI PRISM® 3700 DNA Analyzer

♦ Applied Biosystems 3730 DNA Analyzer

♦ Applied Biosystems 3730xl DNA Analyzer (for 48 capillary 
instruments only)

Supported
Chemistry Kits

The GeneMapper software v3.0 is specifically designed to work with the 
following applications and reagents:

♦ ABI PRISM® Linkage Mapping Set v.2.5

♦ ABI PRISM® Mouse Mapping Primers v.1.0

♦ ABI PRISM® SNaPshot® Multiplex Kit

♦ ABI PRISM® SNaPshot® Primer Focus™ Kit

♦ AmpFlSTR® Kits

♦ StockMarks® Animal Parentage Typing Kits

♦ ABI PRISM® GeneScan™ Size Standards

♦ Custom Microsatellites
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Unique Features of
GeneMapper
Software v3.0

Several new features and enhancements of GeneMapper software v3.0 
include:

♦ Display of polyploid genotypes

♦ Remote database connection

♦ Microsoft® Windows® 2000 operating system support

♦ A clean installation along with upgrades for the 3100 and 
3100-Avant Data Collection computers

♦ Full integration with the Applied Biosystems 3730 DNA Analyzer 
including automation capabilities

♦ Expanded technical portfolio (i.e., mutation screening)

Descriptions of Benefits

GeneMapper software using ABI instruments, Linkage Mapping Set 
(LMS), AmpFlSTR® HID markers, or SNaPshot® Multiplex, provides 
capabilities that go beyond the ABI PRISM® GeneScan® and 
Genotyper® software products. It provides a genotyping capability that 
sets new standards for high-throughput and automated genotyping, 
with the following benefits.

Genotyping benefits of the GeneMapper software

Benefit Description

High accuracy for size- and 
allele-calling

Sophisticated algorithms such as 
Multiple Allele Peak Determination 
(MAPDA), Automatic Bin Builder 
(ABB), and Automatic Bin Assignment 
Algorithms (ABAA) assure highly 
accurate allele calls .

High-throughput In a recommended computing 
platform, GeneMapper software 
processes over 50,000 genotypes in 1 
hour. This is sufficient capacity to 
analyze all the sample files 
accumulated by an Applied 
Biosystems® 3730 DNA Analyzer run 
overnight at peak capacity in 1 to 2 
hours.
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Fully automated operation  Process Component-Based Quality 
Values (PQV) monitor major 
components of the size- and 
allele-calling process, informing a user 
of the source of problems anywhere 
along the data analysis process.

Ease of use One-button operation is provided with 
fully integrated, multi-step size-calling, 
allele-calling, and intelligent data 
management (using the GeneMapper 
database).

Genotyping benefits of the GeneMapper software (continued)

Benefit Description

Unique features of the GeneMapper software v3.0

Unique Feature Description

Multiple Allele Peak Determination 
Algorithms (MAPDA)

For non-forensic data, the MAPDA are used.

For forensic data, the Human Identity Caller (HIC) algorithm is 
specifically optimized to handle data containing tetranucleotide 
repeats and allelic ladders. 

Automatic Bin Builder (ABB) 
Automatic Bin Assignment 
Algorithms (ABAA)

After allele peaks are called using MAPDA, the ABB is used to 
create the bins, optimizing the distances between bins and the 
precise locations of bin centers. The ABAA then completes the 
allele-calling process by assigning allele peaks to their 
corresponding bins.

Process Component-Based 
Quality Values (PQV)

(See Appendix A for more 
information.)

After bin building and allele assignment, bin quality values are 
assigned to these bins based on the success rate of the bins to 
locate allele peaks correctly from the sample file collection.

The PQV system facilitates fully automated operation with only 
questionable allele calls, those with minor component related 
problems, requiring any intervention by the user. Bad samples, 
defined as being below the threshold of acceptability, can be 
discarded without any examination.
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GeneMapper Database The GeneMapper database stores the following data:

♦ Predefined size standard definitions included with installation 
and custom size standard definitions

♦ Panel, marker, and allele bin definitions 

♦ Analysis methods 

♦ Table profiles (for generating tabular reports)

♦ Projects containing analyzed data (allele calls, confidence 
values, analysis methods, and size standard.)

Automated operation for all but 
problematic data

Automated allele calling is made possible by instrument and 
software calibration and setup steps, done once for many 
samples (including user-defined criteria). It is also made 
possible by the PQV system described above. Bad or 
“out-of-bounds” data can be safely discarded, and only data 
with minor component problems is deferred for user 
intervention.

Unique features of the GeneMapper software v3.0 (continued)

Unique Feature Description
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Important
Features

GeneMapper software v3.0 has a number of features that are built on 
the automated genotyping capabilities of the ABI PRISM GeneScan® 
and Genotyper applications. The table below lists important features of 
the GeneMapper software.

Feature Description

Ability to read genetic analysis 
data produced by earlier 
ABI PRISM genotyping applications

You can import sample files directly 
into the GeneMapper database from 
either the ABI PRISM® Data Collection 
software or Sequence Collector 
database. It is not necessary to use 
separate analysis tools such as 
GeneScan software and Genotyper 
software for peak quantitation and 
allele calling.

Note GeneMapper software has 
read-only access to the Sequence 
Collector Version 3.0 database. 
Therefore, GeneMapper database 
results cannot be written back to the 
Sequence Collector Version 3.0 
database. Instead, they are stored in 
individual GeneMapper projects within 
the GeneMapper database.

Ability to read and process sample 
(.fsa) files containing a fifth dye. 
Provides fourth and fifth dye 
support.

Data containing a fifth dye can be 
analyzed just like the other four dyes. 

Ability to export results in a user 
defined format

The final results from the GeneMapper 
software table can be exported as 
user-defined text files.

Ability to import panel, marker, and 
Bin definitions

Marker and bin definitions can be 
imported into the GeneMapper 
database using tab-delimited text files.

Ability to export panel, marker, and 
bin definitions

Marker and bin definitions can be 
exported from the GeneMapper 
database as tab-delimited files.
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Ability to create bin sets for 
different instruments

Bin definitions, which may vary 
between instrument types, can be 
stored as separate bin sets allowing 
simultaneous analysis of data from 
different instrument types in the same 
project.

Ability to correct failed in-lane size 
standards

Individual samples that fail size 
standard matching can be corrected 
as soon as they are incurred without 
redefining the size standard definition.

Feature Description
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How GeneMapper
Software Works

The following figure shows how data flows through the GeneMapper 
software system. 

Peak-Detection Size-Matching

Automatic Bin
Builder
(ABB)

Automatic Bin
Assignment
Algorithm
(ABAA)

Allele-Peak
Determination using
Multiple Allele Peak
Algorithms
(MAPDA)

Called-Alleles

GeneMapper Database

Raw data from
ABI PRISM
instrument or
Sequence
Collector

Size-Calling Allele-Calling

G
R

18
67

b
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Hardware and Software Requirements

Hardware and
Software

Requirements

The following table describes the components your computer system 
requires to run GeneMapper software.

IMPORTANT The Oracle database has an embedded license which only 
permits five named users. 

Note In order to perform all functions in GeneMapper software (with its 
embedded Oracle database), please ensure there are at least 500 MB of free 
space on the partition where the GeneMapper database is installed. It is 
possible to export your projects to a different drive or partition, and then delete 
those projects from the database to make room for new projects. (See 
Chapter 3, “Using the Project Window.”)

System 
Component Minimum Requirement Recommended

Computer ♦ Intel® Pentium® III 
processor minimum of 
540 MHz

♦ 256 MB of RAMa

♦ 6 GB hard disk (free 
space)

a. There are functions within the GeneMapper software that run faster with more than 
256 MB RAM. Applied Biosystems recommends using at least 512 MB RAM for the best 
results.

♦ Intel Pentium III 
processor faster than 
700 MHz

♦ 512 MB RAM

♦ 10 GB EIDE hard drive

♦ 20/48X IDE CD-ROM

♦ 10/100 NIC with RWV 
(internal)

 Monitor 800 x 600 pixels size 
17-inch monitor

Larger monitor

Operating 
System

Microsoft® Windows NT® 
version 4.0 
(Service Pack 5)

Microsoft Windows NT 4.0 
Service Pack 5 or Windows 
2000 Professional Service 
Pack 2

Ethernet 
Capability

Network card for Oracle® 
installation. TCP/IP must 
be installed prior to Oracle 
installation.

—
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Special
Considerations

The following is a list of special considerations for running the 
GeneMapper software v3.0:

♦ The ABI PRISM® 3100 Genetic Analyzers require the 3100 Data 
Collection Software version 1.0 and a minimum of 512 MB RAM. 

♦ The Applied Biosystems 3730/3730xl Genetic Analyzers require the 
3730 Data Collection Software version 1.0.

♦ When using the GeneMapper software v3.0 with the ABI PRISM® 
3700 DNA Analyzer, the software must be installed on a separate 
computer.

♦ GeneMapper software v3.0 requires a single-processor computer.

♦ GeneMapper software v3.0 runs on Windows NT® and Windows® 

2000 platforms only. Conversion utilities are included for analyzing 
data from MacIntosh®-based sample files.

♦ GeneMapper software v3.0 is not compatible with Xeon chips on 
upgrades from GeneMapper software v.1.0.2.

♦ The version of Oracle® database in the GeneMapper software v3.0 
is an embedded license for use by five (named) users only. 

IMPORTANT To accommodate more than five users, additional GeneMapper 
software or Oracle database licenses must be purchased.

♦ When installing GeneMapper software v3.0, the user must log into 
the local machine and have administrator privileges.

♦ GeneMapper software v3.0 can exist with other Oracle clients but 
not other Oracle servers. The only exception to this rule is when the 
ABI PRISM® 3100 Data Collection Software version 1.0 and/or the 
Applied Biosystems 3730 Data Collection Software version 1.0 is 
installed on the system.
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Registering GeneMapper Software

How to Register To register, fill out the registration card included in this package and 
return it to Applied Biosystems, and read the information in Chapter 2, 
“Installing and Registering the GeneMapper Software” on page 2-3.

For Applied Biosystems technical support telephone and address 
information, see “Obtaining Technical Support” on page 1-12.

Note Installation privileges are available only if you have returned your 
registration card.
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Obtaining Technical Support

Applied
Biosystems

Website

A services and support page is available on the Applied Biosystems 
Web site. To access this, go to:

http://www.appliedbiosystems.com

and click the link for services and support.

At the services and support page, you can:

♦ Search through frequently asked questions (FAQs)

♦ Submit a question directly to Technical Support

♦ Order Applied Biosystems user documents, MSDSs, certificates of 
analysis, and other related documents

♦ Download PDF documents

♦ Obtain information about customer training

♦ Download software updates and patches

In addition, the services and support page provides worldwide 
telephone and fax numbers to contact Applied Biosystems Technical 
Support and Sales facilities.
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Using GeneMapper 
Software 2
Chapter Overview

Introduction This chapter describes techniques for collecting and preparing sample 
data that will help you improve the overall quality of the fragment 
analysis sample files you import into the ABI PRISM® GeneMapper™ 
Software Version 3.0. It also describes how to plan for use of the 
GeneMapper software features in your genotyping application.

In This Chapter This chapter contains the following topics:

Topic See Page

Steps Required to Use GeneMapper Software 2-2

Installing and Registering the GeneMapper Software 2-3

Logging on to and Logging out of the GeneMapper Software 2-5

Importing Data from the Analysis Sample Sheet 2-8

GeneMapper Manager 2-11

Overview of the User’s Manual 2-12

2
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Steps Required to Use GeneMapper Software

Using
GeneMapper

The following steps are required to use the GeneMapper software. You 
will be guided through this process in more detail by reading the 
ABI PRISM® GeneMapper™ ID Software v3.0 Human Identification 
Analysis Tutorial (P/N 4335523), Microsatellite Analysis with 
ABI PRISM® GeneMapper™ Software v3.0 Tutorial (P/N 4335525), and 
SNP Genotyping with ABI PRISM® GeneMapper™ Software v3.0 Tutorial 
(P/N 4335524).

♦ Set up the GeneMapper software the first time for each analysis 
application:

– Import or create panels and bins in the Panel Manager.

– Create an analysis method suitable for your application with 
appropriate bin sets. No bin set is needed if you are performing 
a sizing-only application.

– Create the appropriate size standard(s) if your data uses size 
standards other than those provided with GeneMapper 
software.

– Set up options so that the same setup will apply the next time 
you use GeneMapper software, if desired.

– Convert any Macintosh®-generated sample files to the .fsa 
format. (See Appendix E for details.)

♦ Set up the Project window for analysis of a given set of data:

– Import the fragment analysis sample files.

– Select the appropriate analysis method.

– Choose the appropriate panels.

– Select the size standard.

♦ Perform analysis and examine the results:

– Initiate analysis.

– Examine analysis results using the Plot window(s).

♦ Export results:

– Set up table format for export (using Table Settings Editor).

– Export (using Export Table command).

Set up
GeneMapper

Software

Set up Project
window for analysis

Perform
Analysis

Export results
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Installing and Registering the GeneMapper Software

No Prior Oracle
Installation

An important requirement for the GeneMapper software installation is 
that no previous Oracle® installation be in place at the time of 
installation except for 3100 Data Collection Software (DCS), the 
3100-Avant DCS, and the 3730 DCS. 

CD-ROM
Contents

IMPORTANT Do not work off of the CD-ROM. Install the software to the 
selected drive.

GeneMapper software comes on a CD-ROM and includes:

♦ Microsatellite, Human Identification (HID) marker, bin definitions 
and example data, and SNP genotyping tutorial data

♦ AppleScript® sample file conversion utilities 

♦ Electronic (PDF)® version of the user’s manual

♦ Size standard folder which contains various size standards

♦ Panel folder which contains Linkage Mapping and AmpFlSTR 
panels and bins

Installing
GeneMapper

Software

To install GeneMapper Software version 3.0, please use the instructions 
in the ABI PRISM® GeneMapper™ 3.0 Software Installation Instructions, 
P/N 4338561, found in the kit contents or use the 
GeneMapper 3.0 Installation.txt file on the CD-ROM.
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Registering
GeneMapper

Software

When you are ready to use the GeneMapper software, follow the 
instructions in the table below for registration.

To register GeneMapper software:

Step Action

1 Click Start > Programs > Applied Biosystems > GeneMapper.

The first time you start the GeneMapper software, the Product 
Registration dialog box opens.

2 Enter your name, organization, and registration code, and click OK.

Note The first time you use the application, you are asked to 
enter the registration code found on your registration card. 
GeneMapper software then verifies the code. Keep your registration 
code in a place where you can easily retrieve it. If you need to 
reinstall the software at any time, you will be prompted for the 
registration code again.
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Logging on to and Logging out of the GeneMapper Software

Introduction This section provides information on logging on to and logging out of 
the GeneMapper software.

Logging on to the
GeneMapper

Software

You must log on to the GeneMapper software program with a user 
name, so that the system can log information to the database and 
preserve the options for each user.

To log on to the GeneMapper software:

Step Action

1 When you start the GeneMapper software application, the following 
dialog box opens. Select your user name, if it exists, enter your 
password, and click OK.

IMPORTANT If you do not have a User Name, select the default 
gm, enter the password ifa, and click OK to launch the 
GeneMapper software. You can go to Options from the Tools menu 
and create new users and passwords.
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2 Click the New Host button to open the New Host dialog box.

This option allows you to connect to GeneMapper software v3.0 
databases on other computers.

3 In the Host Name field, enter the machine name or IP address of the 
database host.

The window displays the new database host and its user names list.

Note If the GeneMapper software cannot connect to the 
database host you entered, the following error message opens: 
“You have entered an invalid host.” Click OK to exit and reenter the 
database host information.

4 Select the appropriate machine type from the drop-down list.

5 Click OK.

To log on to the GeneMapper software: (continued)

Step Action
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GeneMapper
Software Access

Rules

The following rules apply to access the GeneMapper software.

♦ The first time the GeneMapper software application is launched 
after installation, user registration is required. 

♦ Once registered, all users can read, write, and edit everything in the 
database (except predefined content) because there are no access 
privileges.

♦ Sequence Collector access information is specified in the Options 
dialog box in the Tools menu.

♦ Only one user can access a database at a time.

♦ Database connections can only be made across computers using 
GeneMapper software v3.0 and not earlier versions of the software.

Logging Out Close the GeneMapper software in one of three ways.

♦ Click File > Logout,

♦ Click File > Exit, or

♦ Click the Close button .

If you close GeneMapper software with a new or blank Project window 
(or no changes in your Project), the Save Project (logout) dialog box 
does not open.

When you log out of the GeneMapper software, you have the option of 
saving or discarding the changes you made since the last time you 
updated the project..

If you close the GeneMapper software using the Logout command, the 
login window reopens after you select either “Yes” or “No”. GeneMapper 
software closes completely if you use either the Exit command or the 
Close button.
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Importing Data from the Analysis Sample Sheet

Introduction The sample sheet output from the ABI PRISM instrument used to collect 
data provides important input to GeneMapper software to identify the 
lane number and contents of each sample to undergo analysis. This 
section identifies the sample sheet information used by GeneMapper 
software so that you can correctly set up the sample sheet.

For detailed information on how to fill out a sample sheet correctly, see 
the user’s manual for the appropriate ABI PRISM instrument.

Transfer of
Information

Data is transferred from a sample sheet into GeneMapper software as 
described in the following table.

Using Sample
Sheet Information

The sample sheet information is essential for associating the nature of 
sample fragments with individual dye/lanes and tables in the 
GeneMapper software. 

For example, the following figures show how the GeneMapper software 
incorporates information entered in the Sample Name, Color Info, and 
the Color Comment fields of a sample sheet into GeneMapper software 
Project tables. It is your responsibility to ensure that the entries on the 
sample sheet for your particular ABI PRISM instrument are correctly set 
up to provide GeneMapper software with the necessary information.

Sample Sheet GeneMapper Software

Sample file name and
Sample name

Note These names are the same 
between a sample sheet and 
GeneMapper software.

Sample file name and
Sample name

Sample Info or Color Info Sample type (Control, Allelic Ladder, 
Sample, Negative Control)

Comment Panel name

Comment after Panel name. Use the 
pipebar (|) to separate text into user 
defined columns.

Note The 3730 has user defined 
columns 1-3 in the sample sheet.

User Defined Columns 1-3
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Find Command You can increase the utility of the Find (Ctrl+F) command in 
GeneMapper software by carefully planning the format of the 

 
Sample Sheet

 

 

GeneMapper Software 
Project Table

04_100302.fsa

User defined Read from Sample File
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information you put into the Sample Info or Color Info field of the sample 
sheet.

Example of How To Use the Find Command

One Method

If... Then...

you have 12 samples, numbered 1, 
2, 3,..., 12, and you enter these 
numbers into the Sample Info field

when you search for all dye/lanes 
containing a 1 in the Sample Info 
field, not only will you select sample 
1, you will also get samples 10, 11, 
and 12. 

A Better Plan

If... Then...

you number the samples 01, 02, 03, 
and so on

a search for the text 01 would select 
only the desired dye/lanes.

In Addition

You can place key words in the Sample Comment or Color Comment field 
that distinguish samples from each other.
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GeneMapper Manager

Introduction The GeneMapper Manager is a centralized interface within the 
GeneMapper software v3.0 for managing and organizing projects. The 
GeneMapper Manager window contains six tabs that point to the 
following views: 

♦ Projects - see Chapter 3, “Using the Project Window”

♦ Analysis Methods - Chapter 5, “Using Analysis Methods”

♦ Table Settings - Chapter 6, “Using Table Settings”

♦ Plot Settings - Chapter 7, “Using Plot Windows - Samples and 
Genotypes”

♦ Matrices - Chapter 9, “Creating and Evaluating a Matrix”

♦ Size Standards - Chapter 10, “Using the Size Standard Settings”
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Overview of the User’s Manual

Organization of
the User Manual

This manual provides technical information to support the GeneMapper 
software user.

♦ The following chapters explain how to use the major application 
components:

– Chapter 3, “Using the Project Window,” describes how to use 
the Project window, including the Project Manager to delete and 
rename Projects.

– Chapter 4, “Using Panel Manager,” describes how to use the 
Panel Manager to manage all of the chemistry kits, panels, 
markers, and bin definitions required for automated allele 
calling.

– Chapter 5, “Using Analysis Methods,” describes how to use the 
Analysis Methods tab to create custom analysis methods for 
use in analyzing sample files.

– Chapter 6, “Using Table Settings,” describes how to use the 
Table Settings tab to create new profiles, hide and show table 
columns, and filter the table entries (rows) in Project windows.

– Chapter 7, “Using Plot Windows - Samples and Genotypes,” 
describes how to view data graphically and edit allele calls.

– Chapter 8, “Using the Plot Settings Editor,” describes how to 
create a custom plot profile for viewing data.

– Chapter 9, “Creating and Evaluating a Matrix,” describes how to 
create a matrix file.

– Chapter 10, “Using the Size Standard Settings,” describes how 
to create a size standard and how to use the Size Match Editor.

♦ The following appendices contain reference information:

– Appendix A, “Process Quality Values,” explains how to use the 
Process Component-Based Quality Values.

– Appendix B, “Software Genotyping Algorithms,” provides a 
description of the genotyping algorithms used in GeneMapper 
software.

– Appendix C, “Project Window Software Interface,” describes the 
dialog boxes and menu commands associated with the Project 
Window.
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– Appendix D, “GeneScan Size Standards,” provides information 
on the Size Standards provided with the GeneMapper software.

– Appendix E, “Sample File Conversion,” describes how to use 
the Macintosh® AppleScript® program to convert 
Macintosh-generated fragment analysis sample files to the 
Windows format.

– Appendix F, “Software Warranty Information,” describes the 
Applied Biosystems warranty that comes with the software 
package.
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Using the Project 
Window 3
Chapter Overview

Introduction This chapter provides a general overview of the Project window, the 
central window of the ABI Prism® GeneMapper™ Software Version 3.0 
interface.

In This Chapter This chapter contains the following topics:

Topic See Page

Central GeneMapper Software Window 3-2

Details of the GeneMapper Project Window 3-5

Exported Project Tables 3-20

Projects Page 3-23

3
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Central GeneMapper Software Window

Importance of the
Project Window

As shown by the figure below, the Project window is the most important 
element in the GeneMapper software user interface. The GeneMapper 
software is organized around the concept of the project to support its 
purpose of automatically calling alleles or performing genotyping.

Project window
Samples and Genotypes

Plot window

Login screen

Splash screen

Registration 
screen

Add Samples to 
Project dialog box

Project Open and 
Save dialog boxes

GeneMapper 
Manager

Panel 
Manager

Size Match 
Editor

Print dialog box

Project Manager 
dialog box

Analysis Methods

Table Settings

Plot Settings

Matrices

Size Standard 
Editor

Import/Export  
dialog boxes

Export Table 
dialog box

Options dialog box

Sort and Find 
dialog boxes

Plot Properties 
Control

Print dialog box
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The figure on page 3-2 shows the Project window as the main window 
and the manager utilities, editors, and dialog boxes as the subordinate 
windows. These windows are opened from and provide support for the 
project. 

As the focal point of the GeneMapper application, the Project window 
makes it easy for you to:

♦ Add samples, initiate analysis, and export results

♦ View sample data and access data plots

You can view the data associated with a particular sample file by: 

– Viewing the pre-analysis (raw data) version of the data in the 
Samples view of the Project window

– Viewing the tabular results of analysis in the Genotypes view of 
the Project window, or 

– Viewing plot(s) of selected Project sample data in the Plot 
window

♦ Initiate the process of creating analysis methods and defining 
panels and bins

Windows and
Utilities

Supporting the
GeneMapper

Software Project

The following items support the information in the Project window and 
are available in the GeneMapper Manager in the Project window.

♦ Table Setting Editor (GeneMapper Manager) - This page enables 
you to change the way information is displayed in the Project 
window, including:

– Hide/Show table columns in the Project window

– Filter table entries

– Set profiles to generate reports easily for downstream 
processing (i.e. export text files to other applications)

For more details see “Table Settings Editor” on page 6-4.

♦ Analysis Method Editor (GeneMapper Manager) - This page 
enables you to create and edit analysis methods, including:

– General properties such as type of analysis (Microsatellite, or 
SNP Genotyping)

– Allele-calling properties such as the bin set to be used and 
marker repeat information (di-, tri-, or tetranucleotide type, 
cut-off value, PlusA distance, PlusA ratio, stutter distance, and 
stutter ratio, etc.)
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– Peak Detector parameters and Algorithm type (basic, 
advanced, or classic)

– Marker Quality Values to specify various requirements for 
analysis

– Peak Quality parameters, such as homozygous and 
heterozygous peak heights, maximum expected alleles, etc.

– Quality flags settings and PQV threshold values (pass and fail 
ranges for sizing and genotype quality values)

For more details see “Analysis Method Editor” on page 5-5.

♦ Panel Manager - This window enables you to create and edit 
panels or “reference data” and has the following components:

– A tool for creating product or chemistry kit folders

– A table for specifying panels

– A table for defining markers within a panel

– A graphical editor for defining bins

For more details see Appendix C, “Project Window Software 
Interface.”

♦ Size Standard Editor (GeneMapper Manager) - This window 
enables you to create new size standard definitions to be used with 
new groups of samples and delete existing size standards.

For more details see “Creating/Editing a Size Standard” on 
page 10-5.

♦ Size Match Editor - This window enables you to adjust an in-lane 
size standard to compensate for peak shift or a missing peak.

For more details see “Size Match Editor” on page 10-12.

♦ Display Plots - This window enables you to display graphically the 
data associated with samples and markers, and visually assess the 
quality of the data.

For more details see “Displaying Plot Windows” on page 7-2.
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Details of the GeneMapper Project Window

Introduction The following information is provided for the GeneMapper Project 
window.

Project Window
Interface

Conventions

The Project window enables you to:

♦ Minimize the window to an icon on the Microsoft Windows taskbar 
or to the title bar

♦ Maximize the window to fill the entire screen

♦ Resize the window by dragging any window edge or corner

Reformatting the
Window

The following reformatting can be done in the Project window to change 
the presentation of information.

♦ The View menu provides a Show Navigator toggle command to 
show/hide the navigation pane for both the Samples and 
Genotypes views. When the navigation pane is hidden, the table 
occupies the entire width of the Project window.

♦ Shift-clicking a column header sorts the data by that column. The 
Sort dialog box under the Edit menu allows cumulative sorting over 
three columns; see “Sort Dialog Box” on page C-47.

♦ The first column of the table, displaying row numbers, is fixed during 
horizontal scrolling of the Samples and Genotypes tables.

Topic See Page

Project Window Interface Conventions 3-5

Reformatting the Window 3-5

Parts of the Main Window 3-6

Navigating in the Project Window 3-7

Samples and Genotypes Views 3-11

Project Window Toolbar 3-12

Viewing the Project Window Contents 3-14

Access to Subordinate Application Windows 3-15

Column Menus and Rules for Columns 3-18
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♦ You can create Hide/Show columns as needed with different table 
settings created using the Table Settings in the GeneMapper 
Manager window.

♦ Resize columns by dragging the separating lines. When resizing is 
enabled, the cursor changes to a resize cursor (a double-headed 
arrow that looks like this ).

Parts of the Main
Window

Once you have loaded Sample files into a Project window, the main 
window looks like the example below. For more information see 
Appendix C, “Project Window Software Interface.”

The following table describes the parts of the main window in the above 
figure.

<––>

1

2

3

4

6

5

Parts of the main window

Item Name Description

1 Drop-down 
menus

These menus are described in “Project Window 
Menus” on page C-9.

2 Toolbar Toolbar icons are described in “Project Window 
File Menu Dialog Boxes” on page C-27.

3 Samples and 
Genotypes 
tabs

The use of these tabs is described in “Samples 
View” on page C-2 and “Genotypes View” on 
page C-6.

4 Navigation 
pane

The use of this pane is described in “Navigating 
in the Project Window” on page 3-7.
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Navigating in the
Project Window

This section provides information on how to navigate as well as how to 
access different views for samples files.

♦ Navigation in Samples and Genotypes View - (See page 3-7)

♦ Info Tab - (See page 3-8)

♦ Raw Data Tab - (See page 3-9)

♦ EPT Tab - (See page 3-10)

Navigation in Samples and Genotypes Views 

The left panel of the Project window has a tree view navigation device. 
In the Samples view, the tree viewer has three levels. Each sublevel of 
the tree-view is indented to the right.

In the Genotypes view, the tree viewer has three levels and each 
sublevel of the tree view is again indented to the right.

As soon as you click the tree view controller (indicated in the figure 
below), the tree view expands with the subordinate level indented. 
Clicking the controller a second time will collapse the level back to its 
original form.

5 Samples view 
columns

These columns are described in “Samples View 
Columns” on page C-3.

6 Progress 
indicator

The progress of analysis and import/export of 
projects is shown in this indicator.

Parts of the main window (continued)

Item Name Description

Samples View Genotypes View

• Project • Panels (root level)

• Run folder • Panels

• Sample • Markers

Project
Run folder

Sample files
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Once you have added files to the Project window, the following rules 
apply.

Info Tab

When a Sample file is selected from the navigation pane in the Samples 
view, a special information window like that shown below is presented 
and “Info” is the active tab.

If you... Then...

select the Project item in the 
Navigation pane

all samples in the project are displayed 
in the table.

select a Run folder in the 
Navigation pane

samples in the selected Run folder are 
displayed in the table.

select a Sample file in the 
Navigation pane

sample information associated with the 
selected sample is displayed in the right 
pane (See figure on page 3-8).

click the Raw Data tab (with the 
Info view displayed)

raw data associated with the selected 
sample is displayed in the right pane 
(See figure on page 3-9), replacing the 
Info view display.

click the EPT Data tab sample information associated with 
voltage, power, current and run 
temperature is displayed (See 
page 3-10).
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The Info tab displays sample file information such as:

♦ sample information

♦ run information

♦ data collection settings

♦ gel information

♦ capillary information

♦ error messages

♦ current settings

Sample information comes directly from the Instrument Data Collection 
and/or Sample sheet.

Raw Data Tab

Clicking the Raw Data tab in the Samples view, when the Sample file is 
selected, displays the Raw Data view for the selected Sample file. 
 

There are several plot-scaling features in the Raw Data view: 

♦ Zoom in on one area by placing the cursor in either the X or Y axis 
label areas, and click and drag. The software zooms in on the area 
of selection.

♦ Return to a full scale plot by double-clicking in the label area again. 
The plot window is restored to full scale.

♦ You can scale the Y axis to maximum Y or a user defined value by 
selecting Y-Axis Scale from the View menu.
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Use the Raw Data view to evaluate the following:

♦ problems or noise in the baseline that could result in poor size 
calling

♦ start and stop points for analysis

EPT Tab

Clicking the EPT (electrophoresis, power, and temperature) tab in the 
Samples view, when the Sample file is selected, displays a window that 
shows the voltage, power, current, and run temperature associated with 
that sample.

Line Description

Blue EP Voltage

Black EP Power

Green EP Current

Red Run Temperature
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There are several plot-sealing features in the EPT view: 

♦ Zoom in on one area by placing the cursor in either the X or Y axis 
label areas, and click and drag. The software zooms in on the area 
of selection.

♦ Return to a full scale plot by double-clicking in the label area again. 
The plot window is restored to full scale.

♦ You can scale the Y-axis to maximum Y or a user defined value by 
selecting the Y-Axis Scale from the View menu or specify upper and 
lower limits in the Scale to dialog box.

Samples and
Genotypes Views

The Samples and Genotypes tabs provide access to two separate 
tables, each of which is considered a different view of the same project 
data. Only one of these views is displayed in the Project window at any 
time.

♦ Samples View - (See page 3-12 and in detail on page C-2)

This view is used to enter samples and its tab is always enabled.

♦ Genotypes View - (See page C-6)

The tab for this view is enabled when results are present. Samples 
that do not have a Panel attribute do not display in the Genotypes 
table.

Note Samples with no results do not display in the Genotypes tab.
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Samples View

Genotypes View

Note Shown with navigator pane closed.

Project Window
Toolbar

The table below is provided as a reference for the Project window 
toolbar commands.

Icon Description

 

Creates a New Project
Tooltip: New Project
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Opens the Open Project dialog box
Tooltip: Open Project

 

Saves the Project
Tooltip: Save Project

 

Opens the Add Samples To Project dialog box
Tooltip: Add Samples To Project (Ctrl+C)

 

Opens the Export dialog box; exports the contents of 
the Samples or Genotypes tables in tab or comma 
delimited format (Ctrl+E)
Tooltip: Export Table

 

Opens the Plots Table window
Tooltip: Display Plots

Opens the Size Match Editor window
Tooltip: Size Match Editor

Opens Analysis Method Editor
Tooltip: Analysis Method Editor

 

Opens the Panel Manager window
Tooltip: Panel Manager

Opens GeneMapper Manager
Tooltip: GeneMapper Manager

 

Starts the analysis; displays progress bar and Stop 
button on the Status bar during analysis
Tooltip: Analyze (Ctrl+R)

 

Brings samples with errors to the top of the table; sorts 
by overall confidence value in the Samples or 
Genotypes table
Tooltip: Low Quality to Top (Ctrl+B)

 

Opens the Table Setting Editor for the currently selected 
table
Tooltip: Table Setting Editor (Ctrl+T)

 

Opens the Find dialog box
Tooltip: Find (Ctrl+F)

 

Opens the Print dialog box
Tooltip: Print (Ctrl+P)

Icon Description
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Viewing the
Project Window

Contents

The following table lists how to display information in a Project window.

To display information in a Project window:

To hide the... Open the... Clear the... And GeneMapper software displays the...

Navigation pane View menu
from the Project 
window 

Alternative = 
Ctrl+Shift+N

Show 
Navigator 
check mark

Project window without the navigation pane.

To see the... Click the... And GeneMapper software displays the...

Genotypes view Genotypes tab

Alternatives = 
Select 
Genotypes 
command from 
the View menu, 
or Ctrl+Shift+2

Note Samples 
must be 
analyzed to see 
genotypes.

Project in the Genotypes view.

To see the... Click the... And GeneMapper software displays the...

Samples view 
again

Samples tab

Alternatives = 
Select View > 
Samples, or 
Ctrl+Shift+1

Project in the Samples view.
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Access to
Subordinate
Application

Windows

The following table lists how to access subordinate GeneMapper 
software windows.

Access GeneMapper Application Windows

To see the... Select... And GeneMapper software displays the...

Analysis 
Methods

Tools > 
GeneMapper 
Manager

Then select 
the Analysis 
Methods tab.

Analysis Methods page.

Panel Manager Tools > Panel 
Manager,

or click the 
icon:

Panel Manager window.
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Size Standards Tools > 
GeneMapper 
Manager

Then select 
the Size 
Standards tab.

Currently Defined Size Standards.

Size Match 
Editor

Analysis > 
Size Match 
Editor,

or click the 
icon:

Size Match Editor.

Access GeneMapper Application Windows (continued)

To see the... Select... And GeneMapper software displays the...
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Table Setting 
Editor

Tools > Table 
Setting Editor,

or press 
Ctrl+T.

If samples 
have been 
imported, you 
can click the 
icon:

Note To 
create a new 
table, select 
Tools > 
GeneMapper 
Manager. 
Then select 
the Table 
Settings tab 
and click New.

Table Setting Editor.

Plot window a sample or 
results row, 
and then 
either select 
Analysis > 
Display Plots,

press Ctrl+L,

or click the 
icon:

Plot Window

Access GeneMapper Application Windows (continued)

To see the... Select... And GeneMapper software displays the...
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Column Menus
and Rules for

Columns

Columns are used to set up analyses after you have added samples to 
a project.

Column Menus

Five columns in the Samples view of the Project window have 
drop-down menus to apply settings to selected cells in the column:

♦ Sample Type 

♦ Analysis Method 

♦ Panel

♦ Size Standard 

♦ Matrix

Note The Panel column displays a pop-up window which contains a 
hierarchical list of kits and panels. A panel is required for any allele-calling 
analysis.

Each of these columns is used to apply needed analysis parameters to 
selected samples. Different list selections can be made to the individual 
column rows representing samples.

Rules for Columns

The following rules apply to column selections:

♦ Clicking the header for a column selects the entire column.

♦ Shift+clicking selects a continuous selection range.

♦ Ctrl+clicking on individual cells makes discontinuous selections.
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Applying a List Selection to an Entire Column

Fill Down the Panel Column

To apply a Menu selection:

Step Action

1 Apply the selection to the top cell in a column:

a. Select the top cell in a column. This will display a drop-down list 
of items.

b. Select and click an item to apply the selection to the cell.

2 Select all other cells in the column, either as a continuous or 
discontinuous selection, to which the list selection is to be applied.

3 Click Edit > Fill Down to apply the choice made for the first cell to all 
selected cells. (Ctrl+D)

To fill down the panel column:

Step Action

1 Select the top cell in the Panel column to open the Select a Panel 
window.

2 Expand the appropriate folder.

3 Double-click the appropriate panel.

4 Click Edit > Fill Down.
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Exported Project Tables

Opening Exported
Project Tables in
Microsoft Excel

Project tables are exported as text (.txt) files. When they are opened in 
Microsoft® Excel software, use the Text Import Wizard as described in 
the following procedure so that all columns of the table are interpreted 
correctly.

To open and save an exported text file in an Excel spreadsheet:

Step Action

1 Start Excel software, and either:

♦ select File > Open > Files of Type, or 

♦ select Data > Get External Data > Import Text file.

Then select the .txt file and click Import.

2 Navigate to the folder containing your exported table files and 
double-click the table file you wish to open. The Text Import Wizard 
window opens.
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3 Move through the steps to import text.

a. Click the Next button to proceed to Step 2 of 3 in the Text Import 
Wizard window.

b. Select either Tab or Comma Delimiters according to how you 
exported the table (if necessary).

4 Click the Next button to continue to Step 3 of 3 in the Text Import 
Wizard window.

As you can see, the first column of the table is already selected.

To open and save an exported text file in an Excel 

Step Action
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5 Open the table file by performing the following actions:

a. Hold down the Shift key.

b. Scroll to the last column of the table.

c. Click the last column of the table and release the Shift key.

d. Click the Text option button.

e. Click the Finish button to open the table file with all columns in 
text format.

6 Save the text file as a Microsoft Excel Workbook file. The next time 
you open the file in Excel, the table columns will display correctly in 
text format.

To open and save an exported text file in an Excel 

Step Action
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Projects Page 

Using the Projects
Page

The GeneMapper Manager Projects page, shown below, is a utility 
which is used to rename, save as, import, export, or delete projects.

To display the Projects page, select the GeneMapper Manager from the 
Tools menu and select the Projects tab.

Select the project you would like to change and click the appropriate 
button. If you click the Delete button, the Project Deletion dialog box 
displays. Click No if you do not want to delete the project. Click Yes only 
if you want to delete the project permanently.
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Projects Tab The Projects Tab allows you to view information about the projects 
stored within the GeneMapper database and perform certain functions 
such as renaming and exporting of projects.

Note The only method of backing up your projects is to export them.

Description of items on the Projects tab:

Item Description

Project column Project name

Last Saved column Date/Time stamp showing when the 
project was last saved

Owner column User name of the person who 
created the project

Samples column Number of samples contained in the 
project

Rename button Opens a Rename dialog box for 
renaming the project 

Enabled when a project is selected

Save As button Displays the Save Project As dialog 
box 

Enabled when a project is selected

Import button Displays a dialog box for Importing 
projects

Export button Displays a dialog box for Exporting 
selected projects 

Enabled when projects are selected

Note Projects can be exported as 
a group by holding down the shift 
key and selecting multiple projects. 
This feature works with one or more 
selected projects.

Delete button Deletes the selected projects

Enabled when a project is selected

Note This feature works with one 
or more selected projects.

Done button Closes the GeneMapper Manager.
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Export Project
Window

The Export Project window enables you to export a project out of the 
GeneMapper database into a specified location. See an explanation of 
each area on this window in “Using the Export Project Window” on 
page 3-26.

Note Reference data and Size Standards used by exported Projects are not 
exported with the Projects.

1
2

3

5

6

7

4
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Using the Export Project Window 

The elements called out in the figure in “Export Project Window” on 
page 3-25 are described in the table below.

Export Project Callouts

Item Name Description

1 Toolbar These icons are used as follows:

 -  Clicking moves display up one level in 
main pane.

  - Clicking moves display to Home level in 
main pane. This level is usually 
Profiles\<user>.

 - Clicking creates a new folder at the 
present directory level.

  - Clicking presents a list of the contents of 
the selected folder.

  - Clicking presents details of the selected 
folder.

2 Drop-down 
directory menu

Select drive letter and/or folder.

3 Folder/file 
display pane

The contents of the disk or directory are selected 
in the toolbar and the directory menu is displayed 
here.

4 Save button This button saves the exported project.

5 File name field Enter a file name to use for saving your data.

6 Files of type 
field

This field is a display filter for files (folders are 
always shown). Use this drop-down menu to 
select the file extensions for display:

♦ All Files (*.*) shows all files

♦ Java Serialized file (*.ser) shows only files 
with the extension .ser, which is how 
GeneMapper projects are exported.

Note There is only one preset file extension 
(.ser) that can be used.

7 Cancel button Closes the Export Project window without 
exporting a project.
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Import Project
Window

The Import Project window enables you to import project data 
previously saved. See an explanation of each area in “Using the Import 
Project Window” on page 3-28.

1
2

3

4

5

6

7
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Using the Import Project Window

The elements called out in the figure in “Import Project Window” on 
page 3-27 are described in the table below.

Import Project Callouts

Item Name Description

1 Toolbar These icons are used as follows:

 -  Clicking moves display up one level in 
main pane.

  - Clicking moves display to “Home” level in 
main pane. This is usually 
“Profiles\<user>”.

 - Clicking creates a new folder at the 
present directory level.

  - Clicking presents a list of the contents of 
the selected folder.

  - Clicking presents details of the selected 
folder.

2 Drop-down 
directory menu

Select drive letter and/or folder.

3 Folder/file 
display pane

The contents of the disk or directory are selected 
in the toolbar and the directory menu is displayed 
here.

4 Import button This button imports the selected project.

5 File name field Enters name of selected project being imported.

6 Files of type 
field

This is a display filter for files (folders are always 
shown). Selects the file extensions for display:

♦ All Files (*.*) shows all files

♦ Java Serialized file (*.ser) shows only 
files with the extension .ser, which is 
how GeneMapper database projects 
are exported. 

Note There is only one preset file extension 
(.ser) that can be used.

7 Cancel button Closes the Import Project window without 
importing a project.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Using Panel Manager 4-1

Using Panel Manager4

Chapter Overview

Introduction This chapter describes the Panel Manager feature in the ABI Prism® 
GeneMapper™ Software Version 3.0, and provides instructions on how 
to use it for microsatellite data. Some information is provided regarding 
SNaPshot® specific features; however, additional information can be 
found in the tutorial guide (SNP Genotyping with ABI PRISM® 
GeneMapper™ Software Version 3.0, PN 4335524). Portions of this 
chapter are organized around the Panel Manager menu items to explain 
various features and actions that can be performed.

In This Chapter This chapter contains the following topics:

Topic See Page

Panel Manager Overview 4-2

Panel Manager Window Commands 4-6

Formats of Panel and Bin Text Files 4-23

Panel Table View 4-33

Marker Table View 4-35

Bin View - (for Microsatellites Only) 4-37

4
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Panel Manager Overview

Introduction The Panel Manager utility allows you to manage all of the chemistry 
kits, panels, markers, and bin definitions required for automated allele 
calling.

There are two ways to get data for the Panel Manager:

♦ Creating kits, panels, markers, and bins manually.

♦ Importing preformatted text files that contain panels, markers, and 
bin definitions. (See “Formats of Panel and Bin Text Files” on 
page 4-23 for two examples.)

Purpose of the
Panel Manager

Window

The Panel Manager window enables you to create, edit, and import 
panels. It features a:

♦ Tool for creating kit folders 

♦ Table for specifying panels

♦ Table for defining markers within a panel

♦ Graphical editor for creating and editing bins

Data for the panels is stored in the database. 

♦ Clicking the Apply button after making changes to a panel sends all 
changes to the database but keeps the window open for further 
edits. 

♦ Clicking OK sends all changes to the database and closes the 
Panel Manager window. 

The changes in panel data are then reflected in the Project and Plot 
windows.

Topic See Page

Purpose of the Panel Manager Window 4-2

Displaying the Panel Manager Window 4-3

Hierarchy of Panel Data 4-3

Panel Manager Toolbar 4-4

Panel Manager Navigation Pane 4-5
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When to Click the
Apply Button

♦ After deleting a kit, panel, marker, or bin set

♦ After making a number of edits

♦ After creating a bin set

Displaying the
Panel Manager

Window

To display the Panel Manager window, either:

♦ Click (Panel Manager) from the Project window toolbar, 
or

♦ Select Tools > Panel Manager in the Project window.

Hierarchy of Panel
Data

Conceptually, the hierarchy of panel data is as follows:

♦ Kit (chemistry kit or product)

♦ Panel

♦ Marker

♦ Bin

A kit is a collection of panels. A panel is a collection of markers. Bin sets 
are collections of the expected allele locations for markers contained 
within a kit. A different bin set should be used for each instrument type, 
as variations in run conditions and polymers affect allele positions.

The GeneMapper software requires kit, panel, and bin set names to be 
unique throughout the database and requires marker names to be 
unique within a panel. The Panel Manager enforces these requirements 
during user entry and editing of names as well as during data import.
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Since the Panel Manager allows users to add comments as needed, no 
history or audit trail of panel data changes is kept. Such comments 
provide a way for users to track changes and the reasons for the 
changes. Each kit, panel, and marker has a comment field.

Panel Manager
Toolbar

The toolbar icons enable specific Panel Manager actions similar to their 
associated menu items as described throughout this chapter. Position 
your mouse over an icon to view its tooltip description.

.

Item Description

1 New Kit/Panel/Marker icon automatically updates to 
reflect the current action depending on the item 
selected in the navigation pane (File menu).

2 Clear icon performs kit/panel/marker deletion (Edit 
menu).

3 Icons select bin options: Add Bin, Delete Bin, Edit Bin 
(Bins menu).

4 Icons allow viewing of Project alleles (Bins menu).

5 Icon switches view to full X-Axis and Y-Axis scales 
(View menu).

6 Pull-down menu allows selection of a bin set for a 
selected kit.

7 Icons select specific kit/panel/marker actions (Bins 
menu):

New Bin Set, 

Add Reference Data, 

Auto Bin, 

Panel Reference Data, 

Auto Panel

8 Dye color toggle icons (View menu).

1 2 3 4 5 6 7 8
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Panel Manager
Navigation Pane

The Panel Manager navigation pane is the primary navigation interface 
in the Panel Manager window. Since it is found in all Panel Manager 
views, as shown in the table below, it enables moving back and forth 
between the views to view, edit, and create kit folders, panels, markers, 
and bins. The elements of this field are described below.

Element Description

The Panel Manager root node is the container 
for all panels. It is the top level of the 
hierarchy.

Kits help users organize their panels in 
product- or project-specific folders. Clicking a 
kit folder displays the Panel table.

The Panel folder icon represents a set of 
markers. Clicking a panel folder displays the 
Marker table. For SNP kits, clicking a panel 
folder also displays a plot view.

The Marker icon represents an individual 
marker. Clicking a microsatellite marker 
displays the Bin view. Clicking an SNP marker 
displays the Bin table.
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Panel Manager Window Commands

Introduction The tables in this section describe the following Panel Manager views 
and menus.

File Menu The File menu offers options to the user to create or export kits, 
duplicate, import and export panels, and import and export bin sets.

New Kit/Panel/Marker

The New Kit/Panel/Marker command changes its name and function 
depending on the item selected in the Panel Manager navigation pane 
as follows:

♦ New Kit – This menu item is enabled when the Panel Manager root 
node is selected in the navigation pane and allows creation of a 
new kit folder. When creating a new kit:

– Enter in a unique kit name 

– Select the appropriate kit type (microsatellite or SNP) from the 
drop-down menu

– Click OK to add kit to navigation pane

Topic See Page

File Menu 4-6

Edit Menu 4-11

Bins Menu 4-12

View Menu 4-20
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♦ New Panel – This menu item is enabled when a kit folder is 
selected in the navigation pane and allows creation of a new panel 
folder. When creating a new panel:

– Select the “New Panel” name in the right hand window table 
and enter in the desired name. Names must be unique within 
the database. 

– Repeat to add multiple panels to a kit

– Press [Enter], then click Apply after entering a Panel name to 
update the navigator pane

♦ New Marker – This menu item is enabled when a panel folder is 
selected in the navigation pane and allows creation of a new 
marker. When creating new markers:

– Select the “New Marker” row in the right hand window table and 
enter in the appropriate information for each column. Refer to 
“Marker Table View” for more information.

– Repeat to add multiple markers to a panel

– Press [Enter], then click Apply to update the navigator pane

Duplicate Panel

The Duplicate Panel command creates a copy of a selected panel and 
places it in the same kit as the original with the name “[Selected 
Panel]-dup”. The panel and all associated bins with all bin sets are 
duplicated as well. This menu item is enabled when a panel folder is 
selected in the navigation pane.
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Import/Export Panels

The Import Panels command and the Export Panels command open the 
corresponding dialog box to allow importing/exporting of kits and 
panels. This is enabled when the Panel Manager root node is selected 
in the navigation pane. See “Formats of Panel and Bin Text Files” for 
more information.

Export Panels is not available when the Panel Manager root node is 
selected; it is only active when a kit is selected.

Import/Export Bin Set

The Import Bin Set command and the Export Bin Set command open 
the corresponding dialog box to allow importing/exporting of bin sets. 
This is enabled when a kit name is selected in the navigation pane. See 
“Formats of Panel and Bin Text Files” for more information. 

When bins are imported into a kit, GeneMapper software checks for 
bins that fall outside of their marker allele size ranges. If bins overlap or 
fall out of the marker range the Import Bins Options dialog box will 
open.
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The Import Bins Options dialog box allows you to choose how 
GeneMapper software handles the bins being imported. The numbered 
lines in the graphic above refer to the individual numbered descriptions 
in the figures on .

1.The option shown below adjusts the marker range to 
accommodate any bins that overlap the marker boundaries and will 
delete all bins that fall completely outside the marker size range.

1

2

3
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– The option shown below increases the marker allele size range 
to accommodate all overlapping and out of bounds bins.

– The option shown below does not affect the marker allele size 
range, all overlapping and out of bounds bins are deleted.

If all the bins in an import are inside their marker ranges, the dialog box 
does not open.

Backing up Panels and Bin Sets

The only way to back up panels and bin sets is to export them. You will 
be prompted for a location and name for the exported item. See “Export 
All Kits” on page 4-11.
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Export All Kits

The Export All Kits command opens the Export All Kits dialog to allow 
exporting all kits and their associated panels, markers, and bin sets to a 
selected location. When you use this option, panels retain their current 
panel name as listed in the Panel Manger. Bins are named as follows: 
[Kit name]_[Bin set name]_bins.txt. 

Print

The Print command opens the Print dialog box to enable printing.

Edit Menu The Edit menu contains the Undo command and the Clear command.

Undo

The undo command allows for the Clear command to be undone.

Clear

The Clear command deletes items selected in the navigation pane from 
the GeneMapper database, such as:

♦ Kits

Deletes the kit and all bin sets associated with that kit.

♦ Panels

♦ Markers

Use the Bins Menu items to delete bins and bin sets. 
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Bins Menu The Bins menu contains commands to edit markers and bins.

Edit SNP Marker

The Edit SNP Marker command opens the Edit SNP Marker dialog box 
allowing the user to edit the marker name and bin information for the 
selected marker. To enable this feature:

♦ Select the menu item when a SNP marker is selected in the Panel 
Manager Plot tab

OR

♦ Right-click on a SNP marker or bin in the Panel Manager Plot tab

Additionally, SNP markers and bins can quickly be edited by changing 
the data in the Panel Manager Table tab for a selected SNP Panel. 
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Delete SNP Marker

The Delete SNP Marker command deletes the SNP marker, and 
associated bins, selected in the Panel Manager Plot tab. To enable this 
feature:

♦ Select the menu item when a SNP marker or bin is selected in the 
Panel Manager Plot tab

OR

♦ Right-click on a SNP marker in the Panel Manager Plot tab

Add Bin

The Add Bin command creates a new bin associated with a panel as 
follows:

♦ For microsatellite data:

♦ For SNaPshot data:

Step Action

1 Select a marker in the Panel Manager navigation pane.

2 Select the Add Bin menu item OR right-click within the allele size 
range of the marker shown in the Panel Manager right-hand 
window to select the New Bin option.

3 Drag the length of the desired bin range with the mouse.

4 Edit the bin information in the Add Bin dialog box that opens.

Step Action

1 Select a SNaPshot panel in the Panel Manager navigation pane.

2 Select a marker in the Plot tab.

3 Select the Add Bin menu item OR right-click on a marker or bin in 
the Plot tab.

4 Edit the SNP Marker using the dialog box that opens.
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Delete Bin

The Delete Bin command deletes a marker bin as follows:

♦ For microsatellite data:

♦ For SNaPshot data:

Edit Bin

The Edit Bin command edits a marker bin as follows:

♦ For microsatellite data:

♦ For SNaPshot data:

Step Action

1 Select a marker in the Panel Manager navigation pane.

2 Select a bin to be deleted.

3 Select the Delete Bin menu item OR right-click on the bin and 
select the Delete Bin option.

Step Action

1 Select a SNaPshot panel in the Panel Manager navigation pane.

2 Select a bin to be deleted in the Plot tab.

3 Select the Delete Bin menu item OR right-click on the bin and 
select the Delete Bin option.

Step Action

1 Select a marker in the Panel Manager navigation pane.

2 Select a bin to be edited.

3 Select the Edit Bin menu item, or right-click the bin and select the 
Edit Bin option.

4 Edit the bin information in the dialog box that opens.

Step Action

1 Select a SNaPshot panel in the Panel Manager navigation pane.

2 Select a bin to be edited in the Plot tab.

3 Select the Edit Bin menu item, or right-click on the bin and select 
the Edit Bin option.

4 Edit the bin information in the Edit SNP Marker dialog box that 
opens.
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To quickly resize a bin, select a bin and adjust the right and left handles 
to the desired size range.

To move a bin, select a bin and holding down the mouse button, move 
the bin to the desired location. 

Edit Bin Dialog Box

Element Description

Name Editable; name of the bin can be alphanumeric.

Location Editable; location of the bin center in base pairs.

Left Offset Editable; the left boundary of the bin, expressed as the 
base pair distance to be subtracted from the location 
(default = 0.4).

Right Offset Editable; the right boundary of the bin, expressed as 
the base pair distance to be added to the location 
(default = 0.4).

OK Accepts the pending changes and closes the dialog 
box.

Validation: the following criteria apply:

♦ The edited bin must have a name unique in its 
marker.

♦ The edited bin must have a location and offsets that 
do not overlap any other bins in the marker.

If validation fails, an alert message will be displayed.

Cancel Closes the dialog box without accepting the pending 
changes
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New Bin Set

The New Bin Set command opens the New Bin Set dialog box, allowing 
the user to create a new bin set for the selected kit. Clicking OK checks 
the name for uniqueness; if the name is not unique, an alert is shown 
and the dialog box closes. The new bin set name then displays at the 
top of the Panel Manager window in the Bin Set pull-down menu.

Note Bin sets are always created at the kit level.

Note SNP kits can only contain one bin set.

Delete Bin Set

The Delete Bin Set command deletes the bin set currently listed for a kit 
in the Bin Set drop-down menu at the top of the Panel Manager window. 
If there are multiple bin sets associated with a kit, use the drop-down 
menu to select the appropriate bin set to be deleted. 

Note This action cannot be undone. 

New Offset 
Default (checkbox)

Checking this box sets a left and right offset default, to 
be used for subsequent creation of bins.

Mutant Bin Designates a bin as a mutant. Bin color is red.

Element Description
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Show Project Alleles

The Show Project Alleles command displays all of the marker’s allele 
calls that are present in the Genotypes table of the open project. Allele 
calls are displayed as blue asterisks. This option is enabled when a 
marker is selected in the Panel Manager navigation pane and 
genotypes exist for that marker. The option is for microsatellite data 
only. 

Add Reference Data

The Add Reference Data command opens the Add Reference Data 
dialog box, allowing the user to associate data with a microsatellite 
panel or SNaPshot kit for creating markers and bins.

For microsatellite panel reference data, samples must have been 
analyzed using the panel for which the data serves as a reference and 
the appropriate size standard.

For SNaPshot kit reference data, samples must have been analyzed 
using the appropriate size standard and an Analysis Method with 
SNaPshot as the Analysis Type.
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Panel Reference Data

This feature now works for both microsatellite and SNP data.

♦ SNP data

The Panel SNP Reference Data command opens the SNP 
Reference Data dialog box, allowing the user to organize the 
reference data imported at the kit level into panels. This feature is 
only used when creating panels manually, not when using the Auto 
Panel feature. The panel is enabled when a SNaPshot panel is 
selected and reference data has already been added at the kit level.

♦ Microsatellite data

The Panel Reference Data command allows you to remove 
reference samples from the selected microsatellite panel.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Using Panel Manager 4-19

Auto Bin

The Auto Bin command opens the Auto Bin dialog box to automatically 
create bins for a microsatellite panel. This feature is enabled when a 
microsatellite panel is selected and reference data has been selected. 
Refer to the Microsatellite Tutorial for more information. 

Auto Panel

The Auto Panel command opens the Auto Panel dialog box to 
automatically create panels, markers and bins for a SNaPshot Kit. This 
feature can only be used with reference data generated from the 
ABI PRISM® SNaPshot Primer Focus Kit. Refer to the SNaPshot Tutorial 
for more information.
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View Menu

Full View

Depending on the X- and Y-axes mode, the Full View command resets 
the X- or Y-axis to the:

♦ maximum range

♦ panel size range

♦ most recent Scale To range

X Axis Scale for SNP data

The X Axis Scale menu command controls the horizontal scale of the 
reference data electropherogram being viewed in the Panel Manager as 
follows:

♦ Scale to maximum – The electropherogram being viewed is scaled 
to its maximum base pair length as collected from the instrument.

♦ Scale to panel size range – The electropherogram being viewed is 
scaled to the size range available for the selected panel.

♦ Scale to - The user can define the horizontal range being viewed. 

To zoom in to a specific region on the X-axis of the electropherogram:

♦ Click and drag with the left mouse button the desired region on the 
X-axis. 

OR

♦ Right-click on the X-axis to open the X-Axis Scale menu command 
options.
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X Axis for Microsatellite data

The X Axis Scale menu command controls the horizontal scale of the 
reference data electropherogram being viewed in the Panel Manager as 
follows:

♦ Scale to maximum – The electropherogram being viewed is scaled 
to its maximum base pair length as collected from the instrument.

♦ Scale to marker size range - The electropherogram being viewed 
is scaled to the size range available for the selected marker.

♦ Scale to - This setting allows the user to define the horizontal range 
being viewed.

To zoom in to a specific region on the X-axis of the electropherogram:

♦ Click and drag with the left mouse button the desired region on the 
X-axis. 

OR

Right-click on the X-axis to open the X-Axis Scale menu command 
options.

Y Axis Scale

The Y-Axis Scale menu command controls the vertical scale of the 
reference data electropherogram being viewed as follows:

♦ Scale to maximum – The electropherogram being viewed is scaled 
to its maximum height as.

♦ Scale to- The user can set the Y-Axis scale value. 
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To zoom in to a specific region on the Y-axis of the electropherogram:

♦ Click and drag with the left mouse button the desired region on the 
Y-axis 

OR

♦ Right-click on the Y-axis to open the Y-Axis Scale menu command 
options. 

Dyes

The Dyes menu item controls the dye colors shown when viewing 
SNaPshot reference data and microsatellite reference data 
electropherograms in the Panel Manager Plot view. Checked when 
active. Multiple dye colors may be selected. 

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Using Panel Manager 4-23

Formats of Panel and Bin Text Files

This section provides an example of a file used to import panel 
definitions and a file used to import bin definitions. Files like these are 
created using Microsoft® Excel or other spreadsheet programs. Files 
must be saved as a tab-delimited text file.

Topic See page

Panel Definition Example 4-24

Bins Definition Example 4-26

Panel Definitions for SNaPshot 4-28

Bins Definitions for SNaPshot 4-30

Import and Export Files 4-32
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Panel Definition
Example

The examples below show panels defined in the format used by 
GeneMapper software v3.0 for a panel definition in a tab-delimited text 
file (.txt) using notepad or wordpad, or a Microsoft® Excel spreadsheet 
saved as a .txt file.

Columns:

1: marker name
2: dye color
3: min ASR (ASR = allele size range; actually the marker size range)

4: max ASR
5: control allele names as comma-separated bin names (1, 2)

(if none, there must be a dash “-”)
6: type of repeat (2 = dinucleotide, 3 = trinucleotide, 4 = tetranucleotide, 

5 = non-repeat)
7: marker-specific stutter ratio (if none, use a zero “0”)
8: comments (if none, write “none”)

Notice that there are no extra rows between markers and panels.

1 2 3 4 5 6 7 8
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Columns:
1: marker name
2: dye color

3: min ASR (ASR = allele size range; actually the marker size range)
4: max ASR
5: control allele names as comma-separated bin names (1, 2)

(if none, there must be a dash “-”)
6: type of repeat (2 = dinucleotide, 3 = trinucleotide, 4 = tetranucleotide, 

5 = non-repeat)
7: marker-specific stutter ratio (if none, use a zero “0”)

8: comments (if none, write “none”)
Notice that there are no extra rows between markers and panels.

1 2 3 4 5 6 7 8
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Bins Definition
Example

The examples below show bins defined in the format used by 
GeneMapper software v3.0 in a tab-delimited text file (.txt) or an Excel 
spreadsheet saved as a .txt file.

Note The ASR in the bin definitions file should match the ASR in the Panels 
definition file. Also, kit, panel, and marker names must be the same between the 
two files.

Columns:

1: bin name
2: bin center
3: bin left offset

4: bin right offset

1 2 3 4

Rows:

1: GM version number
2: Kit name
3: bin set name

4: panel name
5: marker name

1
2
3
4
5
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Columns:

1: bin name
2: bin center
3: bin left offset

4: bin right offset

1 2 3 4

Rows:

1: GM version number
2: Kit name
3: bin set name

4: panel name
5: marker name

1
2
3
4
5
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Panel Definitions
for SNaPshot

The examples below show SNP panels defined in the format used by 
GeneMapper software v3.0 in a tab-delimited text file (.txt) or an Excel 
spreadsheet saved as a .txt file.

Columns:

1: marker name
2: control allele names as comma-separated bin names 

(A, G) (if none, there must be a “-”)
3: comments (if none, write “none”)

1 2 3
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Columns:
1: marker name

2: control allele names as comma-separated bin names 
(A, G) example (if none, there must be a “-”)

3: comments (if none, write “none”)

1 2 3
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Bins Definitions
for SNaPshot

The examples below show SNP bin definitions in the format used by 
GeneMapper software v3.0 in a tab-delimited text file (.txt) or an Excel 
spreadsheet saved as a .txt file.

Note ASR = Total allele size range. The allele size data automatically exports 
and then the range is printed.

Columns:

1: bin name
2: bin size range min
3: bin size range max

4: bin color

1 2 3 4
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Columns:
1: bin name
2: bin size range min

3: bin size range max
4: bin color

1 2 3 4
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Import and Export
Files

The Panel Manager imports and exports two text file data formats, 
panel data and bin set data. These files are tab-delimited and the 
following rules apply:

♦ Files to be imported must have the correct number of columns in 
the correct order.

♦ On import, panel and bin set names are checked for uniqueness in 
the GeneMapper™ database and markers are checked for 
uniqueness within the panel that will contain them. An alert is 
presented if a name is not unique and such a file cannot be 
imported.

♦ If any errors are found during import, no data from the file is 
accepted by the Panel Manager.

♦ Lines beginning with “#” are comments and are ignored on import.

♦ Both Panel and Bin set file formats have a header line with a 
GeneMapper software version string:

Version GM v 3.0

If the first line of a file to be imported does not begin with “Version 
GM,” then GeneMapper software handles the import as a 
GeneMapper software 1.x panel import. If the file is in GeneMapper 
software 1.x format, then it is imported without errors. If the file is in 
GeneMapper software 2.x or 3.x format, the file will not be imported 
and the following error alert will be presented: “The format of this 
file is wrong. Correct the file and try again.” 

If the data type label does not match the type specified in the import 
command, the file is not imported and an alert is presented.

A PanelImportLog.txt file is generated during import of a panel or bin 
set and will list any errors encountered. This file is found in the 
GMdistribution\app folder on your hard drive. Panels and bin sets 
created in GeneMapper software v1.0.2 or GeneMapper software v2.0 
are automatically updated when imported into GeneMapper software 
v3.0
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Panel Table View

Introduction Selecting the Panel Manager icon or text in the navigation pane (left 
pane shown below) shows a table of the current Panel Manager folders 
or kits in the right portion of the window. Selecting a particular kit 
produces a list of panels in the right portion of the window. This list is 
called the Panel Table view.

Tasks you can perform in the Panel Table view include:

♦ Editing panel names and entering comments in the panel table

♦ Creating new panels using the New Panel command 

♦ Deleting an existing kit by selecting it in the Navigation pane and 
then choosing the Clear command

♦ Exporting panels and bin sets used for project analysis to backup

Note Editing or deleting kits, panels, and bin sets will prevent your from 
displaying analyzed projects. Export any panels and bin sets that you might use 
at a later date, or for reanalysis of old projects.

Note A Warning alert is shown whenever kits or panels are deleted to remind 
you that this reference data may have been used previously in Sample analysis.
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Panel Table
Columns

The table below lists the columns in the Panel table:

Note All columns are resizable.

Name Rule for
Panels

Panel names must be unique (within a kit and across kits).

Column
Name Description

Panel 
Name

Editable. Contains the name of the panel. Cell accepts 
alphanumeric characters (restricted for any invalid symbol 
characters – includes all Microsoft Windows invalid 
characters).

Note When the cell is closed, the software must check that 
the name is unique. An alert message will display if the name 
is not unique.

Comments Editable. Contains comments regarding the panel. Cell 
accepts alphanumeric characters.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Using Panel Manager 4-35

Marker Table View

Introduction Selecting a panel in the navigation pane displays the Marker table for 
that panel. The Marker table, shown below, enables you to view, create, 
and edit marker names and associated data. 
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Marker Table
Columns

The figure on page 4-35 shows the columns in the microsatellite marker 
table. They are further described in the following table.

Marker table column descriptions:

Column Description

Marker 
Name

Editable. Contains the name of the Marker. Cell accepts 
alphanumeric characters from the keyboard. The field is 
validated if the marker name is unique in the panel.

Note Marker names are case insensitive (i.e., D1S83 is the 
same as d1s83). 

Dye Color Editable. Contains the color names blue, green, yellow, red, 
orange. The field is validated if it is one of these text strings, 
which are not case-sensitive.

Min Size Editable. Contains the starting base pair number for the 
allele size range. Cell accepts numeric characters from the 
keyboard.

The range defined by the Minimum Size parameter should 
include the stutter peaks for the smallest allele. 

Max Size Editable. Contains the ending base pair number for the allele 
size range. The cell accepts numeric characters from the 
keyboard.

Control 
Alleles

Editable. Contains a comma separated list of control allele 
names in the marker. No validation.

Marker 
Repeat

Editable. Indicates a di-, tri-, or tetra-nucleotide repeat.

Contains a number for the number of repeats: 2, 3, 4.

The field also accepts 9 for nonrepeat containing markers. 
The field is valid if it contains 2, 3, 4, or 9; any other number 
is invalid. 

Marker 
Specific 
Stutter Ratio

Editable. Contains the ratio of stutter peak to main peak. 
Sets the maximum value of stutter for a specific marker, as 
opposed to using a global value for all markers.

Comments Editable. Contains comments regarding the marker. Cell 
accepts alphanumeric characters from the keyboard.

Ladder 
Alleles

Editable. Comma-separated list of allele names in the allelic 
ladder. No validation. Applicable only to Human Identification 
(HID) genotyping or applications that use allelic ladders.
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Bin View - (for Microsatellites Only)

Introduction The Bin view enables you to view, create, and edit bins. The data 
displayed in the Bin view, imported into the Panel Manager using the 
Import BinSet command, is used to create the bins associated with the 
marker.

Bins allow the user to average the minor variations in size that occur 
from run to run and capillary to capillary. 

Description of the
Bin View

Reference Data, Bins, and Allele Calls

Reference data includes descriptions of bins (name, location, and 
boundaries) and the sample allele calls used to construct the bins. In 
the Bin view, the vertical bars are bins that are originally associated with 
the Markers imported as reference data. The “+” symbols shown in the 
figure above (marked in red on the monitor) are from the reference 
alleles used to build the bin set indicated in the drop-down menu at the 
top of the window. The red + s shown when those alleles are used in the 
autobinning process or in the manual process of bin creation.
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If you analyze data using a bin set like that shown above, you will see 
the + s as shown above. Then, when you click the Show Project Alleles 
icon,

 the + s will be overlaid by a set of “*” symbols (marked in blue 

on the monitor), which represent the data associated with a particular 
bin for the current project in the Project window and called according to 
the allele associated with the bin.

Bins may be used for calling alleles with or without allele calls in the 
reference data, but project alleles (* s) are required for automatic bin 
generation (the Auto Bin function). Reference alleles (+ s) are identified 
as a result of the Auto Bin command.

Selecting a reference data sample in the navigation pane displays that 
particular sample’s electropherogram with bins overlaid to provide easy 
viewing while editing markers.

X- and Y-axes, Genotype Quality Symbols, and Cursor Location 
Information

The Bin view X-axis is the fragment size in base pairs; the Y-axis is 
quality, or signal height if a reference sample is selected. Vertical 
shaded bars are the bins that will be used to call alleles for the selected 
marker. The symbols (blue stars), described above as Allele Call 
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indicators, represent Genotype quality values on the Y-axis for the 
alleles of samples that have been analyzed and are currently displayed 
in the open project. The equivalent positions in the reference data are 
marked with red + s. 

The Genotype quality values, representing analysis results, are not 
editable. Bin location, boundaries, and names are editable. Cursor 
location in base pairs for any selected bin are shown under the X-axis to 
the left. The Bin Sets drop-down menu, located just above the Bin view 
pane, selects the bin set that is applied to the marker.

Marker Allele Size Range (ASR)

Reference data for bins includes the marker ASR. This is the size range 
of bins in a marker and is set by the user to allow multiplexing of 
markers in a sample; an ASR should be changed only when a marker is 
under development.

ASR boundaries can be edited in the marker table or in the Bin view by 
adjusting the ASR handles on the right and left hand sides of the 
screen. The bins in a marker must not extend beyond the marker ASR. 
When bins are created and viewed in the Bin view, they are restricted 
so that their range does not extend beyond the marker ASR. The Show 
Alleles command may show new allele calls for a marker outside that 
marker’s ASR, but bins cannot be created or extended to include alleles 
outside the ASR. To create bins for alleles that fall outside the ASR, edit 
that marker’s ASR first and then click Apply. Then you can add a new 
bin.

Bins must not overlap in a microsatellite marker. When bins are created 
and edited, their locations and offsets are restricted to avoid overlap.

Import and export commands for panels and bin sets are enabled in the 
table views of the Panel Manager. Imported bin set reference data 
includes the bin boundaries but not sample reference data (the “+ s”).
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Automatic Bin
Builder and

Automatic Bin
Assignment

Algorithm

This section discusses the features of the Automatic Bin Builder (ABB) 
and Automatic Bin Assignment Algorithm (ABAA). 

Combining Unique Features

The ABB process is used, along with the outcomes of the Multiple Allele 
Peak Determination Algorithms (MAPDA) and in conjunction with the 
ABAA to ensure that the called alleles are of the highest accuracy. The 
key benefit of combining these algorithms with the ABB is that, since 
only a small number of questionable alleles result from the integrated 
process, manual reexamination of the allele information is significantly 
minimized.

Automatic Bin Builder

The ABB is the first step in accurate allele assignment. The process of 
creating bins starts with a collection of Sample files. Bins are created by 
the ABB based on the chosen panel information and successive allele 
calls from the Sample file collection. As each Sample file in the 
collection is processed, the bin definitions are refined to reflect the 
actual data. The bin centers and widths continue to be refined until all 
Sample files in the collection are processed and GeneMapper software 
is ready for its final step of allele calling, Automatic Bin Assignment.

Automatic Bin Assignment Algorithms

Once bins are completely defined by the ABB, allele peaks are 
accurately and automatically assigned to their corresponding bins to 
complete the allele calls using the ABAA. The allele assignment 
algorithms calculate the certainty of each allele peak assignment, and 
determine if an allele should be called. Bin assignment quality values 
are assigned to the allele and become part of the overall PQVs.

Questionable alleles are appropriately marked with either a 
“Check  or “Low Quality ” status marker. See the table under 
“Genotype View Columns” on page C-7 for more information on how 
this information is displayed in the Genotypes view.

”
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Using Analysis 
Methods 5
Chapter Overview

Introduction This chapter provides information on how to use the Analysis Methods 
feature in the GeneMapper Manager window of the ABI Prism® 
GeneMapper™ Software Version 3.0, and describes how to use the 
features of the Analysis Method Editor.

In This Chapter This chapter contains the following topics:

Topic See Page

Analysis Methods Tab 5-2

Analysis Method Editor 5-5

5
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Analysis Methods Tab

Introducton The Analysis Methods Tab is used to create custom analysis methods 
for analyzing sample files. An analysis method is a set of algorithm 
parameters that are applied to data during analysis.
-

Default Analysis
Methods

GeneMapper software v3.0 contains the following standard Applied 
Biosystems profiles:

Note These profiles can be altered but should not be deleted. They are 
intended to be used as models for customizing new analysis methods.

Default Analysis Type Bin Set
Detection 
Algorithm

Microsatellite Microsatellite None Basic

SNP Genotyping SNP Genotyping None Basic

3730 DS-33 
Install

Microsatellite 3730 DS-33 
Install Bins

Basic (For use 
with the Applied 
Biosystems 
3730 DNA 
Analyzer only)
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About the Analysis
Methods Tab

The Analysis Methods tab contains a list of analysis methods in the 
database. This tab is used to manage the contents of the project 
window.

To display the Analysis Methods tab, select Tools > GeneMapper 
Manager > Analysis Methods.

Parts of the Analysis Methods tab:

Item Description

Name column Analysis method name

Last Saved column Date/Time stamp showing when the 
analysis method was last saved

Owner column User name of the person who 
created the analysis method

Instrument column The type of instrument used 

Analysis Type column Identifies the analysis mode of the 
analysis method (i.e., HID, 
Microsatellite, SNaPshot)
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New button Opens the New Analysis Method 
dialog box. Always enabled.

This dialog box asks you to select 
the analysis type before opening the 
Analysis Method Editor.

The analysis type you select:

♦ Sets the analysis algorithm

♦ Displays the appropriate fields for 
that type of analysis in the 
Analysis Method Editor dialog 
box.

Open button Opens the editor for a selected 
analysis method. Enabled when a 
analysis method is selected.

Save As button Displays the Save As dialog box. 
Enabled when an analysis method is 
selected.

Import button (.xml file type) Displays a dialog box for Importing 
analysis methods. Always enabled.

Export button (.xml file type) Displays a dialog box for Exporting 
selected analysis methods. Enabled 
when one or more analysis methods 
are selected.

Delete button Deletes the selected analysis 
method(s)

Done button Closes the GeneMapper Manager

Parts of the Analysis Methods tab: (continued)

Item Description
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Analysis Method Editor

Introduction The Analysis Method Editor allows you to create or edit analysis 
methods to be used for analyzing your sample files. The analysis 
method determines the type of application being analyzed and allows 
for customization of the peak detection algorithm and quality value 
settings.

Flowchart

In the General tab, type a name for the new setting

In the Alleles tab, select the bin set to use

In the Peak Detector tab, choose a peak detection
algorithm for your application

In the Peak Quality tab, set minimum requirements

In the Quality Flags tab, adjust PQV and threshold settings

Select Tools > GeneMapper Manager

Select the Analysis Methods tab

Click New

Select analysis type

Click OK to save
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Accessing the
Analysis Method

Editor

Access the Analysis Method Editor in the following ways:

♦ Click Tools > GeneMapper Manager > Analysis Methods Tab > 
New or Open

♦ In the Project Window, click the Samples tab. Click New Analysis 
Method to create a new method, or double click an existing method 
to edit it.

♦ Select a sample in the project window and click the Analysis 
Method Editor icon on the toolbar. Edit the currently selected 
samples’ analysis method, if necessary.

Note The Analysis Method Editor icon is not active unless a sample with an 
analysis method is selected.

New Analysis
Method Dialog

Box

When you create a new analysis method, the following dialog box 
opens prior to opening the analysis method editor. This dialog box 
allows you to select the analysis type for your samples, and controls the 
items available for customization within the Analysis Method Editor tab.
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General Tab In the General tab, enter a name and description for the analysis 
method.

Note The Analysis Type reflects the choice selected in the New Analysis 
Method dialog box.

Allele Tab In the Allele tab, set a number of parameters controlling allele calling, 
including:

♦ Bin Set

♦ Marker Repeat Type (for Microsatellites)

♦ SNP Cut-Off value (for SNaPshot)
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Bin Set

Bins are a way of matching your data to the allele definitions contained 
in the panel assigned to the data. Bins are the locations in which you 
expect an allele to display. Alleles are defined in Markers as a size 
range (bin) centered around the average size in base pairs, for example 
101.5 +⁄- 0.4 bp. If your sample has a peak that falls within a bin, the 
allele in your sample file is called with the identifier assigned to that 
allele bin.

A bin set must be chosen for your analysis in order to guide the 
algorithms in assigning allele calls. This drop-down list enables you to 
choose the bin set to be used for analysis. The bin set chosen for 
analysis must match the kit/panel chosen for analysis.
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Marker Repeat Type (for Microsatellites)

As stated on the Allele tab view, no entries are required for dinucleotide 
repeats because the application calculates them automatically.

Check the “Use marker-specific stutter ratio if available” check box to 
insert stutter ratio information into the Panel Manager marker’s table. If 
you know the stutter ratio for an individual marker, you can set this 
number under the “Marker Specific Stutter%” column in the Panel 
Manager. Checking this box in the Alleles page causes the algorithm to 
use your defined stutter ratio and not the ones defined in the Stutter 
ratio box. Different values can be used for different markers.

The “Cutoff value” ignores all peaks less than the cut-off ratio of the 
largest peak in the allele size range.

The “PlusA ratio” and “Stutter ratio” refer to the ratios you are expecting. 
For example, if you expect a stutter percentage of 20% for your 
markers, enter in 0.2.

The two columns labeled Trinucleotide and Tetranucleotide allow entry 
of all related parameters directly into fields, so that everything can be 
seen at once. The following table provides information about the ranges 
of possible values.

Parameter Min Max
Trinucleotide 

Default 
Tetranucleotide 

Default

Cut-off value 0.0 1.0 0.2 0.25

PlusA ratio 0.0 1.0 0.95 0.95

PlusA distance 0.0 ? (Infinite) 1.6 bp 1.6 bp

Stutter ratio 0.0 1.0 0.95 0.15

Stutter distance 0.0 ? (Infinite) from 0 to 3.5 bp from 0 to 4.5 bp
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The parameters in the table (except Cutoff value) are defined 
graphically in the following figure.

SNP Cutoff Value (for SNaPshot)

For heterozygous SNP genotyping alleles, if the highest peak height is 
X and a second, lower peak height is Y, then the ratio Y/X must be 
larger than the cutoff value in order for the second peak to be called. 
The default value is set at 0.3 and may need to be further optimized for 
your data.

Range Filter

The Range Filter allows you to remove labels from peaks within a 
specific size range for each color.

Stutter

Stutter

Stutter Distance

Allele PlusA

A

B

PlusA Distance

PlusA ratio = B
A
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Peak Detector Tab Use the Peak Detector tab to select the algorithm to use for detecting 
peaks:

♦ Basic

♦ Advanced

♦ Classic

See Appendix B, “Software Genotyping Algorithms,” for additional 
information on Basic, Advanced, and Classic peak detection algorithms. 

Basic Peak Detection Algorithm

The default, Basic peak detection algorithm, is used for most 
applications.

The application sets the level automatically for these five dye colors 
when “Automatic” is selected: blue, green, yellow, red, and orange. This 
level represents the minimum signal strength that will be identified as a 
peak for each dye (equivalent to 10 times the noise).

Selecting the User Specified option button enables the number entry 
fields for five dye colors. These numbers are the minimum signal 
strength that will be identified as a peak (in relative fluorescent units). 
For all dyes, the default is 50, minimum is 1, and the maximum is any 
number of 10 digits. 
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Advanced Peak Detection Algorithm 

This algorithm is similar to the ABI PRISM® GeneScan® software on 
Windows NT operating system method of analyzing size standards and 
performing peak detection. Information on the individual parameters 
can be found in Appendix B, “Software Genotyping Algorithms.”
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Classic Peak Detection Algorithm

This algorithm is similar to the GeneScan software on the MacIntosh 
operating system method of analyzing size standards and performing 
peak detection. Refer to Appendix B, “Software Genotyping Algorithms,” 
for additional information.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



5-14 Using Analysis Methods

Peak Quality Tab The Peak Quality page sets the thresholds for warning flags in the 
Genotypes view in the Project window. The PQV system uses these 
values to determine what types of warning flags should be set for each 
parameter. When you click the Peak Quality tab, the following page 
opens.

The settings include the following:

♦ Signal Level (in fluorescent units)

– Homozygous min peak height (default = 200)

– Heterozygous min peak height (default = 100)

Peaks between the minimum peak height and the signal peak 
height setting (set in the Peak Detector page) will still be scored, but 
the peak height flag will be triggered.

♦ Heterozygote Balance

– Min peak height ratio (default = 0.5)

In a heterozygous allele, the higher peak height is X and the lower 
peak height is Y. If the ratio Y/X is less than the Heterozygote 
Balance, then the process quality value flag for Peak Height Ratio 
will be triggered and the GQ value will be lower.
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♦ Peak Morphology

– Max peak width (basepairs) (default = 1.5)

♦ Pull-up peak

– Pull-up percentage (default = 0.1)

Considers the ratio of any color peak directly under a major peak. 
Flags Spectral Pull-Up quality value as in the Genotypes table.

♦ Allele Number

– Max expected allele number (default = 2)

If analyzing polyploid alleles, enter in the maximum number of 
alleles you expect. You must also set the table profile to display the 
correct number of alleles.

♦ SNP (for SNaPshot application only)

– Double peak (default = 0.5) 

(See “PQV Flags on the Genotypes Page” in Appendix A.)
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Quality Flags Tab Use the Quality Flags tab to set the importance level of the PQVs 
available for microsatellite and SNP analysis. The PQVs are weighted 
on a scale of 0 to 1, with 0 being of no importance and 1 being of the 
highest importance. Most defaults are set at 0.5, except for Out of Bin 
Allele, which is set at 0.8. These defaults emphasize the point that if a 
peak falls outside a bin, it should have a lower genotype call. The 
Default button will reset these calls to the default numbers discussed in 
the Peak Quality Tab section on page 5-14.

PQV Thresholds

Use the options under PQV Thresholds to set Pass/Check/Low Quality 
thresholds for the Sizing Quality (SQ) parameter for the Samples view 
and the Genotype Quality (GQ) parameter for the Genotypes view. (See 
the figure on page 5-16.) Anything that is not labeled Pass or Low 
Quality will be labeled as check.
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Options

The Quality metric columns are set to display color symbols by default. 
However, the SQ column in the Samples view and the GQ column in the 
Genotypes view can be set to display the numerical equivalent on which 
the color symbols are based for these columns. This setting is made in 
the Analysis tab in the Options window by clicking the Numbers option 
button for the Quality Metrics Display setting.

Data entry restrictions for the PQV thresholds ensure that the lower limit 
of the Pass range is always greater than the upper limit of the Low 
Quality range. The Check range is the interval between Pass and Low 
Quality, if any. For example, if you use the default threshold settings 
shown in the figure above, any result over 0.75 passes, any result at 
0.25 or below fails, and any result from 0.26 to 0.74 will be marked for 
you to check. (See “Process Component-Based Quality Values,” in 
Appendix A.)

When the default setting for the Quality Metrics Display (Analysis tab in 
Preferences window) is “Symbols,” a Pass for the SQ and GQ 
parameters is indicated by a green square  a Check is indicated by 
a yellow triangle , and a Low Quality is indicated by a
red octagon 

Some quality metrics are either Pass or Low Quality (for example, 
Background Peak), and some are warning flags with either Pass or 
Check values (for example, File Not Found). Such values are not 
adjustable by the Threshold parameter.

,

.
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Using Table Settings 6

Chapter Overview

Introduction This chapter provides information about the Table Settings tab in the 
GeneMapper Manager window of the ABI Prism® GeneMapper™ 
Software Version 3.0, and describes how to use the features of the 
Table Settings Editor.

In This Chapter This chapter contains the following topics:

Topic See Page

Table Settings Tab 6-2

Table Settings Editor 6-4

6
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Table Settings Tab

Introduction Use the Table Settings tab to perform the following tasks:

♦ Create new profiles

♦ Hide and show table columns

♦ Filter the table entries (rows) in Project windows

Default Table
Settings

GeneMapper software v3.0 contains the following standard Applied 
Biosystems profiles:

– Default

– SNP Default

– Microsatellite Default

Default is a general profile, SNP Default is intended for SNaPshot 
samples,and Microsatellite Default is intended for Microsatellite 
samples. These profiles can be used as models for customizing new 
profiles.

Table Settings Tab To display the Table Settings tab, select Tools > GeneMapper 
Manager > Table Settings.
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Table Settings allow you to determine what columns are viewed in the 
Samples and Genotypes tab, and to set filtering properties.

The Table Settings tab contains a list of Table Settings in the database. 
This tab is used to manage the contents of the Project window by 
providing the following menus and interface elements.

.

Parts of the Table Settings tab:

Item Description

Name column Table Setting name

Last Saved column Date/Time stamp displaying when 
the object was last saved

Owner column User name

Description column Description of the object

New button Opens the Table Setting Editor 
window 

Always enabled

Open button Opens the editor for selected table 
settings

Enabled when a single object is 
selected

Save As button Displays the Save As dialog box 
Enabled when a single object is 
selected

Import button (.xml file) Displays a dialog box for Importing 
objects

Always enabled

Export button (.xml file) Displays a dialog box for Exporting 
selected objects

Enabled when one or more objects 
are selected

Delete button Deletes the selected object(s)

Done button Closes the GeneMapper Manager
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Table Settings Editor

Introduction Use the Table Settings Editor to show or hide information specific to 
your sample, add filtering capabilities, and give content information for 
each column in the project window. The Table Settings Editor window 
contains the following three tabs:

♦ General

♦ Samples

♦ Genotypes

The General Tab The General tab provides the capability to give a name and description 
to a new profile.

Note You cannot change the name of an existing profile, only the description.
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The Samples Tab The Samples tab provides the capability to filter columns in the 
Samples table of the project window.
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The Genotypes
Tab

The Genotypes tab provides the capability to filter columns in the 
Genotypes table of the project window and the capability to control the 
allele settings.
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The Sample and
Genotypes Tab

Elements

The Samples and Genotypes tabs display the Table Setting properties 
that will be applied to the corresponding tabs in the Project window. The 
properties or elements are described in the table below.

Samples and Genotypes Settings

Element Description

Column settings These settings contain the valid columns for either 
Samples or Genotypes data.

♦ Show column - List with an editable check box 
for each Project column, controlling whether the 
column is shown or hidden

♦ Column column - List of column headings for 
the Project window

♦ Filtering column - List of filtering properties for 
each Project window column

♦ Content column - Sets what information is 
displayed in each Project window column as 
selected by the appropriate filtering method. 
“N/A” indicates that no comments can be made 
for these rows.

Filtering Properties 
(Summary)

(For more specific 
information, see 
“Filtering Controls” 
on page 6-10.)

The filtering properties for a Project table column 
are controlled in the Filtering and Content columns. 
Modifying these settings updates the property in the 
Column/Filter table. For more information, see 
“Filtering Controls” on page 6-10.

OK Closes the Table Setting Editor window and applies 
any pending changes to the Project window.
Contents of the Table Setting Editor are saved to 
the GeneMapper database.

Cancel Closes the Table Setting Editor window without 
making any pending changes.

Show Selects all highlighted rows as visible.

Hide Selects all highlighted rows as hidden.
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Allele Settings

The Allele Settings box on the Genotypes page of the Table Setting 
Editor window controls how the Allele, Size, Height, Area, Mutation and 
Comment columns are displayed in the Genotypes view.

Allele Settings Description

Number of Alleles The number of alleles for which genotypes are 
displayed.

The default value is 2. This value is correct in most 
cases. However, when you are analyzing polyploid 
data you should change this value to the 
maximum expected allele number to view all calls.

Keep Allele, Size, 
Height, Area, Mutation 
and Comment together

If the box is unchecked:

– then the columns display as:

Allele 1, Allele 2, Size 1, Size 2, 
Height 1, Height 2, Area 1, Area 2, 
Mutation 1, Mutation 2, Comment 1, Comment 2

or

If the box is checked:

– then the columns display as:

Allele 1, Size 1, Height 1, Area 1, 
Mutation 1, Comment 1, 
Allele 2, Size 2, Height 2, Area 2, 
Mutation 2, Comment 2
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Creating a New
Table Setting

Editing a Table
Setting

Deleting a Table
Setting

To create a New Table Setting:

Step Action

1 Select GeneMapper Manager > Table Settings and click New to 
open the Table Setting Editor window.

2 In the General tab, enter a name for the new setting and a 
description if necessary.

3 Open the Samples and/or Genotypes tabs and select the 
desired contents for the Samples and Genotypes tables in the 
corresponding tabs.

4 Click OK to save the new setting.

To edit a Table Profile:

Step Action

1 Select Tools > GeneMapper Manager to open the GeneMapper 
Manager window.

Note If the table is selected in the project window drop down 
menu, then you can click the Table Settings icon or Tools > 
Table Setting Editor.

2 Select the Table Settings tab.

3 Select a table setting name and click Open. The selected 
setting opens.

4 Perform edits in the table setting.

Note See The Sample and Genotypes Tab Elements on 
page 6-7.

5 Click OK when you have completed editing. The changes you 
have made are saved to the Table Setting.

To delete a Table Setting :

Step Action

1 Select the Table Settings tab in the GeneMapper Manager 
window.

2 Select a table setting name and click Delete.

A warning alert is shown. Click OK to remove the setting.
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Filtering Controls The Table Settings column labeled “Filtering”, shown in the figure 
below, is used to filter or set the type of record or display presented for a 
Project window column. 

Samples View Column Filtering Settings

Note When you apply these settings to filter parameters, be aware that when 
no instance of the type specified exists, the Sample Table displays blank. If this 
occurs, return to the Table Manager and reset the filter.

The following information describes how to use the filter settings for the 
Samples Column Settings. The default “Show All Records” can be 
changed to one of the following:

Samples view filter settings:

Column Name Filter Settings

Status
Sample File

Analyzed or Not Analyzed
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Sample Name
Sample ID
Comments
Analysis Method
Panel
Size Standard
Matrix
Run Name
Instrument Type
Instrument ID
Run Date & Time
User Defined Columns

Show Records Containing 

Note This setting allows specification by a 
string. Input this information into the Content 
column.

Sample Type Sample, Control, Allelic Ladder, Primer 
Focus, or Negative Control

Reference Data
Off-scale
Sizing Quality Invalidated

Yes or No

Sample File Not Found
Matrix Not Found
Size Standard Not Found

Show Pass (green squares) or Show Low 
Quality (red octagons)

Samples view filter settings: (continued)

Column Name Filter Settings
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Genotypes View Filter Settings

Note In applying these settings to filter parameters, be aware that when no 
instance of the type specified exists, the Genotypes table will be displayed 
blank. If this occurs, return to the Table Manager and reset the filter.

The following information describes how to use the filter settings for the 
Genotypes Column Settings. The default “Show All Records” can be 
changed to one of the following:

Sizing Quality (SQ) Show Pass, Show Check, or Show Fail

Note These settings restrict the display to 
those records meeting these criteria.

Genotypes view filter settings:

Column Name Filter Settings

Sample File
Sample Name
Sample ID
Run Name
Panel
Marker
Allele
Size
Height
Peak Area
Mutation
AE Comment
Integration Comments
User Defined Columns

Show Records Containing

Note This setting allows specification by a 
string. Input this information into the Content 
column.

Samples view filter settings: (continued)

Column Name Filter Settings
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Dye Blue, Green, Orange, Red, or Yellow

Note This setting can be changed to display 
either all colors “Show All Records” or the choice 
of display of an individual color. SNaPshot data 
cannot be filtered by this selection.

Off-scale
Sharp Peak (M)
One Basepair Allele (M)
Single Peak Artifact (M)
Split Peak (M)
Out of Bin Allele
Peak Height Ratio
Low Peak Height
Spectral Pull-up
Allele Number
Broad Peak
Double Peak (SNP)
Narrow Bin (SNP)
Control Concordance
Overlap (HID)

Show Pass (green squares) or Show Check 
(yellow triangles)

Allele Edit
Allele Display Overflow

Yes or No

Genotypes view filter settings: (continued)

Column Name Filter Settings
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Genotype Quality (GQ) Show Pass, Show Check, or Show Low Quality

Genotypes view filter settings: (continued)

Column Name Filter Settings

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Using Plot Windows - Samples and Genotypes 7-1

7Using Plot Windows - 
Samples and Genotypes7
Chapter Overview

Introduction This chapter describes how to examine and interpret 
electropherograms within the ABI Prism® GeneMapper™ Software 
Version 3.0 Samples and Genotypes plot windows, and explains the 
various electropherogram settings and interactions in the plot window 
menu items.

In This Chapter This chapter contains the following topics:

Topic See Page

About the Plot Window 7-2

Plot Window Toolbars 7-4

Plot Window Menus 7-5
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About the Plot Window

Introduction The Samples and Genotypes plot windows allow you to visually assess 
your data. If genotype calls were made, you can also view and edit 
allele calls assigned by the GeneMapper software algorithms.

Purpose of the Plot
Window

Samples Plot Window

The Samples plot window allows you to:

♦ View electropherograms on a per sample basis

♦ View a sizing or genotypes table for sample(s) shown

♦ Overlay all samples to determine size standard quality

♦ Edit markers and bins

♦ View the relationship between controls and samples

♦ Edit allele calls

Genotypes Plot Window

The Genotypes plot window allows you to:

♦ View electropherograms on a per genotype basis

♦ View all genotype calls for a given marker

♦ Edit markers and bins

♦ View the relationship between controls and samples

♦ Edit allele calls

Displaying Plot
Windows

Display the plot window from the GeneMapper Project window.

When you select a sample, all of the corresponding genotypes are 
automatically selected in the Project Window Genotypes Tab. If a plot 
window is open, the view refreshes as you switch between tabs.

To open the plot window:

Step Action

1 Highlight any number of samples or genotypes from the project 
window, by selecting the row number or sample file name.

2 Click  (Display Plots) on the toolbar, or 
Analysis > Display Plots.
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When you select a genotype, the corresponding sample(s) are 
automatically selected in the Project Window Samples Tab. If a plot 
window is open, the view refreshes as you switch between tabs. The 
genotype selection is maintained until additional samples or genotypes 
are selected or deselected.

Note Samples with a failed sizing quality (SQ) value cannot be displayed in 
the Plot window. Only raw data can be viewed for failed samples.

Note The Plot Window cannot contain electropherograms from both the 
Samples and Genotypes tabs at the same time.

Customizing Plot
Windows

Certain features within the Plot Windows can be customized using the 
pull-down menu items or toolbar icons. Frequently used plot views can 
be saved as Plot Setting profiles using the Plot Settings Editor 
accessible from the GeneMapper Manager. See Chapter 8, “Using the 
Plot Settings Editor.”

♦ The last profile used in the Samples Plot is used to open the 
Genotype plot.

♦ The last profile used in the Genotypes Plot is used to open the 
Sample Plot.
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Plot Window Toolbars

Toolbar
Descriptions

The toolbar icons enable and disable plot features similar to their 
associated menu items as described throughout this chapter. Position 
your mouse over an icon to view its tooltip description.

Item Description

1 Pull-down menu that allows selection of a plot profile

Note Click the Plot Settings Editor icon to edit the selected profile. 
(Tools menu)

2 Pull-down menu that controls the number of electropherogram panes 
shown

3 Dye color toggle icons (View menu)

4 Header, Marker Range and Marker Indicator toggle icons (View 
menu)

5 Icons that select the plot display: Combine Dyes, Separate Dyes, 
Overlay All (View menu)

6 Icons that select the Sample Plot window to be displayed: No Table, 
Sizing Table, Genotypes Table (View menu)

7 Icons that select either Peak Selection Mode or Binning Mode 
(Alleles menu)

8 Icons that select the Label display: No Labels, Horizontal Labels, 
Vertical Labels (View menu)

9 Icons toggle additional view features: Overlay Bins, Show/Hide Peak 
Position, Controls To Top, Show/Hide Allele History (View menu)

10 Icon switches view to full X-axis and Y-axis scales: Full View from the 
View menu.

2

7 8 9 10

3 4 51 6
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Plot Window Menus

File Menu The File menu commands are used to perform the basic commands. 

Command Description

Save Panel
(Ctrl+Shift+S)

Opens the Save Panel(s) dialog box informing the user of 
what panel(s) have been modified and how many projects 
currently in the GeneMapper database will be effected. 
The options are:

♦ Save Panel - This option allows you to save any marker 
and bin changes made to the current panel name, 
affecting all projects analyzed using this panel.

♦ Save Panel As - This option allows you to save any 
marker and bin changes made to a new panel name, 
affecting only the current project being analyzed.

Note When using Save Panel As feature, the application 
creates a duplicate panel with bins from the current bin set 
and all bins from associated bin sets.

♦ Discard Changes - This option allows you to discard any 
changes made to markers and bins.
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Print
(Ctrl+P)

Automatically prints the contents of the plot window in the 
following order: 

♦ controls

♦ samples/genotypes

♦ table (if any)

Note Customize the view prior to printing.

Export Table
(Ctrl+E)

Opens the Export Table dialog box allowing the user to 
export either the sizing or genotypes table shown in the 
Samples Plot window.

Note This command is functional only when a table is 
currently being viewed. The exported table contains the 
same configuration as the currently viewed table.

Close Plot 
Window
(Escape)

Prompts to save any pending changes and closes the plot 
window.

Command Description
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Edit Menu The Edit menu command provides basic editing for the Plot window 
menus described in this section. 

Item Description

Undo
(Ctrl+Z)

The Undo command is enabled after a user action that adds, 
modifies, clears, or reorganizes. It allows you to undo certain 
actions, such as: 

♦ Editing an Allele

♦ Editing a Bin

♦ Resizing Markers

♦ Zooming
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View Menu The View menu contains features you can use to control:

♦ zooming of electropherograms

♦ electropherogram lines/dye displays on the view

♦ a number of display activities

Item Description

Toolbar Controls whether or not the Plot toolbar is displayed at the 
top of the Plot window. This item is checked when active.

Sample Info 
(Ctrl+F1)

Provides quick access to the Sample Info data tab for the 
selected electropherogram. (See Chapter 3, “Using the 
Project Window.”)

Raw Data 
(Ctrl+F2)

Provides quick access to the Raw Data tab for the selected 
electropherogram. (See Chapter 3, “Using the Project 
Window.”)

EPT Data 
(Ctrl+F3)

Provides quick access to the EPT Data tab for the selected 
electropherogram. (See Chapter 3, “Using the Project 
Window.”)
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Full View 
(Ctrl+])

Automatically resets the X- and Y-axes of the 
electropherogram(s) currently viewed to their full scale size.

Note Double-clicking with the left mouse button on an 
axis automatically resets that axis to full view.

Item Description

Zoomed In View

Full View X & Y Axes
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X-Axis Scale Selects the horizontal scale units for the X-axis to be 
displayed in either base pairs (default) or data points.

Zooms in on a specific region on the X-axis of the 
electropherogram as follows:

♦ Click and drag, with the left mouse button, the desired 
region on the X-axis.

In the Samples Plot, this affects all electropherograms.

In the Genotypes Plot, this affects only the selected 
electropherogram.

or,

♦ Right-click the X-axis to open the Zoom To dialog box, 
which enables specific zoom coordinates and tick 
spacing units to be set.

Double-click the X-Axis Sample Plot and all the 
electropherograms return to Full View.

Double-click the X-Axis Genotype Plot and only the 
selected electropherograms return to Full View.

Item Description
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Y-Axis Scale Controls the vertical scale of the electropherograms 
currently viewed as follows:

♦ Scale Individually - Each electropherogram being 
viewed is scaled to its maximum height.

♦ Scale To Maximum Y - All plots currently viewed are 
scaled to a global maximum value. 

♦ Scale To - This setting allows a user to set the Y-Axis 
scale value. If multiple plots are currently viewed, all 
plots are scaled to this value.

Zooms in on a specific region on the Y-axis of the 
electropherogram as follows:

♦ Click and drag with the left mouse button the desired 
region on the Y-axis. This only affects the selected 
electropherogram.

or

♦ Right-click the Y-axis to open the Zoom To dialog box, 
which enables specific zoom coordinates and tick 
spacing units to be set. Use the Apply To checkbox to 
apply the settings to all electropherograms (panes).

♦ Double click on the Y-Axis to return selected 
electropherograms to Full View.

♦ Shift+double click on the Y-Axis to return all 
electropherograms to Full View.

Item Description
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Labels Controls how labels are viewed beneath an 
electropherogram.

♦ No Labels - Labels are off.

♦ Horizontal Labels - Labels are positioned horizontally 
across the screen. Labels in close proximity overlap with 
the left most label displayed on top. Click any label to 
bring it to the top for viewing.

Item Description
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Labels 
(continued)

♦ Vertical Labels - Labels are positioned vertically across 
the screen to prevent overlap. This option is 
recommended for printing.

Note Labels are enabled in Separate Dyes mode only for 
Microsatellite samples, and are enabled in Combine Dyes 
mode only for SNaPshot® samples.

Item Description
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Bins
(Ctrl+shift+B)

Controls whether or not transparent bins are shown or 
hidden on an electropherogram. In the Binning mode, bins 
are automatically displayed and the Bins menu item is 
checked.

Separate Dyes mode

Note Bins are enabled in Separate Dyes mode only for 
Microsatellite samples, and are enabled in Combine Dyes 
mode only for SNaPshot samples. When you turn off a 
specific dye color for SNaPshot samples, the bins for that 
color turn off also.

Item Description

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Using Plot Windows - Samples and Genotypes 7-15

Bins 
(continued)

Combine Dyes Mode

Note Bins are enabled in Separate Dyes mode only for 
Microsatellite samples, and are enabled in Combine Dyes 
mode only for SNaPshot samples. When you turn off a 
specific dye color for SNaPshot samples, the bins for that 
color turn off also.

Peak 
Positions

Shows/hides the peak position indicators on the 
electropherogram currently viewed. Checked when active. 
Disabled for overlaid samples.

Item Description
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Allele 
Changes

Shows/hides label editing effects.

♦ Turned Off

– Deleted label disappears

– Edited/Added label looks normal 

♦ Turned On, labels manually edited are shown with 
descriptors and the allele call.

Label deleted - Allele label is shown with a diagonal slash 
through it.

Label changed - Allele label is shown with a double upper 
bar.

Label added - Allele label is shown with a double upper bar.

Controls To 
Top

Controls whether or not control samples are displayed at 
the top of the Plot window. Checked when active.

When active, a new pane is displayed at the top of the Plot 
window. Only samples and their corresponding genotypes 
designated as Control or Allelic Ladder in the Sample Type 
column of the Project window display in this pane. If multiple 
controls are shown, use the scroll bar to scroll through the 
different controls.

Item Description
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Off-scale 
Peak Indicator

Controls whether or not offscale peaks are highlighted in an 
electropherogram. Checked when active.

When enabled, a magenta bar overlays any offscale peak in 
an electropherogram as shown in the figure below. An 
offscale peak is a peak whose height exceeds the dynamic 
range of the collection instrument.

Dyes Controls the dye colors shown in the Plot window. Checked 
when active. Multiple dye colors may be selected.

Note This feature is not available when viewing 
microsatellite genotypes in the Genotype Plot window.

Item Description
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Plots Controls the way electropherograms of samples are shown 
in the Sample Plot window.

♦ Combine Dyes - All dye colors from a sample are 
combined into a single source electropherogram.

Item Description
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Plots 
(continued)

♦ Separate Dyes - Each dye color from a sample is 
separated into an individual electropherogram.

♦ Overlay All - Multiple samples are combined into a single 
electropherogram.

Plots 
(continued)

The Overlay All option can be used to verify size standards 
as follows:

1. Select any number of Samples in the Project window.

2. Click  (Display Plots).

3. Turn off all dye color icons except the dye color used for 
the size standard.

4. Click  (Overlay All). All size standard 
electropherograms are displayed; this allows the user to 
check for outliers.

Item Description
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Tables Controls which table, if any, is viewed at the bottom of the 
Sample Plot window. 

♦ No Table [Ctrl+Q] - Table is turned off.

♦ Sizing Table [Ctrl+A] - A sizing table is shown which 
displays information for all detected peaks in the 
selected samples. Use the Plot Settings Editor to 
configure the columns shown in the table. Use the Table 
Filter menu item command to control which rows of data 
are shown.

♦ Genotypes Table [Ctrl+W] - The genotypes table, as 
displayed in the Project window Genotypes tab, is shown 
for the selected samples. Use the Table Setting Editor to 
configure the columns shown in the table.

Table Filter Controls which data rows are displayed in the Sizing or 
Genotypes Table viewed at the bottom of the Sample Plot 
window.

♦ Show All Rows - All available data rows are shown.

♦ Show Selected Rows - Only peaks that are selected in 
the electropherogram(s) are shown.

♦ Hide Selected Rows - All peaks that are selected in the 
electropherogram(s) are hidden.

♦ Show Allele Call Rows - Only peaks that have allele calls 
assigned are shown. This is applicable for the Sizing 
Table only.

Item Description
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Header Controls whether the individual Sample or Genotype 
Header is shown above an electropherogram. Checked 
when active.

Note The information shown in the Header can be 
configured through the Plot Setting Editor.

♦ Headers Turned On

♦ Headers Turned Off

Marker Range
(Ctrl+R)

Controls whether or not the colored marker bar is displayed 
at the top of an electropherogram.

Marker 
Indicator
(Ctrl+K)

Controls whether or not the red triangles at the bottom of 
the electropherogram, which indicate the marker allele size 
range, are displayed.

Item Description
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Marker Margin Opens the Marker Margin dialog box to allow the user to 
determine how many base pairs beyond the allele size 
range are displayed in the electropherogram.

Note This option is only enabled when viewing the 
Genotype plots. The value can be pre-configured through 
the Plot Setting Editor.

Item Description
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Tools Menu The Tools menu provides access to the GeneMapper Manager and the 
Plot Settings Editor.

Item Description

GeneMapper 
Manager
(Ctrl+M)

Opens the GeneMapper Manager to allow creation or editing 
of various project settings. Used to create a new Plot Setting 
profile. See Chapter 2, “Using GeneMapper Software,” for 
more information.

Note New profiles can only be created through the 
GeneMapper Manager.
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Plot Settings 
(Ctrl+T)

Opens the Plot Settings Editor to allow the currently selected 
Plot Setting profile to be edited. See Chapter 8, “Using the 
Plot Settings Editor,” for more information.

Item Description
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Alleles Menu The Alleles menu is used to edit allele call labels on selected peaks and 
is only enabled when labels are displayed in the Plot window and one or 
more peaks are selected.

Item Description

Editing Mode Controls whether the action of the mouse within the 
electropherogram is in Peak Selection or Binning mode.

In Peak Selection mode (Ctrl+;):

♦ Peaks can be selected

♦ Allele calls can be edited

Clicking on a peak automatically highlights that peak’s 
data row within the Sizing Table or (Genotype Table, if an 
allele call has been made).

♦ Continuous peak selection is available

Use the Shift key or Click+Drag inside the plot area.

♦ Discontinuous peak selection is available

Use the CTRL key.

The selected peak is maintained when switching 
between the Samples and Genotypes tabs in the Project 
window with the Plot view still visible.
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Editing Mode 
(continued)

In Binning mode (Ctrl+\):

♦ Marker size ranges can be edited

♦ Bins can be edited

When the Binning mode is selected, the Plot window 
automatically switches the display configuration to an 
appropriate view for editing bins.

– Plots shown in Separate Dyes mode for microsatellite 
samples

– Plots shown in Combine Dyes mode for SNaPshot 
samples

– X-Axis displayed in base pairs

– Marker Indicator and Marker Range displayed

– Bins displayed

To edit marker size ranges (for microsatellites only):

a. Select Binning mode.

b. Click the marker indicator of the marker to be edited. A 
red indicator displays.

c. Drag the red indicator line to the desired size range.

Note To edit allele calls, refer to Add Allele, Delete Allele, 
and Rename Allele rows in this table. To edit Bins, refer to 
Add Bin, Edit Bin, and Delete Bin rows in this table.

To edit marker size ranges for SNPs, the bins need to be 
edited.

Binning Mode is disabled when:

a. There is no binset for the panel.

b. The binset was deleted.

Item Description
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Add Allele
(Ctrl+L)

Allows the user to add a new allele call to an unlabeled 
peak as follows:

a. Select Peak Selection mode.

b. Select an unlabeled peak using the left mouse button.

c. Select the Add Allele menu item or right-click mouse 
button to open the Add Allele dialog box.

If Allele Edit Comment is selected, the Add Allele Comment 
dialog box opens allowing the user to enter an allele 
comment for the selected peak. Labels must be turned on.

A bin name is assigned to the label if the selected peak falls 
within a bin defined for the marker. Otherwise, the allele is 
designated with a question mark (“?”) until the user 
renames the allele. If the Show type of edit checkbox is 
selected in the plot profile, the word “Added” displays inside 
the box.

Note For quick access to “Add Allele Call,” double-click an 
unlabeled peak.

Delete Allele 
(Delete)

Allows the user to delete an allele call from a labeled peak 
as follows:

a. Select Peak Selection mode.

b. Select a labeled peak using the left mouse button.

c. Select the Delete Allele menu item or right-click mouse 
button to open the allele edit options and click Delete.

If Show Allele Edit Comment is selected, the Delete Allele 
Comment dialog box opens allowing the user to enter an 
allele comment for the selected peak. The label is then 
deleted.

If the Show type of edit checkbox is selected in the plot 
profile, the word “Removed” displays inside the label box (if 
Allele Changes is selected from the View menu).

Note Multiple alleles may be deleted at the same time by 
selecting multiple peaks. This is constrained to the peaks in 
the plots currently shown.

History Allows the user to view the allele history in columns labeled 
Basepair, Allele Name, User Name, Modification Date, 
Action, and Comments.

Item Description
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Rename 
Allele

Allows the user to change the allele call on a labeled peak.

a. Select Peak Selection mode.

b. Select a labeled peak using the left mouse button.

c. Select the Rename Allele menu item or click with the right 
mouse button to open the allele edit options and click 
Rename Allele.

d. Select an allele call from the menu to rename the allele.

If you select Allele Edit Comment, the Edit Allele Comment 
dialog box opens allowing the user to enter an allele 
comment for the selected peak. The allele is then renamed 
to the selected allele call.

If Show type of edit prefix is turned on in the plot profile, the 
word “Changed” displays inside the label box.

Allele Edit 
Comment 
(Ctrl+O)

Controls whether or not the Allele Comment dialog box 
opens when making label changes. Checked when active.

To view the comments entered:

♦ Show the AE Comment column in the Project Window 
Genotypes Table, or

♦ Select the History option when right-clicking a selected 
labeled peak, or

♦ Double click a label.

Item Description
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Add Bin
(Ctrl+B)

Allows the user to add a marker bin as follows:

a. Select the Binning mode.

b. Click the Marker Range for the bin. A line and a cross hair 
opens on the electropherogram.

c. Select the Add Bin menu item or right-click to open the 
Add Bin option.

d. Add a bin by either dropping the cross hair at the center 
of the desired bin location or by dragging across the 
desired bin range. The Edit Bin dialog box opens 
allowing the user to add bin information.

Edit Bin
(Ctrl+U)

Allows the user to edit a marker bin as follows:

a. Select Binning mode.

b. Select the bin to be edited.

c. Select the Edit Bin menu item, or right-click the selected 
bin to open the bin edit options, and select Edit Bin.

The Edit Bin dialog box opens allowing the user to edit bin 
information. To quickly resize a bin, select a bin and adjust 
the right and left handles to the desired size range.

To relocate or move the bin (mouse action only):

a. Select Binning mode.

b. Select the bin to be moved.

c. Click and drag the center of the bin to a new location.

Item Description
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Move Allele Using the mouse, you can move an allele label to a new peak. 

Help Menu The Help menu provides access to online help and to the About 
GeneMapper software window.

Delete Bin
(Delete)

Allows the user to delete a marker bin as follows:

a. Select Binning mode.

b. Select the bin to be deleted.

c. Select the Delete Bin menu item, or right-click the 
selected peak to open the bin edit options and then 
select Delete Bin.

The bin will then be deleted.

Item Description

To move an allele:

Step Action

1 Left click a label to select it.

2 Hold down the Ctrl key and drag the label to the new peak.

The old label will be marked “removed.” The new label will be 
marked “added.”

Item Description

GeneMapper Help
(F1)

Opens the GeneMapper User Manual PDF file using 
Adobe Acrobat Reader.

About 
GeneMapper

Opens the About GeneMapper window to indicate 
registration information and software version number.
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Special Feature Invalidate Genotype Quality

This feature allows the user to quickly reset the Genotype Quality to 1.0 
and all PQV icons will be greyed out. Since the allele call has not 
changed, the AE box will not be checked.

To use the Invalidate Genotype Quality feature in the sample plot:

Step Action

1 Show the Genotype table.

2 Select the Genotype Quality cell of a genotype.

3 Right-click the selected cell to open the Override Genotype Quality 
dialog box.

4 Click Yes.

The Genotype Quality now passes with a value set to 1.0, and the 
PQV icons are greyed out in the Genotypes table.

To use the Invalidate Genotype Quality feature in the genotype plot:

Step Action

1 Select the sample header of a plot to select it.

2 Right-click on the header to open the Override Genotype Quality 
dialog box.

3 Click Yes.

The Genotype Quality now passes with a value set to 1.0, and the 
PQV icons are greyed out in the Genotypes table.
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Using the Plot Settings 
Editor 8
Chapter Overview

Introduction This chapter describes how to use the Plot Settings tab in the 
GeneMapper Manager window of the ABI Prism® GeneMapper™ 
Software Version 3.0, and describes how to use the features of the Plot 
Settings Editor.

In This Chapter This chapter contains the following topics:

Topic See Page

Plot Settings Tab 8-2

Plot Settings Editor 8-4

8
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Plot Settings Tab

Introduction The Plot Settings tab enables you to create and edit plot setting profiles 
for viewing your data in the Samples and Genotypes plot views.

Default Profiles GeneMapper software v3.0 contains the following standard Applied 
Biosystems profiles:

♦ Microsatellite Default

♦ SNP Default

♦ Sizing (view is similar to the view in the ABI PRISM® GeneScan® 
software)

Plot Settings Tab The Plot Settings tab contains a list of Plot Setting profiles in the 
database and is used to manage the contents of the Samples and 
Genotypes Plot views by providing the following menus and interface 
elements. To display the Plot Settings tab, select Tools > GeneMapper 
Manager > Plot Settings.
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The Plot Settings tab contains the following items:

Item Description

Name column Plot setting name

Last Saved column Date/Time stamp showing when the 
plot setting was last saved

Owner column User name of the person who 
created the plot setting

Description column A description of the plot setting

New button Opens the Plot Settings editor

Always enabled

Open button Opens the editor for a selected 
project 

Enabled when a single plot setting is 
selected

Save As button Displays the Save As dialog box

Enabled when one or more settings 
are selected

Import button (.xml file extension) Displays a dialog box for Importing 
plot settings

Always enabled.

Export button (.xml file extension) Displays a dialog box for Exporting 
selected plot setting

Enabled when one or more plot 
settings are selected

Delete button Deletes the selected plot setting(s)

Done button Closes the GeneMapper Manager
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Plot Settings Editor

Introduction The Plot Settings Editor allows you to customize your plot views by 
adjusting the following:

♦ The items displayed in the Sample headers

♦ The items displayed in the Genotype headers

♦ The columns displayed in the Sizing table

♦ How labels are shown

♦ Display settings

How to Access the
Plot Settings

Editor

The Plot Settings Editor can be accessed in the following ways:

♦ Select Tools > GeneMapper Manager > Plot Settings Tab > New 
or Open.

♦ In the Sample or Genotype Plot views, select a profile to edit and 
select Tools > Plot Settings or click the Plot Setting Editor icon 
on the toolbar.

General Tab The General tab allows you to enter in the name and description of the 
plot setting.
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Sample Header
Tab

The Sample Header tab controls what is viewed in the header above 
each sample electropherogram in the Samples Plot view.

The Show button displays all selected rows as visible (checked), and 
the Hide button displays all selected rows as hidden (unchecked).

Genotype Header
Tab

The Genotype Header tab controls what is viewed in the header above 
each Genotype electropherogram in the Genotypes Plot view.

The Show button displays all selected rows as visible (checked), and 
the Hide button displays all selected rows as hidden (unchecked).
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Sizing Table Tab The Sizing Table tab controls which columns are displayed in the sizing 
table as shown in the Samples Plot view.
.

The Show button displays all selected rows as visible (checked), and 
the Hide button displays all selected rows as hidden (unchecked).

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Using the Plot Settings Editor 8-7

Labels Tab The Labels tab controls how labels are viewed for each allele. You can 
display up to four labels per peak. 

Use the drop-down menus to display the labels you want to use. 
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Description of items displayed on the Labels tab:

Name Type Description

Allele Call, Area, 
Height, Data point, and 
Size labels

Drop-down menu items 
in the label box

Labels are determined 
by the GeneMapper 
software v3.0.

AE Comment Drop-down menu item 
in the label box

Shows the last allele 
edit comment

Show data type 
prefixes 

Check box Label prefixes such as 
“al” for allele call will be 
displayed.

Show type of edit Check box If an allele is manually 
edited, the label will 
display “changed” or 
“deleted.”

Invert mutant labels Check box If a bin is labeled as a 
mutant bin in the Panel 
Manager, then the 
label color will be 
inverted to distinguish 
it from normal bins.

Label Color Drop-down menu Controls the color of 
the labels. From the 
drop-down menu 
select one of the 
following:

Black & White

Dye Color - All (text & 
border in color)

Dye Color - Border 
(text in black, border in 
color)
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Display Settings
Tab

The Display Settings tab controls how each plot setting will 
automatically open when a customer chooses that setting.

You can select Use the display settings last used for this plot button 
to have the Samples and Genotypes plot views display with your 
previous settings, or select Use these display settings to adjust the 
way these views display with the current settings on this page. These 
icons are the same as the ones in the Plot window. Move the mouse 
over each icon to view the tooltip description. The tooltip describes what 
action occurs if the button is pressed. For example, by default, all colors 
are shown. If you move your mouse over the All icon , the tooltip 
says “Hide All Dyes.” If you click the icon, all colors will be hidden.
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Creating and 
Evaluating a Matrix 9
Chapter Overview

Introduction This chapter describes the process of creating and evaluating a matrix. 
With the ABI Prism® GeneMapper™ Software Version 3.0, matrices are 
stored in the GeneMapper database. They become .mtx files on your 
hard drive only when you export them. You must export a file in order to 
run the 310/377 data collection. You have the option of selecting four or 
five dyes depending on the application when creating a new matrix for 
data collection.

Note This chapter applies only to the ABI PRISM® 310 Genetic Analyzer 
and the ABI PRISM® 377 DNA Sequencer instruments.

In This Chapter Topics in this chapter include the following:

Topics See page

About the Matrices Tab 9-2

About Matrices 9-3

Process of Creating a New Matrix 9-8

Choosing a Data Point Range for the Matrix Calculation 9-10

Generating a New Matrix 9-12

Assigning the Matrix to Samples 9-16

Evaluating the Matrix 9-17

Using the Matrix with Data Collection 9-18

Causes for Bad Matrices 9-19

9
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About the Matrices Tab

Purpose of the
Matrices Tab

Matrices Tab

The Matrices Tab contains the list of Matrices in the database.

Item Description

Name column Matrix name

Last Saved column Date/Time stamp showing when the matrix was last 
saved

Owner column User name of the person who created the matrix

# of Dyes column The number of dyes selected for the matrix

Description A description of the matrix

New button Opens the Matrix Editor dialog box

Always enabled

Open button Opens the editor for a selected matrix

Enabled when a single matrix is selected

Save As button Displays the Save As dialog box

Enabled when a single matrix is selected

Import button Displays a dialog box for Importing matrices

Always enabled 

Note The extension must be .mtx. 

Export button Displays a dialog box for Exporting the selected 
matrix

Enabled when one or more matrices are selected

Note The extension must be .mtx.

Delete button Deletes the selected matrix(s)

Done button Closes the GeneMapper Manager
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About Matrices

Introduction There are two dye-labeling chemistries currently available to prepare 
nucleic acid samples to use the GeneMapper software on ABI PRISM® 
instruments: 

♦ 5´ end labeling Dye Sets D, F, G5

♦ 3´ end labeling Dye Set E5

Each chemistry has a set of dye labels that fluoresce at different 
wavelengths when excited by a laser.

Matrix Definition A Matrix is a mathematical formula that corrects for spectral overlap of 
fluorescent emission spectra data collected from ABI PRISM 
instruments. 

Multicomponent
Definition

This process of eliminating the bleed-through caused by spectral 
overlaps is called multicomponenting. 

Applying a matrix to raw data allows you to generate multicomponented 
data.

During data collection on the... The wavelengths are separated...

 ABI Prism® 310 Genetic Analyzer, 
ABI Prism® 377 DNA Sequencer, 
377XL, or 96-lane upgrade 
instrument

by a spectrograph into a known 
spectral pattern across a detection 
system with the sequencer.
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Why Is a Matrix
Necessary

A matrix is necessary because the four or five dyes used to label the 
fragments fluoresce at different wavelengths and may have spectral 
overlaps:
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Sample Files Using
A Matrix

The following figures show examples of data analyzed with and without 
a matrix. 

You can see that peak data from a sample file analyzed without a matrix 
displays the expected peak, along with extra peaks in other dye colors, 
or bleed-through from other dye colors.

Assigning a Matrix
to a Sample

Normally the matrix is assigned to a sample file automatically upon 
generation during or after a run. Additionally, a matrix can be manually 
assigned to a 377/310 sample file from within the GeneMapper 
software. 

When to Assign a
Matrix

Before you can successfully analyze 310/377 sample files using the 
GeneMapper software, you must make a new matrix or assign an 
existing one to a set of sample files. 

Sample file analyzed without a matrix 

Sample file analyzed with a matrix 
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Limitations to
Matrices

The matrix is instrument-specific. You cannot apply a matrix you made 
on the ABI PRISM 377 DNA Sequencer to data you collected on an 
ABI PRISM 310 Genetic Analyzer, nor can you apply a matrix made on 
one ABI PRISM 377 to a sample or gel file made on another 
ABI PRISM 377. In other words, you cannot apply matrix created on one 
instrument to other instruments of the same model.

You can only assign a matrix to sample files generated on the same 
instrument, under the same electrophoresis, gel matrix and buffer 
conditions, and using the same dye set.

When to Create a
New Matrix

Create a new matrix in the following conditions:

♦ For each dye set:

– D, F, G5, E5

♦ When you change the dye set you use to label sample fragments, 
for example, if you are using the fifth dye.

♦ When you use gel materials or buffers with pH values that differ 
greatly from the pH value of the gel material or buffer on which the 
existing matrices were generated.

♦ When you see multiple unexpected peaks of different colors under 
an expected peak.

♦ When you recalibrate your CCD camera (ABI PRISM 310 Genetic 
Analyzer and ABI PRISM 377 DNA Sequencer) and the change is 
greater than 3 pixels from the original pixel position.

♦ When you replace the CCD camera (ABI PRISM 310 Genetic 
Analyzer and ABI PRISM 377 DNA Sequencer).

♦ When you see an increase in pull-up or pull-down.
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Considerations
Before Making a

Matrix

The following table lists some of the considerations before making a 
matrix:

Where to Store
Exported Matrix

Files

Store exported matrix files (.mtx) intended for use by Data Collection 
software in: 

D:\AppliedBio\Shared\Analysis\Sizecaller\Matrix\ 

If Data Collection and Analysis are installed on different computers, the 
location is the same. Remember to copy the matrix from the analysis 
computer to the Data Collection computer. 

Note GeneMapper software matrices are stored in the Oracle database.

Consideration Comment

How much dye matrix standard to 
load?

With the ABI PRISM 377 DNA 
Sequencer, loading more than 3 µL 
will overload most wells and may 
produce too much signal. 

Any amount that results in a signal 
over 4,000 RFUs is too strong.

Which lanes to load with the dye 
matrix standards?

For gel electrophoresis, load the 
matrix standards with an empty lane 
between each sample to avoid 
contamination of the individual dyes 
by residual material leaking adjacent 
samples.

Which gel data will be used for 
matrix creation?

After generating a gel image, for 
ABI PRISM 377 instrument, check 
that the tracking of the gel file is 
adequate.
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Process of Creating a New Matrix

Process Diagram The following diagram shows the procedure for making a new matrix:

For sample preparation and loading information, refer to the appropriate 
instrument user manual.

Import samples into a new 
GeneMapper project

View raw data to determine data 
point range for the matrix 

Select Tools > GeneMapper Manager

Select the Matrices tab

Review and edit the matrix result

Click New

Click Create

Enter a matrix description

Select the number of dyes

Select the sample file for each dye color

Insert the data point to start at for each 
dye color

Click OK to save and close the window
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Steps to Create a
New Matrix

The following table lists the steps to create a new matrix: 

Step Process See Page

1 Choosing a Data Point Range for the Matrix 
Calculation

9-10

2 Generating a New Matrix 9-12

3 Assigning the Matrix to Samples 9-16

4 Evaluating the Matrix 9-17 

5 Using the Matrix with Data Collection 9-18

6 Causes for Bad Matrices 9-19
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Choosing a Data Point Range for the Matrix Calculation

Introduction Depending on how well your Matrix Standards run, it may be necessary 
for you to choose a specific range of data points to be considered for 
your matrix calculation.

In order to choose appropriate values for the data point range, you must 
first view the sample file raw data from each of the matrix standard files, 
so you can decide where to choose the start point for the data point 
range.

Viewing the Raw
Data

What to Look For
in the Raw Data

Display

In the raw data display of the sample files verify the following:

♦ Data peaks are present in all four or five of the matrix standards. 

♦ There are no anomalies.

♦ The baseline is stable (flat between peaks). 

♦ Peaks are on-scale—no more than 8191 relative fluorescent 
units—and the peaks of the dye of interest have a value of at least 
200.

To view raw data: 

Step Action

1 Open a new GeneMapper Project.

2 Import Samples by selecting File > Add Samples to Project.

3 Select the files you want to view:

a. Navigate to the disk/directory containing the samples for 
creating a matrix.

b. Select the files you wish to use.

c. Click Add to List.

4 Click Add to import the files into a new project and close the Add 
Samples to Project window.

The Project window reopens with the imported files displayed in the 
Samples tab.

5 In the navigation pane, expand the folder containing sample files.

6 Select a sample file.

7 Click the Raw Data tab.
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If peak data does not show these characteristics, refer to “Causes for 
Bad Matrices” on page 9-19, for possible interpretations of your peak 
data.

Choosing a Data
Point Range

Eliminating
Primer Peaks

Both the primer peaks and the data peaks are displayed when viewing 
the raw data of your matrix standards. Any time you run dye-labeled 
samples on a gel (377 instrument), or capillary (310 instrument), you 
have excess dye-labeled primer in the reaction. The primer peak 
displays as the first peak, usually off-scale because it is in molar 
excess. Eliminate the primer peak when making a matrix, by choosing 
the start point after the primer peak in a flat area with a stable baseline.

Note To create a good matrix, you need at least five fragments in each color.

To choose a data point range:

Step Action

1 Move the cursor well away from the primer peak, in a region at the 
beginning of the run and in a flat part of the baseline, and record 
the data point values for both the start and stop points in the flat 
part of the baseline of the data point range. 

Note When choosing the start point, do not include primer peaks 
in the data point range (refer to “Eliminating Primer Peaks”). You will 
need to enter these values in the next step when generating the 
new matrix (refer to page 9-12).

2 Return to the Project window by selecting the run folder in the 
navigation pane.
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Generating a New Matrix

Creating a
GeneMapper

Software Matrix

To create a GeneMapper software matrix: 

Step Action

1 Select GeneMapper Manager > Tools . Then click the Matrices tab.

The Matrices page opens.
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2 Click the New button on the Matrices tab. The Matrix Editor dialog 
box opens.

3 Enter in a Matrix name and description, if desired.

To create a GeneMapper software matrix: (continued)

Step Action
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4 Choose the number of dyes from the Number of Dyes drop-down 
list.

If 5 dyes are selected, a button for “O” Data is added to the bottom 
of the list.

5 The B, G, Y, R, and O buttons represent dye colors. Choose the file 
associated with the appropriate dye color.

a. Click a button to display a pop-up menu. 

b. Use the pop-up menu to access a sample file to link to each of 
the dye-labeled primers.

c. Choose the sample file that represents the dye color for that 
button.

6 Enter the start point that you determined when choosing a data 
point range in the Start At field.

Refer to “Choosing a Data Point Range” on page 9-11.

7 Enter the total number of data points to include to calculate the 
matrix in the Points field.

In most cases, leave the default value, unless you must exclude a 
portion of your data because of artifacts or bleed-through.

Note You must have at least five peaks to make a matrix.

8 Click Create to generates a new matrix.

9 Click OK to save and close the Matrix Editor dialog box.

To create a GeneMapper software matrix: (continued)

Step Action
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Matrix Example The following is an example of the matrix results showing the values 
used to calculate the overlap correction.

For each dye, the value where the dye fluorescence is read by the 
appropriate filter is 1.000. The adjacent colors show the amount of 
overlap for which the system must compensate. The adjacent values, in 
most cases, should be less than 1.000, but greater than or equal to 
0.0000.
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Assigning the Matrix to Samples

Introduction After generating the new matrix, assign it to all the samples that you 
want to analyze.

IMPORTANT After assigning your matrix to samples, refer to “Evaluating the 
Matrix” on page 9-17.

Procedure To assign a matrix to samples: 

Step Action

1 Open or create a GeneMapper Project containing the samples you 
wish to analyze.

2 Select the Matrix column in the project window.

3 Select the appropriate matrix from the drop-down list for each 
sample, or use the Edit > Fill Down feature.

4 Apply additional project settings prior to analyzing the sample files.
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Evaluating the Matrix

Introduction After creating a new matrix and assigning it to select sample files, 
evaluate the quality of the matrix. The quality of the matrix has a direct 
impact on the quality of the results data.

Procedure

For each displayed sample file you should see the following:

To evaluate the matrix:

Step Action

1 Analyze the sample files used to make the matrix.

2 Display results data for all the Dye Matrix Standard sample files in 
the plot window, showing only electropherogram data.

You should see... If not...

that the only visible peaks represent 
the color of the Dye Matrix Standard 
run in that lane, or for that injection 
(ABI PRISM 310).

you probably have a bad matrix. 

For instructions on how to identify 
and correct problems with bad 
matrices, see “Causes for Bad 
Matrices” on page 9-19.all other lines should be relatively 

flat, indicating that the matrix 
properly compensated for the 
spectral overlap. 

For example, for the blue matrix 
standard sample file, you should 
only see blue.

sharp, well-defined, singularly 
colored peak data.
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Using the Matrix with Data Collection

Using Different
Computers for

Data Collection
and Analysis

Be sure to copy matrices generated and exported on the analysis 
computer (the computer running GeneMapper software) to the Data 
Collection computer, if different. Copying the matrices will ensure that 
the correct matrix name is stored in the sample file. The proper matrix is 
required for accurate analysis of 310 and 377 sample files.

Where to Store
Exported Matrix

Files

Store exported matrix files (.mtx) intended for use by Data Collection 
software in: 

D:\AppliedBio\Shared\Analysis\Sizecaller\Matrix\ 

If Data Collection and Analysis are installed on different computers, the 
location is the same. Remember to copy the matrix from the analysis 
computer to the Data Collection computer. 

Note GeneMapper software matrices are stored in the Oracle database.

To transfer the matrix from one computer to another:

Step Action

1 Click the Matrices tab in the GeneMapper Manager window.

2 Select Matrix to Export.

3 Click Export.

4 Select a name and location for the matrix.

5 Transfer the .mtx file to the data collection computer.
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Causes for Bad Matrices

If an Error
Message Diplays

There are two possible causes for the error messages shown in the 
following table: 

Two Causes of Bad
Matrices

If... Take this action...

you designated the wrong files, reassign the matrices. 

Refer to “Assigning the Matrix to 
Samples” on page 9-16.

the signal is too weak to make a 
matrix,

rerun the matrix standards.

The following table lists two common causes of bad matrices:

Problem Cause What to do

Artifact peaks of 
different colors under 
the true peaks.

Refer to the figure 
below.

Loading too much dye 
when running matrix 
standards, resulting in 
dye bleed-through.

Complete another run 
and recreate the 
matrix.

Noisy baseline. If the matrix subtracts 
too much of a 
particular color from 
the sample, then the 
baseline may become 
too elevated, resulting 
in false peaks.

Refer to the figure 
below.

Complete another 
matrix run and make 
sure you do not have 
any off-scale data.

Or, choose a different 
set of fragments.
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The following table lists two common causes of bad matrices: (continued)

Problem Cause What to do
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Using the Size 
Standard Settings 10
Chapter Overview

Introduction This chapter describes the Size Standard and Size Match Editors in the 
ABI Prism® GeneMapper™ Software Version 3.0.

In This Chapter This chapter contains the following topics:

Topic See Page

About Size Standards 10-2

Size Standards Tab 10-3

Creating/Editing a Size Standard 10-5

Size Match Editor 10-12

Size Calling Curve 10-18

Performing a Sizing-Only Application 10-19

10
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About Size Standards

What are Size
Standards

Size standards are specific DNA fragments of known sizes. After 
defining the sizes of a size standard, the GeneMapper™ software 
matches this definition to the internal size standard included with the 
run. The software assigns the defined size values to the appropriate 
peaks of the internal size standard and uses this information with the 
selected size calling method to size all unknown fragments.

Applied Biosystems provides several fluorescently labeled size 
standards, which are described in Appendix D. If necessary, you can 
also define your own size standard.

Advantages of
Using a Size

Standard

Running an internal size standard results in precise molecular length 
determination, because the internal size standard and the unknown 
fragments undergo exactly the same electrophoretic forces. 
GeneMapper software can then compensate for band-shift artifacts 
caused by variations in the gel and in the sample from lane to lane or 
injection to injection.
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Size Standards Tab

Purpose of the Size
Standards Tab

The Size Standards tab in the GeneMapper Manager window contains 
a table of size standards stored in the database.

Item Description

Name column Size Standard name

Last Saved column Date/Time stamp showing when the size standard 
was last saved

Owner column User name of the person who created the size 
standard

Type Classic or Basic/Advanced

Description A description of the size standard

New button Opens the Specify parameters and Size Standard 
Editor dialog boxes to create a new size standard

Open button Opens the editor for a selected size standard

Enabled when a single size standard is selected

Save As button Displays the Save As dialog box

Enabled when a single size standard is selected

Import button Displays a dialog box for Importing size standards

Always enabled
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Export button Displays a dialog box for Exporting selected size 
standard(s)

Enabled when one or more size standards are 
selected

Delete button Deletes the selected size standard(s)

Done button Closes the GeneMapper Manager

Item Description
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Creating/Editing a Size Standard

Overview To create a size standard, you must first specify the parameters under 
which the size standard is created and then define the peaks using the 
Size Standard Editor. When editing a pre-defined size standard, only 
the Size Standard Editor dialog box will be shown.

Specifying Size
Standard

Parameters

To specify size standard parameters:

Step Action

1 Select Tools > GeneMapper Manager. Then click the Size Standards 
tab.

2 Click the New button to open the Select Dye and Analysis Method 
dialog box.

3 Select the appropriate button, Basic or Advanced or Classic. The 
mode you select must be the same as the peak detection algorithm 
you use to analyze the samples in Analysis Method.
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4 If using the Classic mode:

a. Select a dye color from the drop-down list.

b. Select an Analysis Method from the drop-down list.

c. Click the Select Sample button to open the Select Sample 
window, and select the sample file that contains the dye 
standard you want to use as the template.

To specify size standard parameters:

Step Action
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5 Click Select Sample button to select the sample, and click OK.

The Size Standard Editor opens.

To specify size standard parameters:

Step Action
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Using the Size
Standard Editor in
Basic or Advanced

Mode

The Size Standard Editor window in Basic or Advanced mode allows 
you to define the peaks for each size standard dye you use.

To use the size standard editor in basic or advanced mode:

Step Action

1 Choose a Size Standard Dye color from the drop-down list.

2 Enter a description for the size standard you are creating.
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3 Enter the base pair values to be defined in your size standard in the 
table provided.

Note Use the Edit menu to undo certain actions or Add and 
Remove Rows as desired.

4 Click OK to save and close the Size Standard Editor, or click Cancel 
to close without saving.

To use the size standard editor in basic or advanced mode: (continued)

Step Action
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Using the Size
Standard Editor in

Classic Mode

The Size Standard Editor in Classic mode shows an electropherogram 
and a table of peaks for the dye color and sample selected. The 
software assigns a number to each peak found in the electropherogram 
in order, from left to right. You should be able to recognize the peak 
pattern of the standard in the electropherogram.

Note You can only change the peak size value in the right column of the table. 
You cannot change or rearrange the peak numbers.

Note If too many peaks display in the electropherogram or the baseline is too 
high, you might need to adjust the analysis parameters.
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To use the size standard editor in classic mode:

Step Action

1 Enter in a name and description for the size standard.

2 Specify the peaks of the standards and their sizes.

Click the peak you want to define either in the electropherogram or 
in the table, or click on a row and the corresponding peak is 
highlighted.

Note For easier viewing, you can zoom in on the 
electropherogram by click+drag on the X-Axis numbers.

3 Type the peak size in the corresponding column.

Note Leave a zero in the Size column when you want to ignore a 
peak for the standard definition.

4 Press the tab key to automatically move to the next size standard 
peak.

5 Click OK to save and close the Size Standard Editor, or click Cancel 
to close without saving.
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Size Match Editor

Introduction The Size Match Editor window enables you to examine size standard 
electropherograms, edit the identification of size standard peaks, and 
view the size calling curve. To open the Size Match Editor window, click 
Analysis on the toolbar in the GeneMapper Project window and select 
Size Match Editor.

When the Size Match Quality indicator shows a marginal or fail state, 
you can use the Size Match Editor to help adjust the in-lane size 
standard to make it valid. Typical problems include the following 
conditions:

♦ Peak shift - The algorithm does not correctly identify a peak, 
resulting in invalid positions for other size standard peaks.

♦ Missing peak - The algorithm does not identify a peak.

♦ Extra peak - The algorithm identifies a peak that is not a size 
standard peak,but a spike or pull-up peak.
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Window Elements The Size Match Editor window elements are described in the following 
table below.

Editor Commands The following Size Match Editor menus are described in this section:

♦ Edit

♦ View

♦ Tools

Element Description

Sample navigation 
pane

Enables you to select a sample to view by scrolling 
through the Sample list. The list of samples displayed 
reflects the list of samples selected in the Project 
Sample view.

Size Quality 
indicator

Displays the quality of the currently displayed size 
standard (name listed above the plot). Value 0.0–1.0.

Size Matches 
electropherogram

Displays the size standard peaks. Clicking on a peak 
selects it (single selection only).

Size Calling curve Displays the size calling curve for best fit.

OK button Closes the Size Match Editor window, accepting the 
pending changes. For samples whose size standards 
are modified, the Project window is ready for 
reanalysis.

Cancel button Closes the Size Match Editor window, disregarding 
any pending changes.

Apply button Same as OK button, except the dialog box remains 
open.

Override SQ 
button

Allows the user to override the Sizing Quality value 
and automatically set the value to 1. This will cause 
the sizing quality to be invalidated and a check mark 
will display in the SQI column in the Project window 
Samples tab.
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Edit Menu

The Edit menu is used to delete or change size labels.

Item Description Enabling

Undo
(Ctrl+Z)

Undoes the last user action. Enabled after a user 
action that adds, 
modifies, or deletes.

Add Size 
Label

Adds a size label to the selected 
peak.

Enabled when an 
unlabeled peak is 
selected.

Delete Size 
Label 
(Delete)

Deletes the size label of the 
selected peak.

Enabled when a 
labeled peak is 
selected.

Change Size 
Label

Opens a dialog box for the 
selected peak, allowing the 
selection of a new size label.

Enabled when a 
labeled peak is 
selected.

Delete All 
Size Labels 
(Ctrl+Delete)

Removes/deletes all size labels for 
the selected size standard sample.

Always enabled.
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View Menu

The View menu is used to change the Size Match Editor window.

Tools Menu

Item Description Enabling

Zoom Submenu used to scale the plot to 
the following value:

Full View (Ctrl+])

Always enabled.

Y-Axis Scale ♦ Scale to maximum Y (default)

♦ Scale to... user defined

Always enabled.

Show Navigator
(Ctrl+Shift+N)

Switches the navigator pane 
(Removes the pane with the first 
use and restores it on the second 
use.)

Always enabled.

Item Description Enabling

Auto Adjust 
Sizes

Auto adjusts size standard 
peaks.

Tooltip: Auto Adjust

Always enabled.

Check Sizing 
Quality

Checks the quality of the 
current size matching.

Tooltip: Check Quality

Always enabled.
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Toolbar The Size Match Editor toolbar contains the following icons:

Using the Size
Match Editor

The Size Match Editor window uses the mouse for editing.

Note All user edited size standard samples automatically have a sizing quality 
of 1.0, and display a check mark in the SQI column in the Samples window.

Icon Description Enabling

Autoadjusts size standard peaks. 
Adjusts the size of other peaks 
automatically to the right of the 
selected peak.a

Tooltip: Auto Adjust Sizes

a. Only for Basic and Advanced modes.

Enabled after a 
peak is changed.

Checks the quality of the current size 
matching. Checks the quality of the 
revised peak positions and updates 
the Size Match Quality indicator.b

Tooltip: Check Sizing Quality

b. Only for Basic and Advanced modes.

Enabled after a 
peak label is 
changed.

 Deletes all size labels.

Tooltip: Delete All Size Labels

Always enabled.

To edit a particular Size Standard peak:

Step Action

1 Import and analyze samples in the Project window.

2 Sort failed samples to the top of the Samples tab view.

3 Select the samples whose size match you want to edit.

4 Select Analysis > Size Match Editor.

The selected samples display in the navigation pane at the left side 
of the window. Selecting a sample name in this list displays its Size 
Standard electropherogram in the plot panel.

5 Click the peak to be edited.

6 Right-click the peak to open the editing pop-up window, and Add, 
Delete, or Change the selected peak.
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7 If you choose Add or Change, move the cursor to the right to open 
the Select Size sub-menu. 

Choose the desired height value from this menu.

8 Check the sizing quality by selecting Check Sizing Quality under the 
Tools menu.

If the peaks are sized correctly, but the quality score is still below 
passing, click the Override SQ button to set the SQ to 1.0.

9 Click Apply if you are going to edit a second size standard peak, or 
click OK if you are finished applying your changes to the edited 
peak.

To edit a particular Size Standard peak: (continued)

Step Action
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Size Calling Curve

Overview The Size Calling Curve is used as a measure of how well the internal 
size standard matches the standard definition, and whether or not it is 
linear.

The Size Calling Curve displays two curves.

Red Curve If the size calling curve is a red curve, it is based on the sizecalling 
method used to analyze the data.

Black Curve If the size calling curve is a black curve, it is a best-fit, least squares 
curve, which the GeneMapper software calculates for all samples, 
regardless of the size calling method used. This curve is provided to 
help evaluate the linearity of the sizing curve. When the sizing curve 
and best-fit curve match, they overlap so you see only the size curve.

Note Sizing problems due to anomalous mobilities may be displayed as 
non-linear.
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Performing a Sizing-Only Application

Introduction Sizing-only applications quickly analyze data without generating 
genotype calls.

General
Sizing-Only
Application

Sizing
Microsatellite

Reference Data

To take advantage of the Auto Bin feature for generating marker bins for 
microsatellite data, reference data needs to be sized.

To perform a general sizing-only application:

Step Action

1 Import samples into the Project window.

2 In the Analysis Method column, select an analysis method with the 
following features:

♦ The appropriate analysis type selected for your data

♦ A Binset of none

♦ The appropriate Peak Detection Algorithm set for your data

3 In the Size Standard column, select the size standard used with 
your data.

4 Analyze your samples.

♦ Samples are analyzed for sizing only; no genotype calls will be 
made.

♦ When viewing samples in the Plot window, the Sizing Table 
displays information for all peaks detected.

To size reference data:

Step Action

1 Import microsatellite reference samples into the Project window.

2 In the Analysis Method column, select an Analysis Method with the 
following features:

♦ Analysis Type set to Microsatellite

♦ Binset set to none

♦ Peak Detection Algorithm set for your data

3 In the Panel column, select the panel that references this data.

Panels must be created in advance of Auto Binning and should 
contain all marker information known.
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Sizing SNaPshot
Reference Data

Whether creating SNaPshot® bins manually or by using the Auto Panel 
feature with SNaPshot Primer Focus samples, reference data needs to 
be sized.

4 In the Size Standard column, select the size standard used with 
your data.

5 Analyze your samples.

Samples are now ready to be used for Auto Binning in the Panel 
Manager.

To size reference data: (continued)

Step Action

To size reference data:

Step Action

1 Import SNaPshot or Primer Focus reference samples into the 
Project window.

2 In the Analysis Method column, select an Analysis Method with the 
following features:

♦ Analysis Type set to SNaPshot

♦ Binset set to none

♦ Peak Detection Algorithm set for your data

3 Set the Panel column to none.

4 In the Size Standard column, select the size standard GS120LIZ® 
or the appropriate size standard for your data.

5 If using Primer Focus samples, set the Sample Type column to 
Primer Focus.

6 Analyze your samples.

Samples are now ready to be used for creating bins in the Panel 
Manager.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Process Quality Values A-1

Process Quality
Values A
Appendix Overview

Introduction This appendix describes how users can optimize the quality assurance 
level of their results by using the Process (component-based) Quality 
Values (PQV) in the ABI Prism® GeneMapper™ Software Version 3.0 to 
troubleshoot the data analysis process.

In This Appendix This appendix contains the following topics:

Topic See Page

Overview of Process (Component-Based) Quality Values 
(PQV)

A-2

Using Process (Component-Based) Quality Values A-3

A
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Overview of Process (Component-Based) Quality Values (PQV)

What are Process
Quality Values

Process Quality Values (PQVs), values reported by data analysis, aid in 
finding and fixing problems in sample preparation and analysis. These 
values are the end results reported by the PQV system.

The PQV Process The PQV process includes the following : 

♦ At the end of the process, quality values (also known as PQV or 
Process Component-Based Quality Values) are assigned to the 
size calling process and the allele calling process. 

♦ On the Samples page and Genotypes page, the columns 
presenting PQV result data, other than SQ and GQ results, display 
the following samples after analysis:

– “Pass “ (green square) symbol when no problem exists, 

– “Check  (yellow triangle) symbol when there are 
problematic components such as missing size standards, or 
missing matrices

– “Low Quality  (red octagon) symbol when the result falls 
below an acceptable response

What are PQVs PQVs reported by data analysis are an aid to finding and fixing 
problems in sample preparation and analysis. These values are the end 
results reported by the PQV system.

Editing PQVs When you edit PQVs you must create an Analysis Setting and select 
the application mode to control which PQVs are used and available to 
the user for editing.

’’

’’
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Using Process (Component-Based) Quality Values

The PQV System Quality values reported by the GeneMapper software are an aid to 
finding and fixing problems in sample preparation and analysis. These 
values are the end results reported by the PQV system. For more 
information on the PQV system, see “Unique Features of GeneMapper 
Software v3.0” on page 1-3.

The color-coded, sortable PQV values on the Samples and Genotypes 
pages allow the user to isolate problem samples quickly and examine 
the electropherograms. 

Two types of PQV values are presented on the Samples and Genotypes 
pages. On the Samples page:

♦ The SFNF, MNF, SNF, and OS parameters report results as Pass 
 or Check .

♦ The second type, the Sizing Quality (SQ) parameter, reports results 
as Pass , Check , or Low Quality . 

On the Genotypes page:

♦ The SHP, AN, AE, OBA, SPA, Bin, PHR, LPH, SPU, BD, SP, OS, 
CC, OVL, NB, and DP parameters report results as Pass  or 
Check .

♦ The second type, the Genotype Quality (GQ) parameter, reports 
results as Pass , Check , or Low Quality .

Note On the Genotypes page, the ADO and AE parameters are also PQV 
parameters but they report results as checks  instead of colored flags.

A Low Quality (red octagon) quality value for the Sample SQ indicates 
that the sizing standard has failed. A Low Quality value for the GQ 
parameter means the analysis has failed for that marker. You can set 
the thresholds for the SQ and GQ values in the Analysis Method Editor 
on the Quality Flags page.
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Rules for PQV
Columns

In gaining familiarity with the PQV columns on the Samples page and 
Genotypes page, keep the following rules in mind:

♦ Quality metrics with Pass/Check values and no Low Quality value 
are warning flags. Analysis does not stop if problems are detected 
with these properties, but the user should examine results flagged 
with Check values.

♦ Holding the cursor over a column header displays a ToolTip 
identifying the full name of the column (the default names are often 
acronyms).

♦ PQV results are reported in the column labeled SQ on the Samples 
page and GQ on the Genotypes page. 

The SQ and GQ quality indicators (displayed in either symbols or in 
numerical values depending upon the Quality Metrics Display 
setting in the Tools-Options Analysis tab) have the meanings listed 
below:

– Green = good data (default: numerical range of 0.75 to 1.0)

– Yellow = questionable data (default: numerical range of 0.25 to 
0.75)

– Red = low quality data (default: numerical range of 0.0 to 0.25)
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PQV Flags on the
Samples Page

The PQV flags on the Samples page.

PQV Column Description

SFNF Sample File Not Found

♦ A flag (Pass  or Check ) is automatically 
displayed when no sample file is found. 

♦ Not editable.

MNF Matrix Not Found

♦ A flag (Pass  or Check ) is automatically 
displayed when no matrix file is found attached to the 
sample file. 

♦ Not editable.

SNF Size Standard Not Found

♦ A flag (Pass  or Check ) is automatically 
displayed when no size standard is found. 

♦ Not editable.

OS Offscale

♦ A flag (Pass  or Check ) is automatically 
displayed when there is offscale data in the signal.

♦ Not editable.

♦ Indicates an offscale result in the size standard region of 
the signal.

SQ Sizing Quality

♦ A value (Pass , Check , or Low Quality ) is 
automatically displayed to indicate the sizing process 
quality.

♦ The sizing quality is calculated based on the similarity 
between the size standard fragment pattern and the 
actual size standard peak distribution pattern in the 
sample.

♦ Not editable.

♦ This feature performs the following functions:

– Identifies and eliminates the primer peaks based on 
peak shape

– Performs size matching (ratio matching)

– Makes a size calling curve using the Local Southern 
Method
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PQV Flags on the
Genotypes Page

The PQV flags on the Genotypes page:

Column Description

AE Allele Edit (check box)

♦ The check box displays unchecked immediately after 
analysis.

♦ The check box is checked when the marker allele calls 
have been edited by the user.

Note The marker allele calls are edited in the Plot View 
page. The user can enter comments in the Allele History 
Comments column on the same page.

ADO Allele Display Overflow (check box)

♦ The check box is checked when the number of alleles the 
marker calls exceeds the number to display previously set 
by the user. 

♦ The user specifies how many alleles to display in the Table 
Settings Editor parameters. The default is two.

♦ There are six columns for each allele to indicate name, 
size, height, area, mutation and comments.

SHP Sharp Peak

♦ A flag (Pass  or Check ) is automatically displayed 
when there is a sharp peak present in the marker signal.

♦ Analysis does not stop if problems are detected with these 
properties, but the user should examine results flagged 
with Check values.

♦ The PQV system gives a label of SHP to indicate a cluster 
of peaks with a large, narrow peak in the middle whose 
width is 50% less than the neighboring peak.

♦ This flag is used for Linkage Mapping (Microsatellite, 
dinucleotide only) analysis.

♦ Not editable.
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AN Allele Number

♦ A flag (Pass  or Check ) is automatically displayed 
when the number of alleles exceeds the maximum legal 
number for the organism, or no alleles are found. That 
number is specified in the analysis method.

♦ Triggering this flag reduces the final PQV Genotype value 
(GQ parameter) to zero (“0” multiplier).

♦ Not editable.

OBA One Basepair Allele

♦ A flag (Pass  or Check ) is automatically displayed 
when there is a one-base pair allele (a microvariant peak) 
present in the marker signal.

♦ Two allele peaks that are one base pair apart are flagged. 
This may indicate the presence of a microvariant and/or an 
invalid allele call.

♦ This flag is used only for LMS (Microsatellite, dinucleotide 
markers only).

♦ Not editable.

SPA Single Peak Artifact

♦ A flag (Pass  or Check ) is automatically displayed 
when the marker signal contains single peaks due to some 
problem in electrophoresis.

♦ The flag is triggered, when there are no peaks present 
within a two-base pair range prior to an allele peak.

♦ This feature detects the absence of stutter peaks, which 
indicates nonmicrosatellite peaks.

♦ This flag is used only for LMS (Microsatellite, dinucleotide 
markers only).

♦ Not editable.

The PQV flags on the Genotypes page: (continued)

Column Description
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Bin Out of bin allele

♦ A flag (Pass  or Check ) is automatically displayed 
when the called alleles’ peak apex is out of the bin 
boundary.

♦ Triggering this flag reduces the final PQV Genotype value. 
The default is 20% (0.2 multiplier) of what it would be 
otherwise.

♦ This flag is used for LMS analysis.

♦ For HID, this is labeled OL (off ladder alleles).

♦ Not editable.

PHR Peak Height Ratio

♦ A flag (Pass  or Check ) is automatically displayed 
when there are two alleles present and the ratio between 
the lower allele height and the higher allele height is below 
a certain level. 

♦ If there are more than two alleles present, the calculation 
iterates through all the peak pairs.

♦ PHR can be set in the Peak Quality tab of the analysis 
method (Analysis Manager). The default is 50%.

♦ For LMS markers, the ratio is calculated based on peak 
heights of the called allele peaks.

♦ For SNP, the ratios are calculated the same as for 
microsatellite markers except it goes across two different 
colors and only two peaks are used in the calculation.

♦ Not editable.

LPH Low Peak Height

♦ A flag (Pass  or Check ) is automatically displayed 
when the alleles are lower that the specified values and do 
not result in the proper intensity.

♦ The homozygous (default is 200) and heterozygous 
(default is 100) values can be set in the Peak Quality tab of 
the Analysis method (Analysis Manager).

♦ Setting this flag reduces the final PQV Genotype value (GQ 
parameter). The default is 50% (0.5 multiplier) of what it 
would be otherwise.

♦ Not editable.

The PQV flags on the Genotypes page: (continued)

Column Description
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SPU Spectral Pull-Up

♦ A flag (Pass  or Check ) is automatically displayed 
when the marker signal contains bleed-through peaks 
(pull-up peaks).

♦ Pull-up is when the peak height of the called allele peak is 
less than X% of the larger peak within ±1 data point.

♦ The default is a conservative 10% to check all colors. The 
user can set this value.

♦ This flag is used for LMS (Microsatellite), SNP, and HID.

♦ Not editable.

BD Broad Peak

♦ A flag (Pass  or Check ) is automatically displayed 
when the called alleles’ peak width is wider than a certain 
value. The default of this value is 1.5 basepair.

♦ This flag is used for SNP, HID, and LMS (Microsatellite, all 
markers).

♦ Not editable.

SP Split Peak

♦ A flag (Pass  or Check ) is automatically displayed 
when a split peak is found by GeneMapper software.

♦ A split peak is defined as overlapping peaks that are < .25 
basepairs apart (the horizontal distance from two peak 
apexes).

♦ Not editable.

OS Offscale

♦ A flag (Pass  or Check ) is automatically displayed 
when there are offscale peaks present within the marker 
size range.

♦ This flag is used for all applications.

♦ Not editable.

The PQV flags on the Genotypes page: (continued)

Column Description
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CC Control Concordance

♦ A flag (Pass  or Check ) is automatically displayed 
when the designated control sample does not exactly 
match the defined alleles for this marker in the panel being 
scored.

♦ This feature serves as an internal control for quality 
assurance, and allows you to see deviations in your 
controls.

♦ This flag is used for all applications.

♦ We recommend that you run the control sample at least 
once for every panel.

♦ Not editable.

OVL Overlap

♦ A flag (Pass  or Check ) is automatically displayed 
when a peak in the overlapped region is called twice. (It is 
possible to have two allele size ranges that overlap.)

♦ This feature serves as a warning for an allele calling error.

♦ This is used for HID only.

NB Narrow Bin

♦ A flag (Pass  or Check ) is automatically displayed 
when a peak is present at a position within 0.5 basepairs 
from a bin and no peak is present inside that bin.

♦ The benefit is to capture peaks that fall outside of bin 
boundaries due to experimental variations.

♦ This flag is used for SNP only.

DP Double Peak

♦ A flag (Pass  or Check ) is automatically displayed 
when two peaks of the same color in the same bin have a 
ratio ≥0.5. (minor peak height/major peak height)

♦ This flag is used for SNP only.

♦ Not editable.

The PQV flags on the Genotypes page: (continued)

Column Description
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GQ Genotype Quality

♦ A Low Quality or red octagon  is shown when the 
analysis has failed for that sample.

♦ Pass , Check , or Low Quality  flags are set by 
the Analysis Method. Not editable.

Below is a representation of sample peaks with the allele 
quality (AQ) assigned.

See the following page for information about the mathematical 
formula used to calculate the Genotype Quality from a sample 
represented by the image above.

The PQV flags on the Genotypes page: (continued)

Column Description
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 GQ 
(continued)

Genotype Quality - Mathematical Formula

♦ The mathematical formula used is:

GQ = MQb x (PQV1 x PQV2 x...xPQVN)

a AQ (Allele Quality) is a function of quality value assignments for the 
following: sizing quality, allele calling quality, bin assignment quality, 
and bin quality.

b MQ (Marker Quality) is modified by user defined PQVs to generate 
the final GQ value.

♦ PQVs are weighted from 0 to 1.

♦ The actual value of a PQV in the equation is:

1 minus the weight

♦ 0 (weight) = no effect on the final GQ calculation
(1 minus 0 = 1, therefore no change to GQ value)

♦ 1 (weight) = full effect (1 minus 1 = 0) (If you multiply GQ by 
0 and you get a GQ value of 0, then the sample analysis 
failed.)

♦ Between 0 and 1, the higher the value, the greater the 
impact on GQ.

♦ PQV filtering is controlled by the threshold set by 
GeneMapper software users, and remains fully functional 
irrespective of what weight is chosen.

The PQV flags on the Genotypes page: (continued)

Column Description

a

AQ

x (AQ) = MQ

AQ

G
R

21
19

a
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Software Genotyping
Algorithms B
Appendix Overview

Introduction This appendix provides a description of the new genotyping algorithms 
used in the ABI PRISM® GeneMapper™ Software version 3.0 and a 
detailed description of the Peak Detection Basic, Classic, and 
Advanced algorithm settings.

In this Appendix This appendix contains the following topics:

Topic See Page

GeneMapper Software Genotyping Algorithms B-2

Basic Mode - Peak Detection Algorithm Settings B-8

Classic Mode - Peak Detection Algorithm Settings B-9

Advanced Mode - Peak Detection Algorithm Settings B-14

Peak Detection: Polynomial Degree and Peak Window Size 
Parameters

B-19

Optimizing Peak Detection Sensitivity: Example 1 B-23

Optimizing Peak Detection Sensitivity: Example 2 B-25

Optimizing Peak Detection Sensitivity: Example 3 B-27

Peak Detection: Slope Threshold for Peak Start and Slope 
Threshold for Peak End Parameters

B-28

Slope Threshold Examples B-30

Size Calling Methods for Classic and Advanced Modes B-32

B
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GeneMapper Software Genotyping Algorithms

Overview Five algorithms used in the GeneMapper software are discussed in this 
appendix:

♦ Peak Detection - uses Basic, Advanced, or Classic mode to detect 
peaks and process data

♦ Size-matching/calling—matches found peaks to size standards

♦ Binning—determines bin centers for genotyping

♦ Allele calling—produces a consensus call based on several 
allele-calling algorithms

♦ Quality value determination—assigns a quality value to size- and 
allele-calling algorithms (See Appendix A, “Process Quality Values,” 
for more information.)
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A flowchart of the data flow in GeneMapper software is shown below. 
Standard signal processing is applied to the data prior to being 
delivered to the GeneMapper algorithms.The algorithms discussed 
here are shown in the raised portion.

Peak Detection
Algorithm

This algorithm uses Basic, Advanced, or Classic mode to detect peaks 
and process data. (See “Basic Mode - Peak Detection Algorithm 
Settings” on page B-8,“Classic Mode - Peak Detection Algorithm 
Settings” on page B-9, and “Advanced Mode - Peak Detection 
Algorithm Settings” on page B-14.)

ABI PRISM 310/377 systems

ABI PRISM 3730/3700/3100 systems

Caller 1 Caller n

Arbitrator

Bin assignment

Final quality value determination

Report results to user

Input sample Multicomponenting

Baselining

Peak detection

Binning

Size-matching/calling 
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Size-Matching
Size-Calling

Algorithm

This algorithm uses a dynamic programming approach that is efficient 
(runs in low polynomial time and space) and guarantees an optimal 
solution. It first matches a list of peaks from the electropherogram to a 
list of fragment sizes from the size standard. It then statistically derives 
quality values determined by examining the similarity between the 
theoretical and actual distance between the fragments.

SizeSize-Matching Algorithm Example

An example of how the size-matching/calling algorithm works is shown 
below using a contaminated GeneScan™ 120 size standard data.

Peaks found (standard and contamination) are indicated by blue lower 
bars along the x-axis. The size standard fragments as determined by 
the algorithm (and their corresponding lengths in base pairs) are 
designated by the upper green bars. Note that there are more peaks 
than size standard locations because the standard was purposely 
contaminated to test the algorithm. The algorithm correctly identifies all 
of the size standard peaks and removes the contamination peaks 
(denoted by the black triangles) from consideration. The large peak is 
excluded from the candidate list by a filter that has identified it as being 
atypical with respect to the others.

Bars indicate 
peaks found

Bars indicate size standard 
determined by algorithm

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Software Genotyping Algorithms B-5

Binning Algorithm This algorithm estimates the bin centers using all found alleles. To 
determine true bin positions, the algorithm uses an iterative clustering 
technique and then reports a quality value proportional to the binning 
noise. To enhance the flexibility, bins may also be edited manually.

Note When the user creates bins manually, all alleles, regardless of their 
quality values, are treated as reference alleles as long as the alleles reside 
within the created bins’ boundaries.

Allele-Calling
Algorithm

Final allele calls are based on a consensus between several different 
allele-calling algorithms. Each caller has a different design philosophy 
such that it excels in a particular data regime. A variety of allele-calling 
algorithms are used. Allele-calling algorithms involve envelope 
detection, optimization of parametric models, and rule-based systems.

Example Output of Different Allele-Calling Algorithms

The following is an example of three different allele-calling algorithms 
for 16 samples. User annotations are denoted by the (red) circles, allele 
caller outputs are denoted by the (green, black, and blue) asterisks. 
Note that consensus between multiple callers virtually assures that the 
calls are correct. In certain cases some algorithms have not made a call 
since they have determined that the data is too complex to act on. 
Examples of this occur in (i) and (p). Here the blue asterisks show the 
calls transmitted to the user. Low quality values are reported because in 
both cases the first algorithm did not call and in (i) the black caller is not 
in agreement with the blue. However, despite these conditions, the calls 
are correct. The low quality values alert the user to potential problems 
such as the spurious peak in (i) and the high background in (p).
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Quality Value
Determination

Algorithm

The Quality Value Determination algorithm is used to create Process 
Quality Values (PQVs). PQVs are reported by data analysis and are an 
aid to finding and fixing problems in sample preparation and analysis. 
These values are the end results reported by the PQV system

The quality value determination algorithm equation is the following:

MQ1 =  (AQ2

GQ = MQ x (PQV1 x PQV2 x...xPQVN)

♦ PQVs are weighted from 0 to 1.

♦ The actual value of a PQV in the equation is: 1 minus the weight

♦ 0 (weight) = no effect on the final GQ calculation
(1 minus 0 = 1, therefore no change to GQ value)

♦ 1 (weight) = full effect (1 minus 1 = 0) (If you multiply GQ by 0 and 
you get a GQ value of 0, then the sample analysis failed.)

♦ Between 0 and 1, the higher the value, the greater the impact on 
GQ.

PQV filtering is controlled by the threshold set by GeneMapper software users, 
and remains fully functional irrespective of what weight is chosen.

1. MQ (Marker Quality) is modified by user defined PQVs to generate the final GQ value.

2. AQ (Allele Quality) is a function of quality value assignments for the following: sizing 
quality, allele calling quality, bin assignment quality, and bin quality.

x
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Basic Mode - Peak Detection Algorithm Settings

Overview The Basic peak detection algorithm is used as the default algorithm by 
GeneMapper software v3.0. Basic Mode uses the Local Southern size 
calling method which determines the sizes of fragments by using the 
reciprocal relationship between fragment length and mobility.

In Basic mode there are two analysis parameter options.

♦ Minimum Peak Height - Automatic

♦ Minimum Peak Height - User specified (rfu)

Minimum Peak
Height

The Minimum Peak Height group box provides two parameter options:

Item Description

Automatic
option button

This option button sets the level 
automatically for the five dye colors (blue, 
green, yellow, red, and orange). 

This level represents the minimum signal 
strength that will be identified as a peak for 
each dye (equivalent to 10 times the noise).

User specified (rfu)
option button

This option button enables the number entry 
fields for the five dye colors (blue, green, 
yellow, red, and orange). 

These numbers are the minimum signal 
strength that will be identified as a peak in 
relative fluorescent units (rfu). For all dyes, 
the default is 50, the minimum is 1, and the 
maximum is any number of 10 digits.
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Classic Mode - Peak Detection Algorithm Settings

Overview In Classic mode there are five analysis parameter options. They are as 
follows:

♦ Ranges

♦ Data Processing

♦ Size Calling Method

♦ Peak Detection

♦ Split Peak Correction
\

Ranges Parameter
Options

The following are the Ranges parameter options:

Item Description

Analysis 
drop-down menu:

Full Range

Partial Range

Used to analyze all the data collected on the genetic 
analysis instrument for each sample.

Enter Start and Stop data point numbers in the entry 
fields in order to specify only a limited range analyzed 
for each sample. The data point numbers affect what 
is displayed in the results display. Normally, set the 
analysis range to start after the primer peak.

Note Sample files generated from the ABI PRISM® 
377 DNA Sequencer may have already removed the 
primer peak by setting the data point range for gel 
image generation to exclude the primer peak.

Sizing
drop-down menu:

All Sizes

Partial Sizes

Enter Start and Stop size numbers in the entry fields 
in order to specify only a limited range analyzed for 
each sample.
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Data Processing
Parameter Options

The Data Processing parameter options specify how the raw data is 
processed before peak detection and size calling. 

Description of the data processing parameter options:

Item Description

Baseline checkbox Used to automatically adjust the baselines of all 
detected dye colors to the same level for a better 
comparison of relative signal intensity.

Multicomponent 
checkbox

Note Do not 
check this box for 
multicapillary 
instruments. This 
user function was 
performed in Data 
Collection.

Used to specify that the GeneMapper software 
applies a predefined matrix to adjust for spectral 
overlap when it performs analysis.

Although the dyes used to label DNA fluoresce at 
different wavelengths, the spectra overlap to some 
extent. Create a matrix file containing a mathematical 
matrix to correct for this overlap. 

For a description of matrix files and how to create 
them, see Chapter 9, Creating a Matrix File.

Smoothing 
option buttons

Used to help reduce the number of false peaks 
detected by the GeneMapper software.

You have the following options:

Select... To...

None apply no smoothing.

Select this option if the data has very 
sharp, narrow peaks of interest.

Light provide the best results for typical 
data.

Heavy apply to data from slower runs that 
has very broad peaks, or to avoid 
the detection of sharp edges.

Choosing this option might reduce 
peak size or eliminate narrow peaks.
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Size Calling
Method Parameter

Options

Click a radio button to select the desired size calling method. The 
GeneMapper software uses these methods to determine the molecular 
length of an unknown fragment.

Peak Detection
Parameter Options

Use the Peak Detection parameter options to specify the minimum peak 
height to be detected for analysis. This, in turn, controls the number of 
peaks analyzed. Peaks falling below the parameters specified display in 
the electropherogram, but are not analyzed, and no values display for 
them in the tabular data.

Description of the size calling method parameter options:

Item Description

2nd Order Least 
Squares and 3rd 
Order Least 
Squares

Both Least Squares methods use regression analysis 
to build a best-fit size calling curve.

Cubic Spline 
Interpolation

Forces the sizing curve through all the known points 
of the selected GeneScan size standard. 

Local Southern 
method

Determines the sizes of fragments by using the 
reciprocal relationship between fragment length and 
mobility. (Default method)

Global Southern 
method

Similar to the Least Squares method in that it 
compensates for standard fragments that may run 
anomalously. 

Description of the detection parameter options:

Item Description For example

Peak Amplitude 
Thresholds

Set the dye amplitude 
threshold at a level that 
allows the software to 
detect peaks, but 
eliminate noise. 

For each dye, the 
GeneMapper software 
detects peaks above 
the threshold entered 
in the entry field. 

If you leave the default 
value of 50, peaks with 
amplitude above 50 are 
analyzed and display in 
the tabular data. 

Lower amplitude peaks 
still display in the 
electropherogram, but 
are not analyzed and 
do not display in the 
tabular data.
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Split Peak
Correction

Parameter Options

Under denaturing conditions, certain fragments in the GeneScan 2500 
standard display as doublets, or split peaks. This standard has labels 
on both stands of the DNA. Under poor denaturing conditions you see 
split peaks. One of the two fragments typically has normal mobility, 
while the other does not. The Split Peak Correction feature allows the 
software to correctly call each of the splits.

If you select split peak correction, you will also need to verify or change 
the correction limits. After you decide on a split peak correction method, 
use the same method for all projects to keep size calling consistent.

Minimum Peak Half 
Width

Defines what 
constitutes a peak. 

Use to specify the 
smallest half peak 
width for peak 
detection.

The range is from 
2 - 99. 

A typical number might 
be 3 for microsatellites, 
or 10 for SSCPs.

If this number is large, 
the software ignores 
noise spikes. 

If the peaks in the data 
are narrow, set the 
value to a low number. 

Experiment with this 
value to determine the 
best number for the 
data.

Description of the detection parameter options: (continued)

Item Description For example

Half
width

Description of the split peak correction parameter options:

Item Description

No Peak Correction No correction for doublets.

GS2500 Peak 
Correction

Makes the following peak size assignments for 
GeneScan 2500:

♦ The right peak for all fragments 222, 233, 238, 
286, and 490.

♦ The left peak for all other splits.

Left Most Peak 
Correction

Chooses the left peak for every doublet.
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Right Most Peak 
Correction

Chooses the right peak for every doublet.

Correction Limit Set a correction limit if correcting for doublets. 

Set this value slightly larger than the largest split 
observed.

This value (set in data points) specifies the maximum 
width of split that should be corrected (the difference 
in data points of the positions of the two peaks). 

Description of the split peak correction parameter options: (continued)

Item Description
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Advanced Mode - Peak Detection Algorithm Settings

Overview In Advanced mode, there are four main analysis parameter options. 
They are as follows:

♦ Ranges

♦ Smoothing and Baselining

♦ Size Calling Method

♦ Peak Detection

Ranges Options The following are the Analysis Range options:

Item Description

Full Range button Use to analyze all the data collected on the genetic 
analysis instrument for each sample.

Partial Range 
(Data Points) 
button

Enter Start and Stop data point numbers in the entry 
fields in order to specify only a limited range to be 
analyzed for each sample.

Data points affect what is displayed in the results. 
Normally, you set the analysis range to start after the 
primer peak.

Sizing
drop-down menu:

All Sizes

Partial Sizes

Enter Start and Stop size numbers in the entry fields 
in order to specify only a limited range analyzed for 
each sample.
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Smoothing and
Baselining Options

The Smoothing and Baselining parameter options help to optimize peak 
size and eliminate noise from the baseline.

Baselining Option

The Baselining option controls the scope of the baseliner. Use this 
option to set the size Beta of the Baseline Window. GeneMapper 
software computes a baseline for the electropherogram of each dye 
independently.

How the Baselining Option Works

A baseline comprises a value at each data point i. Basically, the 
baseline value at each data point i, is the lowest electropherogram 
value in a window whose width Beta is set using the Baselining option, 
and centered at each data point i. 

Item Description

Smoothing 
option buttons

Used to help reduce the number of false peaks 
detected by the GeneMapper software.

You have the following options:

Baseline Window
text field

Used to automatically adjust the baselines of all 
detected dye colors to the same level for a better 
comparison of relative signal intensity.

Select... To...

None apply no smoothing.

Select this option if the data has very 
sharp, narrow peaks of interest.

Light provide the best results for typical 
data.

Heavy apply to data from slower runs that 
has very broad peaks, or to avoid 
the detection of sharp edges.

Choosing this option might reduce 
peak size or eliminate narrow peaks.
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More accurately, the baseline computed in this manner is intermediate. 
The real baseline value at each data point i, is the highest intermediate 
value, again in a window whose width Beta is set using the Baselining 
options and centered at each data point i. GeneMapper software 
baselines an electropherogram by subtracting the baseline from the raw 
electropherogram

Troubleshooting the Baseline Window

The following table describes what happens if the baseline window is 
either too small or too large..

Size Calling
Method Options

GeneMapper software uses these methods to determine the molecular 
length of an unknown fragment.

Using... Causes...

a small baseline window size the baseline to creep into the peaks, 
resulting in shorter peaks in the 
analyzed data.

a large baseline window size the baseline to ride too low, resulting 
in elevated and possibly not 
baseline-resolved peaks.

Description of the size calling method parameter options:

Item Description

2nd Order Least Squares and 3rd 
Order Least Squares

Both Least Squares Methods use 
regression analysis to build a best-fit 
sizecalling curve.

Cubic Spline Interpolation Forces the sizing curve through all 
the known points of the selected size 
standard.

Local Southern Method Determines the sizes of fragments 
by using the reciprocal relationship 
between fragment length and 
mobility. 

Global Southern Method Similar to the Least Squares Method 
in that it compensates for standard 
fragments that may run 
anomalously. 
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Peak Detection
Options

The Peak Detection options locate peaks at the positive-to-negative 
zero crossings of the first derivative of the baselined electropherogram. 
The peak detector computes the first derivative at a data point i by fitting 
a polynomial to a window centered on i. 

Item Description For example

Peak Amplitude 
Thresholds

GeneMapper software 
reports to the user only 
those peaks whose 
heights are at least the 
Peak Amplitude 
Threshold for that dye.

Set the dye amplitude 
threshold at a level that 
allows the software to 
detect peaks, but 
eliminate noise. 

If you leave the default 
value of 50, peaks with 
amplitude above 50 are 
analyzed and display in 
the tabular data. 

Lower amplitude peaks 
still display in the 
electropherogram, but 
are not analyzed and 
do not display in the 
tabular data.

Full Width Half 
Maximum

Defines what 
constitutes a peak. 

Use to specify the 
smallest full width at 
half maximum for peak 
detection.

The range is 2–99. 

A typical number might 
be 3 for microsatellites, 
or 10 for SSCPs.

If this number is large, 
the software ignores 
noise spikes. 

If the peaks in the data 
are narrow, set the 
value to a low number. 

Experiment with this 
value to determine the 
best number for the 
data.

Full
width

Half
height
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Polynomial Degree Sets the degree of the 
polynomial.

These parameters 
control the sensitivity of 
this process. Sensitivity 
increases with the 
polynomial degree and 
decreases with the 
window size.

Use polynomials of 
degree 2 or 3 for 
well-isolated peaks, 
such as those from a 
size standard, and a 
degree 4 for finer 
control.

For degree 4, the Peak 
Window Size should be 
1 to 2 times the full 
width at half maximum 
of the peaks that you 
wish to detect.

These parameters 
cannot be set for each 
color independently.

Peak Window Size Sets the width of the 
window

Slope Threshold for 
Peak Start

Slope Threshold for 
Peak End

Determines where a 
peak starts and stops

For example, a peak 
ends when the first 
derivative again 
exceeds the Slope 
Threshold for Peak 
End. 

Slope Threshold for 
peak start must be 
non-negative and 
Slope Threshold for 
peak end must be 
nonpositive. 

Values other than 0 will 
move the extent of the 
peak toward its center.

Item Description For example

Min. 
setting

Max. 
setting

2 5

Min. setting Max. setting

1 above the Degree of 
Polynomial 
differentiation setting.

Number of data points 
between peaks
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Peak Detection: Polynomial Degree and Peak Window Size 
Parameters

About These
Parameters

Use the Polynomial Degree and the Peak Window Size settings to 
adjust the sensitivity of the peak detection. You can adjust these 
parameters to detect a single base pair difference while minimizing the 
detection of shoulder effects or noise. 

Sensitivity increases with larger polynomial degree values and smaller 
window size values. Conversely, sensitivity decreases with smaller 
polynomial degree values and larger window size values.

How These
Parameters Work

The peak window size functions with the polynomial degree to set the 
sensitivity of peak detection.

The peak detector computes the first derivative of a polynomial curve 
fitted to the data within a window that is centered on each data point in 
the analysis range. 

Using curves with larger polynomial degree values allows the curve to 
more closely approximate the signal and, therefore, the peak detector 
captures more peak structure in the electropherogram.

The peak window size sets the width (in data points) of the window to 
which the polynomial curve is fitted to data. Higher peak window size 
values smooth out the polynomial curve, which limits the structure being 
detected. Smaller window size values allow a curve to better fit the 
underlying data.

How to Use These
Parameters

Use the table below to adjust the sensitivity of detection. 

To... Polynomial 
Degree Value

Window Size 
Value

Increase sensitivity use... Higher Lower

Decrease sensitivity use... Lower Higher
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Guidelines for
Using These
Parameters

To detect well-isolated, base-line-resolved peaks, use polynomial 
degree values of 2 or 3. For finer control, use a degree value of 4 or 
greater. 

As a guideline, set the peak window size (in data points) to be about 1 
to 2 times the full width at half maximum height of the peaks that you 
want to detect.

Examining Peak
Definitions

To examine how GeneMapper software has defined a peak, select
View > Show Peak Positions. The peak positions, including the 
beginning, apex, and end of each peak, are tick-marked in the 
electropherogram.
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Effects of Varying
the Polynomial

Degree

The figure below depicts peaks detected with a window size of 15 data 
points and a polynomial curve of degree 2 (green); 3 (red); and 4 
(black). The diamonds represent a detected peak using the respective 
polynomial curves. 

Note that the smaller trailing peak is not detected using a degree of 2 
(green). As the peak detection window is applied to each data point 
across the displayed region, a polynomial curve of degree 2 could not 
be fitted to the underlying data to detect its structure.

Electropherogram showing peaks detected with three different polynomial 
degrees

Polynomial curve of degree 4
(black)

Polynomial curve of degree 3
(red)

Polynomial curve of degree 2
(green)
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Effects of
Increasing the

Window Size Value

In the figure below, both polynomial curves have a degree of 3 and the 
window size value was increased from 15 (red) to 31(black) data points. 

As the cubic polynomial is stretched to fit the data in the larger window 
size, the polynomial curve becomes smoother. Note that the structure of 
the smaller trailing peak is no longer detected as a distinct peak from 
the adjacent larger peak to the right.

Electropherogram showing the same peaks as in the figure above (see page 
B-21) after increasing the window size value while keeping the polynomial 
degree the same

Window size value of 15 (red)

Window size value of 31 (black)
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Optimizing Peak Detection Sensitivity: Example 1

Initial
Electropherogram

The figure below shows two resolved alleles of known fragment lengths 
(that differ by one nucleotide) detected as a single peak. The analysis 
was performed using a polynomial degree of 3 and a peak window size 
of 19 data points.

Electropherogram showing two resolved alleles detected as a single peak

Note For information on the tick marks displayed in the electropherogram see 
Examining Peak Definitions on page B-19.
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Effects of
Decreasing the

Window Size Value

The figure below shows that both alleles are detected after re-analyzing 
with the polynomial degree set to 3 while decreasing the window size 
value to 15 (from 19) data points.

Electropherogram showing the alleles detected as two peaks after decreasing 
the window size value
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Optimizing Peak Detection Sensitivity: Example 2

Initial
Electropherogram

The figure below shows an analysis performed using a polynomial 
degree of 3 and a peak window size of 19 data points.

Electropherogram showing four resolved peaks detected as two peaks
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Effects of
Reducing the

Window Size Value
and Increasing the
Polynomial Degree

Value

The figure below shows the data presented in the figure above (see 
page B-25) re-analyzed with a window size value of 10 and polynomial 
degree value of 5.

Electropherogram showing all four peaks detected after reducing the window 
size value and increasing the polynomial degree value
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Optimizing Peak Detection Sensitivity: Example 3

Effects of Extreme
Settings

The figure below shows the result of an analysis using a peak window 
size value set to 10 and a polynomial degree set to 9. This extreme 
setting for peak detection led to several peaks being split and detected 
as two separate peaks.

Electropherogram showing the result of an analysis using extreme settings for 
peak detection
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Peak Detection: Slope Threshold for Peak Start and Slope 
Threshold for Peak End Parameters

About These
Parameters

Use the Slope Threshold for Peak Start and Slope Threshold for Peak 
End parameters to adjust the start and end points of a peak. 

This parameter can be used to better position the start and end points 
of an asymmetrical peak, or a poorly resolved shouldering peak, to 
more accurately reflect the peak position and area. 

How These
Parameters Work

In general, from left to right, the slope of a peak increases from the 
baseline up to the apex. From the apex down to the baseline, the slope 
becomes decreasingly negative until it returns to zero at the baseline.

If either of the slope values you have entered exceeds the slope of the 
peak being detected, the software overrides your value and reverts to 
zero. 

Guidelines for
Using These
Parameters

As a guideline, use a value of zero for typical or symmetrical peaks. 
Select values other than zero to better reflect the beginning and end 
points of asymmetrical peaks.

A value of zero will not affect the sizing accuracy or precision for an 
asymmetrical peak.

Baseline

Apex

0 0

Increasingly
positive
slope

(+)

Increasingly
negative

slope
(–)
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Using These
Parameters

Use the table below to move the start or end point of a peak. 

Note The size of a detected peak is the calculated apex between the start 
and end points of a peak and will not change based on your settings.

IF you want to move the... THEN change the...

start point of a peak 
closer to its apex

Slope Threshold for Peak Start value from 
zero to a positive number

end point of a peak 
closer to its apex

Slope Threshold for Peak End value 
to an increasingly negative number
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Slope Threshold Examples

Initial
Electropherogram

The initial analysis with a value of 0 for both the Slope Threshold for 
Peak Start and the Slope Threshold for Peak End value produced an 
asymmetrical peak with a noticeable tail on the right side.

Electropherogram showing an asymmetrical peak

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Software Genotyping Algorithms B-31

Electropherogram
After Adjustments

After re-analyzing with a value of –35.0 for the Slope Threshold for Peak 
End, the end point that defines the peak moves closer to its apex, 
thereby removing the tailing feature. Note that the only change to 
tabular data was the area (peak size and height are unchanged).

.

Electropherogram showing the effect of changing the slope threshold for peak 
end
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Size Calling Methods for Classic and Advanced Modes

Overview There are four size calling methods that you can use with the 
GeneMapper software v3.0. They are as follows:

♦ Least Square

♦ Cubic Spline Interpolation

♦ Local Southern

♦ Global Southern

Least Square
Method

Both Least Squares methods (2nd Order and 3rd Order) use regression 
analysis to build a best-fit size calling curve. This curve compensates 
for any fragments that may run anomalously. As a result, this method 
normally results in the least amount of deviation for all the fragments, 
including the size standards and the samples.

Depending on whether you choose the 2nd or 3rd Order Least Squares 
Method in the Analysis Parameters dialog box, the resulting size curve 
is either a quadratic or a cubic function. The software uses the known 
standard fragments and the associated data points to produce a sizing 
curve based on Multiple Linear Regression.

Advantages

In the figures on page B-33, you can see that in nearly all instances the 
mobility of an individual DNA fragment is coincident with the best curve 
fit of the entire data set. Stated differently, the mobility of most DNA 
fragments is strictly length-dependent. This method automatically 
compensates for fragments that run anomalously.

GeneMapper software v3.0 calculates a best-fit least squares curve for 
all samples, regardless of the size calling method you choose. The 
curve is black in the Standard Sizing Curve window.
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2nd Order Least Squares size calling curve

Note This graph was generated using GeneScan 3.7.1 software. These 
results are similar to results obtained when you use GeneMapper software v3.0.

3rd Order Least Squares size calling curve

Note This graph was generated using GeneScan 3.7.1 software. These 
results are similar to results obtained when you use GeneMapper software v3.0.
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Cubic Spline
Interpolation

Method

By definition, the Cubic Spline method forces the sizing curve through 
all the known points of the selected size standard. Although this 
enforement produces exact results for the values of the standards 
themselves, it does not compensate for standard fragments that may 
run anomalously.

Note This graph was generated using GeneScan 3.7.1 software. These 
results are similar to results obtained when you use GeneMapper software v3.0.

Possible Local Sizing Inaccuracy

Mobility of any DNA fragment can be affected by its sequence, and by 
secondary and tertiary structure formation. If any internal size standard 
fragment has anomalous mobility, the Cubic Spline method may exhibit 
local sizing inaccuracy. 

For example: Assume that a standard fragment is close in molecular 
length to an unknown sample fragment. Assume further that the 
standard fragment runs anomalously. The Cubic Spline method assigns 
the official value to this standard fragment, even though it may be 
slightly incorrect. The size of the unknown fragment is then likely to be 
calculated incorrectly as well. 

Note This method does not determine the amount of sizing accuracy error.
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Local Southern
Method

The Local Southern method determines the sizes of fragments by using 
the reciprocal relationship between fragment length and mobility, as 
described by E. M. Southern (1979). 

Note This graph was generated using GeneScan 3.7.1 software. These 
results are similar to results obtained when you use GeneMapper software v3.0.

The Equation 

L = [c/(m-m0)] + L0

The equation attempts to describe the reciprocal relationship between 
the mobility, m, and the length, L0, of the standard fragments.
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How This Method Works

This method, which is similar to the Cubic Spline method, uses the four 
fragments closest in size to the unknown fragment to determine a best 
fit line value. Only the region of the size ladder near the fragment of 
unknown length is analyzed. 

Note Size estimates may be off if any of the standard fragments run 
anomalously.

The following table lists how the Local Southern method works:

Step Action

1 The fitting constants of the curve are calculated for each group of 
three neighboring points on the standard. 

A separate curve is created for each set of three points.

2 A curve is then created by using three standard points (two points 
below and one point above the fragment) and a fragment size is 
determined.

3 Another curve is created by looking at an additional set of three 
points (one point below and two points above the fragment) and 
another value is assigned. 

4 The two size values are averaged to determine the unknown 
fragment length.
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Global Southern
Method

This method is similar to the Least Squares method in that it 
compensates for standard fragments that may run anomalously. The 
method creates a best-fit line through all the available points, and then 
uses values found on that line to calculate the fragment values.

Note This graph was generated using GeneScan 3.7.1 software. These 
results are similar to results obtained when you use GeneMapper software v3.0.
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The Equations 

The following table describes how the equations work:

How This Method Works

All points in the standard are weighted equally and the curve is not 
constrained to go through any specific point. The software can analyze 
a large range of fragment sizes with this method.

For best results, use a standard that brackets all the fragments of 
interest.

Equation Description

L = [c/(m-m0)] + L0 Attempts to describe the reciprocal 
relationship between the mobility, m, 
and the length, L0, of the standard 
fragments.

∑i(Li - (c/(mi-m0) + L0))2 The fitting constants L0, m0, and c 
are calculated by a least squares fit 
to minimize the left side quantity.

DNA fragments that are... Are sized using...

not bracketed within the size 
standard curve

a second order least squares curve 
extrapolation.

bracketed within the size standard 
curve

the method that was chosen.
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Project Window
Software Interface C
Appendix Overview

Introduction This appendix gives detailed descriptions of the features of the ABI 
Prism® GeneMapper™ Software Version 3.0 application, including 
details of each major application window.

In This Appendix This appendix contains the following topics:

Section See Page

Overview of the Project Window C-2

Project Window Menus C-9

Project Window File Menu Dialog Boxes C-27

Printing Tables and Electropherograms C-34

Add Samples to Project Dialog C-36

Project Window Edit Menu Dialog Boxes C-46

C
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Overview of the Project Window

Menus and Dialog
Boxes

The Project window has a number of menus and dialog boxes 
associated with it. The drop-down menus available on each window (for 
example, File, Edit, View) provide a set of commands specific to the 
window. This section will describe the menu commands and dialog 
boxes associated with a given window.

Samples View The following information is provided in this section for the Samples 
view.

Appearance of Samples View

The Samples view of the Project window displays the samples you want 
to analyze or have already analyzed. This view looks much like the 
following example when sample data has been imported.

Note You can hide and show columns in the table using Table Setting.

Topic See Page

Appearance of Samples View C-2

Samples View Columns C-3

Samples View Features C-5
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Samples View Columns

The columns of the Samples view are explained in the table below.

Note The following image is shown with the navigation pane closed.

.

Samples View Column Descriptions

Column Description

Sample or row 
number

From application; used to select a single entire row.

Status A  symbol indicates that the sample needs to 
be analyzed or reanalyzed.

Note These symbols indicate status of each 
sample, and they control which samples will be 
analyzed during the next analysis if the Analyze icon 
is selected. There are other analysis options which 
ignore the status field.

♦ The Status field next to each sample contains the 
 symbol prior to analysis. This field is empty 

after analysis, if analysis was successful.

♦ Resetting parameters such as the Panel, Size 
Standard, Sample Type, and the Analysis 
Method resets the symbol for a given sample, 
enabling reanalysis.

Sample File From sample sheet; not editable.

Sample Name From sample sheet; editable, free text.

Comments Editable, free text.
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Note Refer to Appendix A for PQV information.

Sample Type Editable via Sample Type drop-down list box; valid 
types are Sample, Control, Allelic Ladder, and 
Primer Focus, Negative Control.

Analysis Method Editable via a drop-down list box. The list is editable 
via the Analysis Method Editor in the Analysis 
Methods tab in the GeneMapper Manager window.

Panel Editable via Panel window; Panel window contents 
come from Panel Manager.

Size Standard Editable via a drop-down list box. The list is editable 
via the Size Standard Editor in the Size Standards 
tab in the GeneMapper Manager window.

Matrix Editable via a drop-down list box. The list is editable 
via the Matrix Editor in the Matrices tab in the 
GeneMapper Manager.

For the ABI PRISM® 377 DNA Sequencer and the 
ABI PRISM® 310 Genetic Analyzer instruments, the 
matrix file is created in the Matrices Tab in the 
GeneMapper Manager window.

Run Name From sample sheet; not editable.

Instrument Type From sample sheet; not editable.

Instrument ID From sample sheet; not editable.

Run Date and Time From sample sheet; not editable.

REF Reference data;  indicates that the selected 
sample is defined as reference data in the Panel 
Manager.

SQI Sizing quality invalidated; checkmark indicates that 
sizing quality value is 1.0.

User Defined 1-3 Editable free text. Also from the vertical bar enabled 
in the sample sheet fields. See Chapter 2, “Using 
GeneMapper Software.”

Samples View Column Descriptions (continued)

Column Description
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Samples View Features

Feature Description

Select Row(s) Click the Row Header box; drag to select a 
continuous range.

Select Column(s) Click the Column Header box; drag to select a 
continuous range.

Resize columns Click and drag between columns to change column 
width.

Quick sort column Shift–click the column header to sort ascending; 
shift–click again to sort descending.

Deselect Row Ctrl-click the Row Header box
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Genotypes View The Genotypes view, shown below, displays the results of allele calling 
analysis. Each row or “record” in the table is a single marker for a 
sample. For example, if a panel specified for a sample contains four 
markers, the Genotypes table contains four records for that sample 
(each in a separate row).

Single 
Marker

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Project Window Software Interface C-7

Genotype View Columns

The table in the Genotypes view can display some of the columns in the 
Samples view (see table on page C-3), plus these unique columns.

 Genotypes View Columns

Column Description

Marker Not editable; name of the marker associated 
with the record; created in the Panel 
Manager.

Dye From Panel Manager; not editable; indicates 
which dye is associated with the marker 
(B=blue, G=green, Y=yellow, R=red, or 
O=orange).

Note Not used for SNP Genotyping 
(SNaPshot® analysis).

Allele 1, 2, etc. Not directly editable in the table cell; allele 
calls are editable only in the plot windows.

The call for Allele 1. Allele calls and names 
are defined in the Panel Manager as bin 
names. The Allele call text box displays a list 
of valid calls plus one of the following:

♦ ? (for unknown) for linkage and SNP 
(SNaPshot) applications

♦ OL (Off-ladder) for Human Identification 
(HID) applications

♦ blank for no allele calls.

Note When alleles shown in the 
Genotypes table are edited in the Plot 
window, the allele call in the table also 
changes and confidence value indicators in 
the table turn to grey triangles.

Size 1, 2, etc. Peak size for Allele. Not editable.

Height 1, 2, etc. Peak height for Allele. Not editable.

Peak Area 1 & 2 Peak area for Allele. Not editable.

Mutation Indicates allele falling within a mutant bin.

AE Comment Displays last user-edited comment.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



C-8 Project Window Software Interface

Note Refer to Appendix A for PQV column information.

ADO (Allele Display 
Overflow)

♦ The box is labeled with an  when the 
number of alleles the marker calls 
exceeds the number to display previously 
set by the user. 

♦ The user specifies how many alleles to 
display in the Table Settings parameters. 
(The default is two.)

♦ There are six columns for each allele to 
indicate name, size, height, area, 
mutation, and comment.

AE (Allele Edit ) ♦ The box displays unlabeled immediately 
after analysis.

♦ The box is labeled with an when the 
marker allele calls have been edited by 
the user.

♦ The marker allele calls can be edited in 
the Plot window. The user can enter 
comments in the Allele Edit column while 
editing allele calls.

User Defined 1-3 Editable; free text. Also from vertical bar 
enabled in sample sheet fields. See 
Chapter 2, “Using GeneMapper Software.”

 Genotypes View Columns (continued)

Column Description
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Project Window Menus

Introduction The tables in this section describe the following Project Window menus.

Command
Activation and
Special Terms

The commands in the Project Window menu can be activated in two 
ways:

♦ Clicking the command in the menu, or 

♦ Using the special key combinations shown to the right of the name 
in the menu.

File Menu The commands are described in the table below.

Topic See Page

File Menu C-9

Edit Menu C-11

Analysis Menu C-12

View Menu C-14

Tools Menu C-16

Help Menu C-26
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Project Window File Menu Commands

Item Description Enabling

New Project 
(Ctrl+N)

Clears sample files, results, and 
project name from the Project 
window, displaying a blank Project.

If previous project has pending 
changes, the following alert 
message is displayed: Do you 
want to save changes? [Yes] [No] 
[Cancel]

Always enabled 
except when a blank 
Project is displayed.

Open Project 
(Ctrl+O)

Displays the Open Project dialog 
box.

If previous Project has pending 
changes, the following alert 
message is displayed: you want to 
save changes? [Yes] [No] [Cancel]

Always enabled.

Save Project 
(Ctrl+S)

Saves Project to the file named at 
the start of analysis.

Named projects are saved to the 
GeneMapper database without a 
dialog box.

Enabled when the 
Project table has 
pending changes.

Save Project 
As...

Displays the Save dialog box. Always enabled.

Add Samples 
To Project 
(Ctrl+I)

Opens the Add Samples To 
Project dialog box.

Always enabled.

Export Table
(Ctrl+E)

Displays the Export table dialog 
box.

Exports table as tab or comma 
delimited text file.

Enabled when the 
Project table 
contains data.

Print
(Ctrl+P)

Displays the Print dialog box.

The standard Print Setup dialog is 
opened from the Print dialog.

Enabled when the 
project table contains 
data.

Log Out Closes the Project window and 
displays the Login window.

Displays a Save alert message if 
the Project has pending changes.

Always enabled.
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Edit Menu The commands in the Edit menu are used to manage the contents of 
the Project window by performing standard actions like undo, delete, 
select, and by enabling access to settings for Preferences. 

Exit (Alt+F4) Exits the GeneMapper application; 
displays Save alert message if 
Project has pending changes.

Always enabled.

Project Window File Menu Commands (continued)

Item Description Enabling

Project Window Edit Menu Commands

Item Description Enabling

Delete From 
Project

Deletes the selected sample(s) 
from the Project and the database 
and displays the following alert 
message: 

Deleting the selected sample(s) 
will delete both samples and 
results from project. This action 
cannot be undone. 
[OK] [Cancel] 

Enabled when a 
Project sample is 
selected.

Note Each use of the command removes a single run or 
sample. If you want to remove all samples and the associated 
folder, use the Select All command before using the Delete 
from Project command. This action does not delete the actual 
sample file or Sequence Collector sample data.

Select All
(Ctrl+A)

Selects all samples in the active 
view.

Always enabled.
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Analysis Menu The commands in this menu control analysis and display of the data in 
a Project and access to a number of other windows that support the 
Project window, such as the Analysis Manager and Panel Manager. The 
following table is provided as a reference for the Analysis menu.

Fill Down

(Ctrl+D)

Fills the selected column with the 
contents of the first cell. This 
command is applicable only to 
Analysis Method, Panel, Size 
Standard, and Matrix columns.

Enabled when a 
column is selected or 
multiple cells are 
selected.

Find 
(Ctrl+F)

Displays the Find dialog box. Enabled when the table 
contains data.

Sort 
(Ctrl+G)

Displays the Sort dialog box. Enabled when the table 
contains data.

Project Window Edit Menu Commands (continued)

Item Description Enabling

Project Window Analysis menu commands:

Item Description Enabling

Display Plot
(Ctrl+L)

Opens the Plot window. Enabled when one or 
more samples or 
records are selected.

Size Match 
Editor 

Opens the Size Match Editor 
window.

Enabled only when 
sized samples are 
present in the Project.
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Analyze
(Ctrl+R)

Analyses all samples eligible for 
analysis. The symbol is shown 
in the Status column.

Enabled when 
Samples tab is visible 
and at least one 
sample in the table 
requires analysis.

Analyze 
Selected 
Samples

Analyzes selected samples 
only.

Enabled when 
Samples tab is visible.

Analyze All
(Ctrl+Shift+R)

Analyzes all samples whether 
or not the Status column 
reports that the sample is 
eligible for analysis, including 
those previously analyzed. The 
following alert message is 
displayed: Analyze all samples? 
This may change your existing 
results. This action cannot be 
undone. [OK] [Cancel]

Enabled when 
Samples tab is visible.

Analyze 
Markers

Analyzes only the marker(s) 
you select within each sample. 
(“Analyze Markers Dialog Box” 
on page C-14.)

Enabled when 
Samples tab is visible.

Analysis 
Method Editor

Allows the user to change the 
settings for analysis.

Enabled when a 
sample with an 
analysis method is 
selected.

Size Standard 
Editor

Allows the user to edit base pair 
and dye settings.

Enabled when one or 
more samples or 
records are selected.

Low Quality To 
Top
(Ctrl+B)

Sorts all Low Quality (SQ or GQ 
column) samples or results 
records to the top of the table.

Enabled when 
analyzed samples are 
present in the table.

Non-concordant 
Samples to Top

Brings non-concordant samples 
to the top of the analysis page.

Project Window Analysis menu commands: (continued)

Item Description Enabling
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Analyze Markers Dialog Box

The Analyze Markers dialog box enables you to select which marker, or 
set of markers separated by commas, will be analyzed within each 
sample.

This option is only enabled when you are in the Project window 
Samples tab and samples are present.Does not work with HID 
samples.

View Menu The View menu is used to hide/show the Project window navigation 
pane and switch between the two Project window tabs. The following 
table is provided as a reference for the View menu.

Project Window View Commands:

Item Description Enabling

Samples
(Ctrl+Shift+1)

Switches to the Samples tab. Always enabled.

Genotypes
(Ctrl+Shift+2)

Switches to the Genotypes tab. Enabled when results 
are present.

Sample Info 
(Ctrl+F1)

Switches to the Info tab for the 
selected sample in the project.

Always enabled.
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Y Axis Scale

The Y Axis Scale option is only enabled when viewing the raw data or 
EPT data of a sample file.

There are two options:

♦ Scale to maximum Y - scales to the maximum Y value for the 
selected sample.

♦ Scale to - opens a dialog box in which a user can define the value 
of the Y axis.

Raw Data 
(Ctrl+F2)

Switches to the Raw Data tab 
for the selected sample in the 
project.

Always enabled.

EPT Data 
(Ctrl+F3)

Switches to the EPT tab for the 
selected sample in the project.

Always enabled.

Full View 
(Ctrl+])

Shows the full view of the Raw 
Data or EPT graph.

Enabled only when 
viewing the Raw Data 
or EPT Data of a 
sample.

Y-Axis Scale Changes Y-axis scale. (See “Y 
Axis Scale” on page C-15.)

Enabled only when 
viewing the Raw Data 
or EPT Data of a 
sample.

Show 
Navigator
(Ctrl+ Shift+N)

Switches the navigator pane 
(shows/hides the pane).

Always enabled.

Project Window View Commands: (continued)

Item Description Enabling
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Tools Menu The Tools menu provides access to the GeneMapper Manager, Panel 
Manager, and Table Setting Editor applications.

Item Description Enabling

GeneMapper 
Manager (Ctrl+M)

Opens the GeneMapper 
dialog box. (See 
“GeneMapper Manager” on 
page 2-11.)

Always enabled.

Panel Manager
(Ctrl+J)

Opens the Panel Manager 
dialog box. (See Chapter 4, 
“Using Panel Manager.”)

Always enabled.

Table Setting 
Editor
(Ctrl+T)

Opens the Table Setting 
Editor dialog box. (See 
“Table Settings Editor” on 
page 6-4.)

Only enabled when 
samples are present. 
Only allows editing of a 
currently selected 
Table Profile.

Show Offsets Displays bin offsets for 
selected samples.

Always enabled.

Options Opens the Options dialog 
box. (See “Options Dialog 
Box” on page C-17.)

Always enabled.
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Options Dialog Box

The Options dialog box contains several tabs for setting preferences 
associated with various software features. The following tabs are 
described below:

Note Each registered user has his or her own set of preferences. When you 
set these options, it only affects the currently logged in user.

Startup Tab:

The Startup tab contains preferences associated with the startup of the 
software.

Topic See Page

Startup Tab: C-17

Add Samples Tab: C-18

Sequence Collector Tab: C-21

Analysis Tab: C-22

Users Tab: C-24
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Add Samples Tab:

The Add Samples tab contains preferences associated with the adding 
of samples.

Startup Tab Elements

Element Description

Open Blank Project 
option button

Sets the software so that upon launch, a blank 
Project window opens.

Open Previous Project 
option button

Sets the software so that upon launch, the last 
Project viewed will open.
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Add Samples Tab Elements 

Element Description

Set Analysis Method to 
drop-down menu and

Read from the Sample
option button

When you add samples, the Analysis Method 
property is set to the value in the text box, which 
contains the list of analysis methods from the 
GeneMapper database.

Set Size Standard to 
drop-down menu and

Read from the Sample
option button

When you add samples, set the size standard 
property to the value in the text box, which 
contains the list of size standards from the 
GeneMapper database.

Set 310/377 Matrix to
drop down menu

Read from the Sample
option button

Set the matrix file to the dye you are using or 
read from the sample file.

Set Panel to

♦ Select a Panel for all 
samples option button 
and window

When you add samples, the panel for all 
samples is set to the value in the text box. When 
the option button is selected, the following 
choices may be made:

♦ Leave the text alone, which selects the 
existing name, or

♦ Click the field to present the Select a Panel 
window (to select an existing panel)

The Select a Panel window contains the list of 
panels from the GeneMapper database.

♦ Read from the Data 
collection 
‘Comment/Panel field’
option button

When you add samples, the panel for all 
samples is set to the value in the Sample Sheet 
“comment” column.
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Note The Panel and Sample Type properties accounts for close spellings and 
abbreviations as shown in the following table.

Set Sample Type to

♦ Sample type for all 
samples option button 
and drop-down menu

When you add samples, the Sample Type for all 
samples is set to the value chosen from the 
Sample Type drop-down menu, contains 
choices for Sample, Control, Allelic Ladder, and 
Primer Focus.

♦ Read from Data 
collection ‘Info’ field
option button

When you add samples, the GeneMapper 
software does a “best guess” match, comparing 
the contents of the field specified in the Sample 
type box with the list of sample types (Sample, 
Control, Allelic Ladder, Negative Control, and 
Primer Focus).

♦ If a match is found, then the Sample Type 
property for the sample is set to that sample 
type.

♦ If a match is not found, then the Sample 
Type property for the sample is set to 
“Sample.”

Spellings and Abbreviations

Case Result

A sample file field contains 
either Control, Ctrl, Crl, Cntrl, 
or a similar variation.

The sample type for the sample is set to 
Control.

Add Samples Tab Elements (continued)

Element Description
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Sequence Collector Tab:

The Sequence Collector tab enables access to a single Sequence 
Collector.

 Sequence Collector Tab Elements

Element Description

Test Result The results returned are Pass or Fail. These results are 
displayed by clicking the Test Connection button. If the 
Test Connection button has not been pressed, the Test 
Result will display Not Tested.

User Name Registered user name to access Sequence Collector.

Password Password for the user name to access Sequence 
Collector; data entry into this field displays as bullets or 
asterisks.

Save 
(check box)

Save the Password; when set, the user does not have to 
enter a password to get access to Sequence Collector.

Database Name of the Sequence Collector (Sequence Collector 
string); refer to Sequence Collector documentation for 
more information.

Schema Owner The name of the owner who has access to desired 
sample collections.

Test Connection 
(button)

Tests the connection to the database specified; includes 
appropriate error checking per Sequence Collector.
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Analysis Tab:

The Analysis tab contains preferences associated with the analysis of 
data.

 Analysis Tab Elements

Element Description

Automatic Analysis 
group box:

Automatically brings 
errors to the top of the 
table check box

When samples are analyzed, the software sorts 
the table automatically to bring samples with 
errors to the top of the table. Same functionality as 
the Bring Errors To Top icon in the Project window.

Quality Metrics Display 
group box:

Symbols button

Numbers button

Display quality values in project tables as symbols 
(green square, yellow triangle, red octagon), or 
numerical values (0.0, ..., 1.0).

Note If Symbols (default) is chosen, then all 
quality values are shown as symbols. If Numbers 
is chosen, then only SQ and GQ columns are 
shown as numbers; the other result columns are 
symbols.
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If only one allele is 
labeled in a genotype, 
then duplicate the label 
group box:

Duplicate homozygous 
alleles checkbox

If this option is checked, single alleles will be 
displayed in the Genotypes table and in the Plot 
window as two labels to indicate presumed 
homozygotes.

 Analysis Tab Elements (continued)

Element Description
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Users Tab:

The Users tab contains preferences associated with managing 
registered users.

Note Once created, user names cannot be deleted.

Users Tab Elements

Element Description

User Name field Displays the list of registered users. 

♦ User Name column = Name of the user

♦ Created On column = Date user was created

♦ Show column = Shows the user in User Name 
drop-down menu of the login window, if checked.

Clearing a Show column check box for a user blocks 
login for that user (can be done by anyone running 
GeneMapper software).

Shift–click the column label headers to sort the list by 
that column.
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New User button Opens the New User dialog box.

To add a user name for GeneMapper software, click New 
User to open a dialog box and then:

1. Type a user name into the dialog box.

2. Enter a password using only alphabetic 
characters.

3. Confirm the password.

4. Click OK to assign the user name and close the 
dialog.

When you select this user name on launching 
GeneMapper software, the name is used to identify 
the preferences set by the user.

Note User names must be unique. If the new user 
name is not unique, an alert message will be displayed.

Note Users added here are for this GeneMapper 
software installation and is visible to all other users. The 
names are converted to lower case and passwords are 
not case sensitive.

Users Tab Elements (continued)

Element Description
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Help Menu The Help menu provides access to online help and to the About 
GeneMapper software window.

Change 
Password

Opens the Change Password dialog box, and allows you 
to change the password for the selected user.

Users Tab Elements (continued)

Element Description

Project Window Help Menu Commands

Item Description Enabling

GeneMapper Help
(F1)

Opens the GeneMapper User 
Manual PDF file using Acrobat 
Reader.

Does not open the tutorial guides.

Always enabled.

About 
GeneMapper 

Opens the About GeneMapper 
window and displays the software 
version.

Always enabled.
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Project Window File Menu Dialog Boxes

Introduction The following dialog boxes are accessed from the Project window File 
menu. This section describes each of the dialog boxes.

Note This section contains information on all application dialog boxes except 
for the “Add Samples to Project” dialog box, which is covered under its own 
section (See “Add Samples to Project Dialog” on page C-36).

Save Dialog Box The Save dialog box, accessed from the New Project window, is 
presented when a project already exists in the Project window, and 
provides you with the option of saving the project.
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Open Project
Dialog Box

The Open Project dialog box displays the list of projects in the 
database. You use the first field to find a project quickly, then click the 
Open button to open the selected project (or double-click the project 
name).

Note Once you have opened a Project window, you may resize it horizontally 
and vertically to increase the width and depth of the Project table.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Project Window Software Interface C-29

The following table describes the Open Project dialog box window 
elements.

Open Project Window Elements

Element Description

Search field Typing in this field selects the first item in the project 
list whose name matches the characters. 

Project table Lists all the projects in the database.

♦ Project = Name of the project.

♦ Last Saved = Date and time stamp of when the 
project was last modified.

♦ Owner = Name of the user who created the project.

♦ # of Samples = the number of samples in the 
project.

Note Columns may not be moved or hidden. You 
may resize the width of the columns by dragging 
between the column headers. Only one row in the table 
may be selected at a time. You may navigate up and 
down in the table using arrow keys.

Shift-clicking a column header sorts the data by that 
column.

Open Opens the selected project. If previous project has 
pending changes, the following alert message is 
displayed before the Open Project dialog box opens: 
Do you want to save changes? [Yes] [No] [Cancel]

Cancel Closes the Project Manager dialog box.
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Save Project and
Save Dialog Boxes

The Save Project and Save boxes enable you to save projects to the 
database. The first dialog box is presented for the Save command if you 
want to save a project before it is analyzed. Using Save after analysis 
does not require a dialog box because you are required to name a 
Project before analysis.

The Save dialog box opens when you select the Save As command.

The elements of these dialog boxes are described in the table below.

Save Project Elements

Element Description

Project name Text field for the name of the project; accepts 
alphanumeric characters. 
The database requires standard Windows interface 
restrictions on length and symbol characters. 

OK Saves the project to the database.

Saved projects are tagged with the Project Name, 
User Name, and Time/Date Stamp. If the name you 
entered already exists, an alert message is displayed.

Cancel closes the alert dialog and displays the Save 
Project dialog box again.

Cancel Closes the dialog box and does not save the project.
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Export Table
Dialog Box

The Export Table dialog box allows you to choose where to save the 
exported file.

The file types supported include:

♦ Tab-delimited text (.txt)

♦ Comma-separated values (.csv)

Note Export operates on the currently-displayed tab. For example, if the 
Samples tab is displayed, Export would export the tab-delimited data shown in 
the Samples table. Exported data includes column headers.

Save Saves the project under the name entered in the dialog 
box.

Don’t Save Aborts the Save action.

Save Project Elements (continued)

Element Description

1

2

3

4

5

6
7

8
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Note Exported text tables show PQV’s as numbers even if they are displayed 
as symbols.

Export Table Callouts

Item Name Description

1 Toolbar These icons are used as follows:

 -  Clicking moves display up one level in 
main pane.

  - Clicking moves display to “Home” level in 
main pane. This is usually 
“Profiles\<user>”.

 - Clicking creates a new folder at the 
present directory level.

  - Clicking presents a list of the contents of 
the selected folder.

  - Clicking presents details of the selected 
folder.

2 Drop-down 
directory menu

Select drive letter and/or folder.

3 Folder/file 
display pane

The contents of the drive/directory are selected 
in the toolbar and the directory menu is displayed 
here.

4 Export Table 
button

This button exports the selected table.

5 File name field Enter a file name to use for exported table.

6 Show files of 
type field

This is a display filter for files (folders are always 
shown). Allows specification of file extension. 
Filters files for display in all files, .txt files, .csv 
files, .txt&.csv.

7 Cancel button Closes the Export Table window without 
exporting a table.

8 Export file as 
field

Select the format of the file you want to export.
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Print Dialog Box The Print dialog box, shown below, is a print file dialog box that controls 
printing. The Samples table, the Genotypes table, Panel Manager 
views, and plot windows may be printed.

The dialog box above contains the following items used for printing:

Item Description

Properties 
button

Presents the dialog box used to set up the printer.

Name field Shows the currently selected printer.

Note The drop-down menu to the right allows selection 
of other available printers.

Status Indicates status of selected printer.

Type Shows type of printer.

Where Shows the path name of the selected printer.

Comment Check box enables printing the project to a file.

Page range All is the only option available when working with tables.

Number of 
Copies

Select the number of copies to print.

Collate options Check box enables collating of copies.
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Printing Tables and Electropherograms

Introduction All tables and electropherograms can be printed as what-you-see-is- 
what-you-get (WYSIWYG), except for these conditions:

♦ Only the number of columns shown in the table printout below are 
printed out on a single sheet of paper in the Portrait mode. 
Additional columns to the right are printed out on additional sheets 
of paper. Change to the Landscape mode to minimize the number 
of sheets of paper used.

Note To reduce the number of sheets of paper printed for a table, hide 
columns you do not want to print using the Table Settings Editor.

♦ Printed plots are sized vertically to fill a single sheet of paper:

– With four plots, the plots are sized close to the same size as the 
default size on your monitor.

– Six plot panes are a practical limit for a single sheet.

Examples Table Printout

Note Additional pages are created to accommodate the number of rows in the 
table. Each additional page that continues the table to the right would have the 
same row numbers as shown in the left column.
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Plot Printout

Note The number of plots per page is set by the Panes dialog box in the Plots 
window. The example above was scaled down vertically and would be printed 
on the whole height of the page on a printer.
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Add Samples to Project Dialog

Introduction This section provides general information about:

♦ the Add Samples to Project dialog

♦ the Edit and View menus available in the window

♦ using the three tabs in the window.

This following topics are covered in this section.

General
Information and

Procedure

The Add Samples to Project window provides a navigation pane to 
enable you to add Samples to the project. You can also access the 
dialog box by clicking the Add Sample icon on the Project window 
toolbar.

Topic See Page

General Information and Procedure C-36

Edit Menu C-37

View Menu C-39

Files Tab C-40

GM Database Tab C-41

Sequence Collector Tab C-44
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Edit Menu The commands in the Edit menu of the Add Samples window are used 
to manage the contents of the window. The commands are described in 
the table below.

To add samples to the Project:

Step Action

1 Click  (Add Samples To Project) on the Project window toolbar.

Add Samples to Project window opens to the last tab viewed by the 
user (default is Files tab).

Sample files can reside on the local hard drive(s), mapped network 
drive(s), and removable media drives.

If Sequence Collector is configured and you are logged into 
Sequence Collector, the Sequence Collector tab is enabled.

2 In Files tab, navigate to folder containing sample files. Select the 
folder, then click the Add to List button.

Folder is added to the Samples To Add field. Individual samples 
within a folder can be selected and added. Selecting the folder adds 
all samples.

3 Click the Add button.

Add Samples to Project window closes and the project window 
becomes visible. Samples are added to the bottom of the Project 
window table.

Add Sample Files Edit Menu Commands

Item Description Enabling

Select All 
(Ctrl+A)

Selects all the items of a given 
type.

Enabled when a single 
valid selection has 
been made (e.g., 
sample file).
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Add 
Samples to 
List
(Ctrl+D)

Adds the selected item(s) from the 
Files, GeneMapper database, or 
Sequence Collector to the 
Samples to Add list.

Enabled when a 
sample file or folder 
with files in the Files, 
GeneMapper 
database, or Sequence 
Collector is selected.

Clear 
(Delete)

Clears (deletes) the selected 
item(s) in the Samples to Add list.

Enabled when a valid 
selection is made.

Clear All Hierarchical menu. Clears all 
sample files and folders from the 
specified field:

♦ Samples to add

♦ Criteria 

Note The Criteria subcommand 
functions in the GeneMapper 
Database tab but not in the Files 
tab and is used to clear all search 
criteria from the Criteria Selector 
List (see the figure on page C-41).

If undo is not possible, the 
following alert message is 
displayed: Clear all items? You 
cannot undo this action. [Yes] [No] 
[Cancel]

Enabled when the field 
is present and an item 
exists in that field.

Options Opens the Options dialog box in 
the Add Samples tab.

Always enabled.

Add Sample Files Edit Menu Commands (continued)

Item Description Enabling
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View Menu The View menu of the Add Samples window is used to switch between 
the three sources for samples and refresh the file directory. The 
commands are described in the table below.

Add Samples View Menu Commands

Item Description Enabling

Files
(Ctrl+1)

Opens the Files tab. Always enabled.

GM 
Database
(Ctrl+2)

Opens the GeneMapper 
Database tab.

Always enabled.

Sequence 
Collector
(Ctrl+3)

Opens the Sequence 
Collector tab.

Enabled and visible if 
Sequence Collector is 
configured and you are logged 
into Sequence Collector.

Configured through the 
Options menu.
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Files Tab The Files tab enables you to choose sample files from local or mapped 
networked storage devices.

Add Samples to Project Window Elements

 Element Description

Files pane Contains the directory structure configured for the 
computer running GeneMapper software. 

The navigation pane provides a tree viewer that works 
like the MS Windows Explorer interface. You can use 
Shift–click for continuous multiple selection and 
Ctrl–click for discontinuous multiple selections within a 
folder.

Samples To Add 
pane

Contains the folders and files that the system will add. 

This field also uses the tree viewer interface. You can 
use Shift–click and Ctrl–click as described above.

Add To List 
button

Adds the selected items from the files pane to the 
Sample to Add field.

Options button Opens the Options window.

Clear button Clears the selected files from the Samples To Add 
pane.

Add button Adds the Samples To Add list into the Project window.

Cancel button Closes the Add Samples to Project dialog box.

Files pane Samples To Add pane
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GM Database Tab The GM (GeneMapper) Database tab enables you to choose sample 
files that have previously been added into a GeneMapper project. This 
database uses a search interface to extract samples that match your 
criteria.

This feature allows mixing and matching sample files. For example, you 
can merge sample files from a number of small projects into a single 
large project.

Search Criteria Table

Samples To Add paneCriteria Selector list
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GM Database Search Rules

Criteria and 
Rules Description

Search criteria This list and table contains the search criteria from 
which to extract samples from the GeneMapper 
database.

Note Locations of the list and table are pointed out in 
the figure on the previous page.

♦ Criteria selector list = list of properties (columns in 
the project window) grouped by topic.

♦ Field column = Text field that contains the 
properties (columns) in the selected group criterion.

♦ Condition column = Combo box that contains 
conditions that the system will use to search for 
samples. Search rules include:

– Is

– Contains

– Starts With

– Date criteria - Presents a calendar widget to 
specify the date

♦ Criteria column = Field for specifying the text string 
associated with the search rules which are case 
sensitive.

Rules for Search 
criteria

Criteria accumulate as they are entered in different 
rows and to different groups of criteria.

Multiple items in the search criteria list use the natural 
language “and” for searching. For example, the natural 
language of the Criteria field is: “Display samples 
whose Panel property contains “XXX” and display 
samples whose Collection Instrument property 
contains “YYY”.”
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GM Database Tab Elements

Element Description

Search Criteria 
Cancel button

Enabled when a search is in progress; search stops 
when clicked.

Note You may not stop the search during data 
transfer from the GeneMapper database.

Search button Searches the database using the criteria list and 
displays the search results in the Search Results field.

Search Results 
field

Displays the results of the database search (sample 
files).

Add To List button Adds the selected items from the Results field to the 
Samples to Add field.

Samples To Add 
field

Contains the folders and files that the system will add. 
This field uses the tree viewer interface. 

Options button Opens the Options window.

Clear button Clears the selected files from the Samples To Add field.

Add button Adds the Samples to Add list into the Project window.

Cancel button Closes the Add Samples to Project dialog box.
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Sequence Collector
Tab

The Sequence Collector tab enables you to choose sample files that 
are stored in a Sequence Collector. The tab uses a search interface to 
extract samples that match your criteria. The Sequence Collector tab 
opens only when a connection to Sequence Collector exists.

The following table describes elements of the Sequence Collector tab.

Sequence Collector Tab Elements

Element Description

Search Criteria This table contains the search criteria from which to 
extract samples from the Sequence Collector.

♦ Field column = Text field that contains the 
properties (columns) in the selected group criterion.

♦ Condition column = Field that contains conditions 
that the system will use to search for samples. 
Search rules include:

– Starts With

– Contains

– Equals

– Date criteria - Presents a calendar widget to 
specify the date

♦ Criteria column = Field for specifying the text string 
associated with the search rules which are case 
sensitive.
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Rules for Search 
Criteria

Criteria accumulate as they are entered by the user.

Multiple items in the search criteria list use the natural 
language “and” for searching. For example, the natural 
language of the Criteria field is: “Display samples 
whose Panel property contains “XXX” and display 
samples whose Collection Instrument property 
contains “YYY”.”

Search Criteria 
Cancel button

Enabled when a search is in progress; the search stops 
when clicked.

Note May not stop the search during data transfer 
from the GeneMapper database.

Search button Searches the database using the criteria list and 
displays the search results in the Search Results field.

Search Results Displays the results of the database search (sample 
files). Columns in the table include Sample File plus 
others to match the fields specified in the search 
criteria.

Add To List button Adds the selected items from the Results field to the 
Samples To Add field.

Samples To Add 
field

Contains the folders and files that the system will add. 
This field uses the tree viewer interface. 

Options button Opens the Options window.

Clear button Clears the selected files from the Samples To Add field.

Add button Adds the Samples To Add list into the Project window.

Cancel button Closes the Add Samples to Project window.

Sequence Collector Tab Elements (continued)

Element Description
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Project Window Edit Menu Dialog Boxes

Find Dialog Box The elements of the Find dialog box is described below.

Project Window Find Elements

Element Description

Find what Field containing the search string.

In column List box containing the names of columns in the table.

Find Next Finds the next instance of the search string in the 
specified column and selects it.

Find All Finds and selects all rows in the table that contain the 
search string in the specified column.

Close Closes the Find dialog box. Table selections remain 
intact.
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Sort Dialog Box The Sort dialog box, shown below, allows sorting of sample files, 
results, etc., by ascending or descending order in up to three steps.

The Sort dialog box has three entry fields for entering sort criteria (the 
“Then by” fields allow successive sorting by two other criteria).

Project Window Sort Elements

Element Description

Sort by
(Then by)

Sort box containing the column which will be sorted.

Ascending 
and 
Descending
buttons

Option buttons for choosing if the sort is ascending or 
descending in alphabetical/numerical order.

OK button Closes the Sort dialog box and performs the sort.

Cancel 
button

Closes the Sort dialog box. Does not perform the sort.
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GeneScan Size
Standards D
Appendix Overview

Introduction The ABI Prism® GeneMapper™ Software Version 3.0 comes with 
several ready-to-use GeneScan® size standard definition files that you 
can choose from to analyze fragments run on ABI PRISM® genetic 
analyzers.

The following table lists the ready-to-use size standards stored in the 
GeneMapper database.

Note The GeneScan™ 350 size standard is not automatically stored in the 
database; however, it is provided in the GeneMapper > Size Standards folder for 
import.

In This Appendix This appendix contains the following topics:

If using size standard... Select this...

GeneScan™ 120 LIZ® GS120LIZ

GeneScan™ 400HD GS400HD

GeneScan™ 500 GS500

GeneScan™ 500(-250) GS500(-250)

GeneScan™ 500 LIZ® GS500LIZ

GeneScan™ 500(-250) LIZ® GS500(-250)LIZ

Topic See Page

GeneScan 120 Size Standard D-2

GeneScan 350 Size Standard D-3

GeneScan 400HD Size Standard D-4

GeneScan 500 and GeneScan 500(-250) Size Standards D-6

D
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GeneScan 120 Size Standard

About This Size
Standard

The GeneScan™ 120 Size Standard is useful for sizing fragments 
between 15 and 120 base pairs. It is used when analyzing SNaPshot® 
samples.

How It Is Prepared All aspects of the preparation of the GeneScan-120 LIZ size standard 
are proprietary. Each fragment contains a single LIZ fluorophore. 

GeneScan 120
Molecular Lengths

The following table lists the GeneScan-120 LIZ denatured molecular 
fragment lengths (nucleotides) for the nine fragments.

Electropherogram
of GeneScan 120

The following screen shows an electropherogram of GeneScan-120 LIZ 
run under denaturing conditions.

Fragment 
Length

Fragment 
Length

15 62

20 80

25 110

35 120

50
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GeneScan 350 Size Standard

About This Size
Standard

The GeneScan™ 350 Size Standard is useful for sizing fragments 
between 35 and 350 base pairs. The native fragments are uniformly 
spaced to provide accurate size calling.

How It Is Prepared The GeneScan 350 Size Standard is prepared by PstI digestion of 
plasmid DNA, followed by ligation of a TAMRA™ or ROX™-labeled 
22-mer oligodeoxynucleotide to the cut ends. A subsequent enzymatic 
digestion with BstUI yields DNA fragments containing a single TAMRA 
or ROX dye (See “GeneScan 350 Molecular Lengths” below).

GeneScan 350
Molecular Lengths

The following table lists the GeneScan 350 Denatured Fragment 
Molecular Lengths (Nucleotides) for the 12 fragments.

Electropherogram
of GeneScan 350

The following screen shows an electropherogram of GeneScan 350 run 
under denaturing conditions.

Fragment 
Length

Fragment 
Length

Fragment 
Length

35 139 250

50 150 300

75 160 340

100 200 350
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GeneScan 400HD Size Standard

About This Size
Standard

The GeneScan™ 400HD (High Density) Size Standard is used to 
determine fragment lengths between 50 and 400 base pairs.

Special Uses The high density of marker bands in this standard makes it particularly 
useful for microsatellite analysis. All fragments have been checked for 
migration that is true to size under a wide variety of run conditions on all 
ABI PRISM® instruments.  

How It Is Prepared All aspects of the preparation of the GeneScan 400HD Size Standard 
are proprietary. Each fragment contains a single ROX fluorophore.

Fragment Lengths The following table lists the lengths of the 21 fragments that make up 
the GeneScan 400HD Size Standard.

Denaturing
Electropherogram

Although the GeneScan 400HD Size Standard is made of 
double-stranded DNA fragments, only one of the strands is labeled. 
Consequently, even if the two strands migrate at different rates under 
denaturing conditions you will not need to worry about peak splitting. 
The following figure shows the peak patterns of GeneScan 400HD 
fragments run under denaturing conditions. Fragments were run using 
the 3700 POP-6™ polymer at 60 °C.

Fragment 
Length

Fragment 
Length

Fragment 
Length

50 180 290

60 190 300

90 200 320

100 220 340

120 240 360

150 260 380

160 280 400
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Electropherogram
of GeneScan

400HD

The following screen shows an electropherogram of GeneScan 400HD.
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GeneScan 500 and GeneScan 500(-250) Size Standards

About These Size
Standards

The GeneScan™ 500, the GeneScan™ 500 LIZ®, the GeneScan™ 
500(-250), and the GeneScan™ 500(-250) LIZ® Size Standards are 
useful for sizing fragments between 35 and 500 base pairs. The native 
fragments are uniformly spaced to provide accurate base calling.

The GeneScan 500(-250) contains all of the fragments in the GS 500 
Size Standard except for the 250 bp fragment. Since it is identical in 
other respects, it is not discussed separately in this section.

How It Is Prepared The GeneScan 500 all Size Standard is prepared by PstI digestion of 
plasmid DNA, followed by ligation of a LIZ or ROX-labeled 22-mer 
oligodeoxynucleotide to the cut ends. A subsequent enzymatic 
digestion with BstUI yields DNA fragments containing a single ROX or 
LIZ dye (see “GeneScan 500 Molecular Lengths” below).

GeneScan 500
Molecular Lengths

The following table lists the GeneScan 500 denatured fragment 
molecular lengths (nucleotides) for the 16 fragments.

Fragment 
Length

Fragment 
Length

Fragment 
Length

35 160 400

50 200 450

75 250 490

100 300 500

139 340

150 350
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Electropherogram
of GeneScan 500

The screen below shows an electropherogram of GeneScan 500 run 
under denaturing conditions.
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Sample File
Conversion E
Appendix Overview

Introduction This appendix describes how to use sample file conversion programs to 
prepare Macintosh® computer-generated fragment analysis sample 
files for transfer to a Microsoft® Windows®-based format and vice versa.

In This Appendix This appendix contains the following topic:

Topic See Page

Converting Macintosh Sample Files E-2

E
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Converting Macintosh Sample Files

About Converting
Sample Files

Applied Biosystems created two conversion programs that prepare 
sample files for transfer from a Macintosh computer to computers 
running Microsoft Windows NT operating systems, and vice versa. 
These sample file conversion programs run only on a Macintosh 
computer.

The sample file conversion programs do not perform the file transfer 
from computer to computer. They set attributes of the files so that they 
can be used on the destination computer. For example, when 
transferring a fragment analysis sample file from a Macintosh computer 
to a computer running the Windows operating system, a file extension is 
required and the conversion program adds .fsa to the sample file name. 
For more detailed information on how these conversion programs 
function, refer to the SimpleText file entitled “About Conversion 
Programs” located in the same folder as the sample file conversion 
programs.

Installing
Conversion

Programs

To install the sample file conversion programs on a Macintosh 
computer:

Step Action

1 Insert the GeneMapper software CD-ROM into your Macintosh 
computer’s CD-ROM drive. 

An icon displays for the CD-ROM on the right-hand side of the 
screen.

2 Double-click the CD-ROM icon.

A CD-ROM window displays containing files and folders.

3 Locate and double-click the CONVFOLD folder.

Inside this folder are two files, CONVPROG.HQX and 
README.TXT, which contain the installation instructions.

4 Copy the CONVPROG.HQX file to your local hard drive by clicking 
on the file, dragging the file over to the local hard drive icon, and 
dropping it in.

5 Decompress the CONVPROG.HQX file by dragging and dropping it 
onto a program called “Stuffit Expander.”

Note You can download a free version of Stuffit Expander from 
http://www.stuffit.com/expander.
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Note Decompressing the CONVPROG.HQX file creates a folder on the local 
hard drive. This folder contains the conversion programs and the SimpleText file 
“About Conversion Programs.” This file is a seven-page document that 
describes in detail how to use the conversion programs, why they are 
necessary, solutions to common problems, and possible alternative programs.

Converting
Macintosh Sample

Files to Micosoft
Windows Files

To convert Macintosh computer sample files for use on a computer 
running Microsoft Windows operating system:

Step Action

1 Double-click the  (Sample File Mac to Win) to start 
the program.

The following dialog box opens.

Note On Macintosh computers running operating system 8.0 or 
less, this dialog box has a different appearance. For more 
information, refer to the SimpleText file “About Conversion 
Programs” mentioned above in “Installing Conversion Programs.”

2 Using the triangle-shaped icons to the left of the folder names, 
navigate to the folder that contains the fragment analysis sample 
files you want to convert .
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3 Select the folder by single-clicking its name.

4 Click the Choose button at the bottom of the dialog box.

If there are no problems, the program performs the task and quits 
automatically. When you open the folder, the sample files have the 
file extension .fsa.

Note To convert sample files created on a computer running the 
Microsoft Windows operating system for use on a Macintosh 
computer, follow steps 1-3 above; in Step 1, double-click the 
Sample File Win to Mac icon.

To convert Macintosh computer sample files for use on a computer 
running Microsoft Windows operating system: (continued)

Step Action
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Software Warranty
Information F
Appendix Overview

Introduction This appendix describes the software warranty provided by Applied 
Biosystems for the ABI PRISM® GeneMapper™ Software Version 3.0.

In This Appendix This appendix contains the following topics:

Topic See Page

Computer Configuration F-2

Limited Product Warranty F-3

F
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Computer Configuration

Configuration Applied Biosystems supplies or recommends certain configurations of 
computer hardware, software, and peripherals for use with its 
instrumentation. Applied Biosystems reserves the right to decline 
support for or impose extra charges for supporting nonstandard 
computer configurations or components that have not been supplied or 
recommended by Applied Biosystems. Applied Biosystems also 
reserves the right to require that computer hardware and software be 
restored to the standard configuration prior to providing service or 
technical support. For systems that have built-in computers or 
processing units, installing unauthorized hardware or software may void 
the Warranty or Service Plan.
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Software Warranty Information F-3

Limited Product Warranty

Limited Warranty Applied Biosystems warrants that for a period of ninety (90) days from 
the date the warranty period begins, its ABI PRISM® GeneMapper™ 
Software Version 3.0 will perform substantially in accordance with the 
functions and features described in its accompanying documentation 
when properly installed on the instrument system for which it is 
designated, and that for a period of ninety (90) days from the date the 
warranty period begins, the tapes, diskettes, or other media bearing the 
software product will be free of defects in materials and workmanship 
under normal use. If buyer believes that it has discovered a failure of the 
software to satisfy the foregoing warranty, and if buyer notifies Applied 
Biosystems of such failure in writing during the ninety (90) day warranty 
period, and if Applied Biosystems is able to reliably reproduce such 
failure, then Applied Biosystems, at its sole option, will either (i) provide 
any software corrections or “bug-fixes” of the identified failure, if and 
when they become commercially available, to buyer free of charge, or 
(ii) notify buyer that Applied Biosystems will accept a return of the 
software from the buyer and, upon such return and removal of the 
software from buyer’s systems, terminate the license to use the 
software and refund the buyer’s purchase price for the software. If there 
is a defect in the media covered by the above warranty and the media is 
returned to Applied Biosystems within the ninety (90) day warranty 
period, Applied Biosystems will replace the defective media.  Applied 
Biosystems does not warrant that the software will meet buyer’s 
requirements or conform exactly to its documentation, or that operation 
of the software will be uninterrupted or error free.

Warranty Period
Effective Date

Any applicable warranty period under these sections begins on the 
earlier of the date of installation or ninety (90) days from the date of 
shipment for software installed by Applied Biosystems personnel. For 
all software installed by the buyer or anyone other than 
Applied Biosystems, the applicable warranty period begins the date the 
software is delivered to the buyer.

Warranty Claims Warranty claims must be made within the applicable warranty period.
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Warranty
Exceptions

The above warranties do not apply to defects resulting from misuse, 
neglect, or accident, including without limitation: operation outside of 
the environmental or use specifications, or not in conformance with the 
instructions for the instrument system, software, or accessories; 
improper or inadequate maintenance by the user; installation of 
software or interfacing, or use in combination with software or products, 
not supplied or authorized by Applied Biosystems; and modification or 
repair of the product not authorized by Applied Biosystems.

The foregoing provisions set forth Applied Biosystems’ sole and 
exclusive representations, warranties, and obligations with respect to its 
products, and Applied Biosystems makes no other warranty of any kind 
whatsoever, expressed or implied, including without limitation, 
warranties of merchantability and fitness for a particular purpose, 
whether arising from a statute or otherwise in law or from a course of 
dealing or usage of trade, all of which are expressly disclaimed.

Warranty
Limitations

The remedies provided herein are the buyer's sole and exclusive 
remedies. Without limiting the generality of the foregoing, in no event 
shall Applied Biosystems be liable, whether in contract, tort, warranty, 
or under any statute (including without limitation any trade practice, 
unfair competition, or other statute of similar import) or on any other 
basis, for direct, indirect, punitive, incidental, multiple, consequential, or 
special damages sustained by the buyer or any other person or entity, 
whether or not foreseeable and whether or not Applied Biosystems is 
advised of the possibility of such damages, including without limitation, 
damages arising from or related to loss of use, loss of data, failure or 
interruption in the operation of any equipment or software, delay in 
repair or replacement, or for loss of revenue or profits, loss of good will, 
loss of business, or other financial loss or personal injury or property 
damage.

No agent, employee, or representative of Applied Biosystems has any 
authority to modify the terms of this Limited Warranty Statement or to 
bind Applied Biosystems to any affirmation, representation, or warranty 
concerning the product that is not contained in this Limited Warranty 
Statement, and any such modification, affirmation, representation, or 
warranty made by any agent, employee, or representative of 
Applied Biosystems will not be binding on Applied Biosystems unless in 
a writing signed by an executive officer of Applied Biosystems.

This warranty is limited to the buyer of the product from 
Applied Biosystems and is not transferable.
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Software Warranty Information F-5

Some countries or jurisdictions limit the scope of or preclude limitations 
or exclusion of warranties, of liability, such as liability for gross 
negligence or wilful misconduct, or of remedies or damages, as or to 
the extent set forth above. In such countries and jurisdictions, the 
limitation or exclusion of warranties, liability, remedies or damages set 
forth above shall apply to the fullest extent permitted by law, and shall 
not apply to the extent prohibited by law.
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Glossary-1

Glossary

Allele a variant of a marker

Allele calling identification of alleles based on bin definitions; genotyping; GeneMapper 
software analysis

Bin a fragment size or basepair range and dye color that define an allele

Bin set a set of bin definitions for one source or set of experimental conditions, usually 
an instrument; bin sets are available inside a kit

Diploid, polyploid having 2 or more alleles, respectively, per gene or locus

Genotype the set of allele calls for a marker or genetic locus; usually 2 alleles

GM GeneMapper software

HID human identification and forensic applications

Kit a set of panels; the grouping of panels in a kit is determined by the kit provider

LMS Linkage Mapping Set; ABI chemistry using dinucleotide repeat microsatellite 
markers

Marker a known microsatellite or SNP location

Microsatellite short tandem repeat marker (di-, tri-, tetra-nucleotide repeat)

Panel a set of bin definitions for one or more markers; the grouping of markers in 
panels is determined by the kit provider

Project GeneMapper software project; a collection of samples

SNaPshot Multiplex
Analysis

Primer extension-based chemistry for SNP validation

SNP single-nucleotide polymorphism (used in this document to refer to SNaPshot® 
System markers)

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Index-1

Index

A
Add Reference Data command 4-17
Add Sample to Project dialog box

general information C-36
Add Samples dialog box

Edit Menu C-37
Files tab C-40
View Menu C-39

Add Samples Tab view
elements C-19

Add samples to the Project
procedure C-37

advanced mode
peak detection options B-17
ranges options B-14
size calling method options B-16
smoothing and baselining options B-15

algorithms
allele calling B-2, B-5
binning B-2, B-5
described 1-3
peak detection B-2, B-3
quality value determination B-2, B-7
size-matching B-2
size-matching/size-calling B-4

Alleles tab
range filter 5-10
SNP cutoff value (for SNaPshot) 5-10

Analysis Method Editor
Alleles tab 5-7
General tab 5-7
Peak Detector tab 5-11
Peak Quality tab 5-14
Quality Flags tab 5-16

analysis methods 5-2
analysis parameters

setting
analysis range options B-14
data processing options B-15

Analysis Tab view
elements C-22

Apply button 4-2, 4-3, 4-7, 10-13, 10-17
Apply To checkbox 7-11

Automatic bin
assignment 4-40
builder 4-40

Automatic Bin Assignment (ABAA) 1-3
Automatic Bin Assignment Algorithms 

(ABAA) 1-4
Automatic Bin Builder (ABB) 1-3, 1-4

B
Bin Set

alleles tab 5-8
choosing a 5-8

Bin view
cursor location information 4-38
description 4-37
genotype quality symbols 4-38
Marker Allele Size Range (ASR) 4-39
purpose of 4-37
X- and Y-axes 4-38

Bins definition
format of text file 4-26

Bins definitions for SNaPshot 4-30

C
CD-ROM contents 2-3
Collecting and preparing sample data

techniques for 2-1
Command activation

three ways of C-9
Computer

configuration requirement F-2
technical support for altered 

configuration F-2
Cubic Spline Interpolation method B-34
customer support. See technical support 1-12
Cut-off Value 5-9

D
Dye/lanes window

example of 3-14
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E
Ease of use 1-4
EPT tab 3-10
Example Plot printout C-35
Example Table printout C-34
Export Project window 3-25
Export Table dialog box C-31

F
failed in-lane size standards

ability to correct 1-7
Filtering controls 6-10
Find command

planning for use of 2-9
Find dialog box C-46
Fully automated operation 1-4

G
GeneMapper

access rules 2-7
accessing subordinate application 

windows 3-15
logging in and out 2-5
major steps in using 2-2
overview 1-2
registering 2-4

GeneMapper Manager
Analysis Method Editor 5-5
Analysis Methods tab 5-2
Matrices tab 9-2
New Analysis Method dialog box 5-6

GeneMapper results
exporting as text files 1-6

GeneMapper Software
installing and registering 2-3

GeneMapper software
hardware and software requirements 1-9
how it works, figure 1-8
important features 1-6
read-only access to the BioLIMS 

database 1-6
GeneMapper system

dataflow 1-8
GeneScan Analysis Sample Sheet

importing data from 2-8
Genotypes view

descriptions of columns C-7
Genotypes View filter setting 6-12
genotyping algorithms B-2

H
High-throughput 1-3

I
Import Project window 3-27
Info tab 3-8

L
Least Square method B-32
Local Southern method B-35
logging out of GeneMapper 2-7

M
Marker 4-36
marker allele size range (ASR) 4-39
marker and bin definitions

exporting 1-6
importing 1-6

Marker table columns 4-36
Marker Table view 4-35
matrices

about 9-3
causes for bad 9-19
error messages 9-19
limitations 9-6
where to store 9-7, 9-18

Matrices tab 9-2
matrix

assigning to a sample 9-5
assigning to sample 9-16
choosing a data point range 9-10, 9-11
considerations 9-7
creating a GeneMapper 9-12
definition 9-3
eliminating primer peaks 9-11
evaluating 9-17
evaluation procedure 9-17
example 9-15
generating a new 9-12
process diagram 9-8
process of creating a new 9-8
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raw data display 9-10
sample files 9-5
steps to create 9-9
using different computers for data collection 

and analysis 9-18
using with data collection 9-18
viewing the raw data 9-10
when to assign to a sample 9-5
when to create 9-6

matrix files
about 9-3 to 9-7
bad matrix files, causes 9-19 to 9-20
choosing a data point range 9-10 to 9-11
evaluating the matrix file 9-17
new matrix file, generating 9-12 to 9-15
process of creating new file 9-8 to 9-9

Multiple Allele Peak Determination (MAPDA) 1-3
Multiple Allele Peak Determination Algorithms 

(MAPDA) 1-4

O
Open Project dialog box C-28
Options dialog box C-17

P
Panel and Bin text files 4-23
Panel data hierarchy 4-3
Panel definition format of text file 4-24
Panel definitions for SNaPshot 4-28
Panel Manager

Add Bin command 4-13
Add Reference Data command 4-17
Auto Bin command 4-19
Auto Panel command 4-19
automatic bin assignment algorithm 4-40
automatic bin builder process 4-40
Bin view 4-37, 4-38, 4-39
Bins menu 4-12
Delete Bin command 4-14
Delete Bin Set command 4-16
Delete SNP Marker command 4-13
Duplicate Panel command 4-7
dyes 4-22
Edit Bin command 4-14
Edit Bin dialog box 4-15
Edit SNP Marker command 4-12

Full View command 4-20
Import Bins Options dialog box 4-9
Import/Export Bin Set command 4-8
Import/Export Panels command 4-8
Navigation pane 4-5
New Bin Set command 4-16
new marker 4-7
new panel 4-7
overview 4-2
Panel SNP Reference Data command 4-18
purpose of 2-12, 4-2
rules for imported and exported files 4-32
Show Project Alleles command 4-17
toolbar 4-4
View menu 4-20
window commands 4-6
X Axis Scale menu command 4-20, 4-21

scale to 4-20
Y Axis Scale 4-21

Panel Manager window 4-2
displaying 4-3

Panel names 4-34
Panel table columns 4-34
Panel Table view 4-33
parameter values 5-7, 5-9
Pass or Fail

quality metrics 5-17
PCR Single-stranded Conformation 

Polymorphism (SSCP)
Minimum Peak Half width setting B-12, 

B-17
peak detection

optimizing sensitivity B-23, B-25, B-27
parameters B-19
peak window size B-19
polynomial degree B-19
slope threshold B-28

peak detection algorithm
advanced 5-12
basic 5-11
classic 5-13

Peak Detector tab
advanced peak detection algorithm 5-12
basic peak detection algorithm 5-11
classic peak detection algorithm 5-13

Peak Quality tab
allele number 5-15
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heterozygote balance 5-14
peak morphology 5-15
pull-up peak 5-15
signal level 5-14
SNP 5-15

plot settings default profiles 8-2
Plot Settings Editor

Display Settings tab 8-9
General tab 8-4
Genotype Header tab 8-5
Labels tab 8-7
Sample Header tab 8-5
Sizing Table tab 8-6

plot settings editor 8-4
Plot Settings tab 8-2
Plot window

Add Allele option 7-27
Add Bin option 7-29
Allele Changes option 7-16
Allele Edit Comment option 7-28
Alleles menu 7-25
bins 7-14
Controls To Top option 7-16
customizing 7-3
Delete Allele option 7-27
Delete Bin option 7-30
displaying 7-2
Dyes option 7-17
Edit Bin option 7-29
Edit menu 7-7
Editing Mode option 7-25
example of 3-14
Export Table dialog box 7-6
File menu 7-5
Full View option 7-9
Header option 7-21
Help menu 7-30
History option 7-27
labels 7-12
Marker Indicator option 7-21
Marker Margin option 7-22
Marker Range option 7-21
menus 7-5
Off-scale Peak Indicator option 7-17
overview 7-2
Peak Positions indicators 7-14
Plot Settings option 7-24

Plots option 7-18
PQV feature 7-31
Rename Allele option 7-28
Table Filter option 7-20
Tables option 7-18, 7-20
toolbars 7-4
Tools menu 7-23
View menu 7-8
X-Axis Scale option 7-10
Y-Axis Scale option 7-11

PlusA Distance 5-9
PlusA Ratio 5-9
polynomial degree

peak detection B-19
varying B-21
window size value B-22

PQV results A-5
Prefences Add Samples

spellings and abbreviations C-20
Preferences

Analysis tab C-22
Import tab C-18
Sequence Collector tab C-21
Users tab C-24

Print dialog box C-33
Process Component Quality Values (PQV) 1-4
Process Component-Based Quality Values 

(PQV) 1-4
process quality values (PQV) A-1

editing A-2
overview A-2
PQV flags on the Genotypes page A-7
PQV flags on the Samples page A-6
PQV values for specific applications A-4
process A-2
rules for PQV columns A-5
using the PQV system A-3

Project
discussion of supporting utilities 3-3

Project Analysis menu
commands C-12

Project Edit menu
commands C-11

Project Edit menu dialog boxes
Find dialog C-46
Sort dialog C-47

Project File menu
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commands C-9
Project File menu dialog boxes

Export Table dialog C-31
New Project C-27
Open Project dialog C-28
Print dialog C-33
Save Project/Save Project As dialogs C-30

Project Help menu
commands C-26

Project View menu
commands C-14

Project window
importance of 3-2
interface conventions 3-5
navigating in 3-7
parts of the main window 3-6
reformatting 3-5
tasks performed in 3-3
toolbar 3-12
viewing contents 3-14

Projects page
using the 3-23

Q
Quality Flags tab

options 5-17
PQV thresholds 5-16

R
Raw Data tab 3-9
registration card, completing 1-11

S
sample files

converting from Mac to NT E-2
Sample Information

source of 2-8
Sample Sheet

how GeneMapper uses 2-8
sample sheet 2-8
Samples and Genotypes views

applying a menu selection 3-19
purposes of tables 3-11

Samples view
appearance C-2
columns C-3

rules for columns 3-18
Samples View column filtering settings 6-10
Save Project/Save Project As dialog boxes C-30
Sequence Collector

database tab window elements C-44
tab view elements C-21

Sequence Collector tab C-44
size calling curve 10-18

black curve 10-18
red curve 10-18

size calling method
Cubic Spline Interpolation B-34
Global Southern B-37
Local Southern B-35

size calling methods
classic and advanced B-32
Cubic Spline B-34
Least Square B-32

Size Match Editor
Edit Menu 10-14
procedure for editing a peak 10-16
View Menu 10-15
when to use 10-12

Size Match Editor window 10-12
editor commands 10-13
elements 10-13
toolbar 10-16
using 10-16

size standard
350 All size standard D-3
400 HD D-4
500 All D-6
creating and editing 10-5
specifying size standard parameters 10-5

Size Standard Editor window
using in basic or advanced mode 10-8
using in classic mode 10-10

Size Standard tab 10-3
Size Standards

advantages of using 10-2
what are 10-2

sizing only application
sizing microsatellite reference data 10-19
sizing SNaPshot reference data 10-20

sizing-only application 10-19
slope threshold B-30

peak end parameters B-28
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peak start B-28
Sort Dialog box C-47
SQ and GQ quality indications A-5
SSCP, Minimum Peak Half width setting B-12, 

B-17
Stutter Distance 5-9
Stutter Ratio 5-9

T
Table Manager

content column dialog box 6-8
filtering controls 6-10

Table Setting Editor
deleting a table profile 6-9
editing a table profile 6-9
filtering controls 6-10

filtering settings, genotypes view 6-12
filtering settings, samples view 6-10

new table profiles 6-9
Table Settings Editor 6-4

General tab 6-4
Genotypes tab 6-6
Sample and Genotypes tab elements 6-7

allele settings 6-8
Samples tab 6-5

Table Settings tab
overview 6-2
profiles 6-2

Technical support
for computers with altered configuration F-2

technical support 1-12
Thresholds 5-16
troubleshooting

bad matrix files, causes 9-19 to 9-20

U
User manual

organization 2-12
Users tab

elements C-24

W
Warranty

exceptions F-4
for computers with altered configuration F-2
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Artisan Technology Group is your source for quality 
new and certified-used/pre-owned equipment

•	 FAST SHIPPING AND 
DELIVERY

•	 TENS OF THOUSANDS OF 
IN-STOCK ITEMS

•	 EQUIPMENT DEMOS

•	 HUNDREDS OF 
MANUFACTURERS 
SUPPORTED

•	 LEASING/MONTHLY 
RENTALS

•	 ITAR CERTIFIED           
SECURE ASSET SOLUTIONS

SERVICE CENTER REPAIRS
Experienced engineers and technicians on staff 
at our full-service, in-house repair center

WE BUY USED EQUIPMENT
Sell your excess, underutilized, and idle used equipment 
We also offer credit for buy-backs and trade-ins
www.artisantg.com/WeBuyEquipment

                        REMOTE INSPECTION
Remotely inspect equipment before purchasing with 
our interactive website at www.instraview.com

LOOKING FOR MORE INFORMATION? 
Visit us on the web at www.artisantg.com    for more 
information on price quotations, drivers, technical 
specifications, manuals, and documentation

Contact us:  (888) 88-SOURCE  |  sales@artisantg.com  |  www.artisantg.com
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